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Notice

This document describes the installation and use of the AudioCodes SCOM Management
Pack in the Microsoft SCOM 2012 and SCOM 2012R2 Operations Manager environment.

Information contained in this document is believed to be accurate and reliable at the time of
printing. However, due to ongoing product improvements and revisions, AudioCodes cannot
guarantee accuracy of printed material after the Date Published nor can it accept responsibility
for errors or omissions. Before consulting this document, check the corresponding Release
Notes regarding feature preconditions and/or specific support in this release. In cases where
there are discrepancies between this document and the Release Notes, the information in the
Release Notes supersedes that in this document. Updates to this document and other
documents as well as software files can be downloaded by registered customers at
http://www.audiocodes.com/downloads.

© Copyright 2015 AudioCodes Ltd. All rights reserved.
This document is subject to change without notice.
Date Published: June-30-2015

Trademarks

AudioCodes, AC, HD VolP, HD VolP Sounds Better, IPmedia, Mediant, MediaPack, What's Inside
Matters, OSN, SmartTAP, VMAS, VolPerfect, VolPerfectHD, Your Gateway To VoIP, 3GX,
VocaNOM and One Box 365 are trademarks or registered trademarks of AudioCodes Limited All
other products or trademarks are property of their respective owners. Product specifications are
subject to change without notice..

WEEE EU Directive

Pursuant to the WEEE EU Directive, electronic and electrical waste must not be disposed
of with unsorted waste. Please contact your local recycling authority for disposal of this
product.

Customer Support

Customer technical support and services are provided by AudioCodes or by an authorized
AudioCodes Service Partner. For more information on how to buy technical support for
AudioCodes products and for contact information, please visit our Web site at
www.audiocodes.com/support.

Documentation Feedback

AudioCodes continually strives to produce high quality documentation. If you have any
comments (suggestions or errors) regarding this document, please fill out the
Documentation Feedback form on our Web site at http://www.audiocodes.com/downloads.
Your valuable feedback is highly appreciated.

Abbreviations and Terminology

Each abbreviation, unless widely used, is spelled out in full when first used.
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1

Introduction

This document describes how to install and use the AudioCodes SCOM Management Pack
which manages AudioCodes gateways in the SCOM environment.

SCOM (System Center Operations Manager) enables customers to reduce the cost of data
center management across server operating systems and hypervisors through a single,
familiar and easy-to-use interface. Different views show state, health and performance
information, as well as alerts generated according to availability, performance,
configuration or an identified security situation. Operators can gain a rapid insight into the
state of the IT environment, and the IT services running across different systems and
workloads.

The purpose of the AudioCodes SCOM Management Pack is to allow the SCOM server to
monitor AudioCodes gateways through SNMP. This includes Discovery, health states,
alerts, performance counters and tasks.

Note: The AudioCodes SCOM Management Pack runs only on SCOM 2012, SCOM
2012 R2 and is not backward-compatible to run on SCOM 2007.

SCOM
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2

AudioCodes Management Pack - Gateway
Support

The following AudioCodes gateways are supported by the AudioCodes SCOM
Management Pack:

Mediant 4000 E-SBC

Mediant 3000 Gateway and E-SBC

Mediant 2600 E-SBC

Mediant 2000 Media Gateway

Mediant 1000 Media Gateway

Mediant 1000B Gateway and E-SBC

Mediant 1000B MSBR

Mediant 800 MSBR

Mediant 800B Gateway and E-SBC

MediaPack Media Gateways MP-124 (FXS)
MediaPack Media Gateways MP-118 (FXS and FXO)
MediaPack Media Gateways MP-114 (FXS and FXO)
MediaPack Media Gateways MP-112 (FXS)

SCOM
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3

3.1

A\

Setting up the AudioCodes SCOM
Management Pack

This chapter describes the following setup procedures:
B Running the Setup Wizard. See below
B Importing Management Pack. See Section 3.2 on page 20.

Running the Setup Wizard

This section describes how to setup the AudioCodes SCOM Management Pack
environment on the SCOM server. Once you have completed this setup, you can import
the AudioCodes Management Pack into the SCOM environment and manage AudioCodes
devices.

Note: This step is only required if you have received the Management Pack in
executable file format.

» To setup the AudioCodes Management Pack:

1. Run the AudioCodesSCOM.exe file; the AudioCodes SCOM Setup wizard is
displayed:

Figure 3-1: AudioCodes Setup Wizard Welcome Screen

rﬁ_’%‘ Setup - AudicCodes SCOM l = | |£h]1

Welcome to the AudioCodes
SCOM Setup Wizard

This will install AudioCodes SCOM wersion 1.0.2.3 on your
computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

Mext = ]| Cancel

SCOM
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2.

Click Next; the Select Destination Location screen is displayed:

Figure 3-2: Select Destination Location

i ™
i5 Setup - AudioCodes SCOM = |

Select Destination Location
Where should AudioCodes SCOM be installed?
J Setup will install AudioCodes SCOM into the following folder,

To continue, dick Mext. If you would like to select a different folder, dick Browse.

:\Program FilesWudioCodes SCOM Browse...

At least 2.9 MB of free disk space is required.

l < Back ][ Mext > ]l Cancel

)

Choose the folder for installing the AudioCodes Management Pack, and then click

Next; the Ready to Install screen is displayed:

Figure 3-3: Ready to Install

i ™
i5 Setup - AudioCodes SCOM = S|

Ready to Install
Setup is now ready to begin installing AudioCodes SCOM on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\Program Files\AudioCodes SCOM

< Badk ” Install J[ Cancel
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4. Verify the installation settings and then click Install; the Completion screen is
displayed:
Figure 3-4: AudioCodes Setup Wizard Complete

rﬁ! Setup - AudicCodes SCOM el I

Completing the AudioCodes SCOM
Setup Wizard

Setup has finished installing AudiocCodes SCOM an your
computer.

Click Finish to exit Setup.

5. Click Finish to exit the setup.
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3.2 Importing Management Pack

This section describes how to import the AudioCodes Management Pack into the SCOM
2012 or 2012R2 environment. Once you import the Management Pack, you can manage
AudioCodes gateways via the SNMP interface.

» To import the AudioCodes Management Pack into the SCOM environment:

1. Start the SCOM; the SCOM interface is displayed.

2. In the main SCOM window, click the Administration pane; the Administration pane
is displayed:

Figure 3-5: Administration Pane

PR audiocodes - Dperations Manager [- O[]
Fle Edit View Go Tasks Tools Help

Searchv _ | B o

Administration <

4|5 Administration
1, Connected Management Groups £\

A e Administration Overview

i Agent Managed

[ Agentless Managed
48] Management Servers
&¥ Pending Management
{5 unD/Linux Computers

% Management Packs

:\‘ Required Configuration Tasks: Actions:

In order for Operations Manager to manag L B RS A R IE

network you must complete the following

nd manitar your
ps: Import management packs

View Management Pack Catalog

4 (3 Network Management ired: i
0 f,U g % Required: Configure computers and devices to manage P —
Discovery Rules ired :
| 4 % Required : Import management packs Find connectors for other management tools
=% Network Devices . S
% Required: Enable Notification Channels
¥ Network Devices Pending Management
e % Upgrade to full version Key Concepts_
|z Channels The Administration Workspace
A Subscribers Discovering Network Devices
“Z| Subscriptions ) . . Run A5 Accourts and Profiles
4 & Product Connectors (> Optional Configuration: Run As Accounts and Profiles for UNIX and Linux
05 Internal Connectors Maragement Packs
F Gptionally configure the following components:
? Resource Pools e SR Sy Discovery and Agents
- R " " "
{ Run As Configuration % Configure Active Directory (AD) Integration Destination Management Pack
i1 Accounts Active Directory (AD) integration allows you to leverage your
1. profiles investmant in AD by enabling you to create AD based rules to assign
2] UNDX/Linux Accounts computers to Management Group. Learn About:
4 (5 seaurity Selecting Targets and Groups
Configure Client Monitorin
2, UserRoles ¥ = < Creating a Resource Pool

Client Monitoring enables youto manitor operating systems and
applications forerrors and participate in the Customer Experience
Improvement Program.

@, settings

Online Resources:

Microsoft System Center Online

Microsoft System Center Community

Discavery Wizard. Report an Issue or Suggestion to Micrasoft

Bl Monitoring
A Authoring
" Administration

ljﬂ My Workspace

Ready y
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Figure 3-6: Import Management Packs Option

Discovery wizard, ..

b

Create Management Pack,

Download Management Packs ..

Import Management Packs. ..

1?5 Mew Lser Role 3
U Create Run As Account. ..
_1_ Create Run As Profile...

Mew channel 3

Tt

Mew subscriber, .

e i

Mew subscription, ..

[=

Mm®  Add Management Group
-

w  Refresh F5

3. In the Navigation tree, right-click Management Packs, and then from the pop-up
menu, choose Import Management Packs; the Select Management Packs window is

displayed:
Figure 3-7: Select Management Packs

v anagement Packs

@ Help

dd ~ 7 Properties ... 2 Remove

Import ligt :

| Name | Version AddFrom catalog ...

Status details :

Iriztall Cancel |

4
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4. Click the Add button, and then choose Add from disk; the following dialog is
displayed:

Figure 3-8: Online Catalog Connection

i ™
Online Catalog Connection ‘ Iﬁ

% Some of the management packs you select may have
dependencies that cannot be located locally.

Would you like to search the online catalog for
these dependencies?

5. Click No to decline choosing Management Pack from a Catalog.
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6. Locate the saved AudioCodes Management Pack (in XML format) on you disk (the
location that you chose in Section 3 on page 17) and then click the Open button; the
Select Management Packs window is displayed:

Figure 3-9: Select AudioCodes Management Packs

mport Management Packs ﬁ

ect Management Packs

& Help

et <k Add = “5F'Properties ... X Remove

| Mame | ersion | Releaze Date | Status | EULA |

v Management Pack |1.0.2.0

Status details ;

Audiocodes B Management Pack version 1.0.2.0 is imported.

Install | Cancel

A4
7. Select the AudioCodes GW Management Pack, and then click the Install button.
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4 Discovering Gateway Devices

When Management Packs are installed you have to discover your AudioCodes gateways
as Network Elements to enable SCOM to make a full discovery. You discover the gateways
by using the Discovery Wizard to create a Discovery Rule.

A Note: You can create a single Discovery rule for each SCOM server.

4.1  Creating Discovery Rule

This section describes how to discover gateways as a network device.

» To discover the gateway as a Network Device:

1. In the Administration pane, right-click Network Devices ,and then in the pop-up
menu, choose Discovery Wizard:

Figure 4-1: Open Discovery Wizard

Discavery Wizard. ..

Create Management Pack,
Download Management Packs ...

Impart Management Packs, ..

Mew User Role 2

b GBI SIS |5

Creabe Run As Account, ..

fro 2

Create Run &s Profile, ..

Mew channel 3

iy

Mew subscriber,

" o [

Mew subscripkion. ..

[+

M Add Management Group

W Refresh F5
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The Computer and Device Management Wizard is displayed:

Figure 4-2: Computer and Device Management Wizard

General Properties Choose the type of computers or devices to discover and manage.
Digcoverny Method

Default Accounts s e s
Devices Digcover Wwindows computers in your Active Directory
7 "j environment and install agents an the ones yau want to

Schedule Discovery I" 7 manage.

Sumrary
Campletion
UNIX/Linux computers
Thig enables pou to dizcover IMIE and Linug computers in
your erwironment and install agents on the ones you want to
manage.
o

Network deyices

“4541 Discover and manitor netwark devices uzing Simple
& Metwork banagement Protocal [SHMP)

Select a discovery type and click Mexst to continue.

<E|evious| Mext » I Create | Cancel |

2. Select the Network devices option, and then click Next; the General Properties
window is displayed:
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Figure 4-3: General Properties

I Network Devices Discovery Wizard
General Properties @ Help
Dizcovery Method Specify general properties
Default Adccounts
Devices
Schedule Discovery Dezcription [optionall:

Summary ;l
Carnpletion ;I

Select a management or gateway server

Select an Operations Manager management zerver or gateway server to iun the
dizcoveny. & server can run only one network. discovery. Servers that alieady run a
netwiork. discovery do not appear in the list.

Available servers:

SCOM.ilyncT 5 lacal =]
Select a resource pool Create Resource Poal |
Select an Operationz Manager resource poal for monitoring of dizcovered netwiork.
devices.

Available pools:
All Management Servers Resource Pool j
< Frevious | Mest » I Save | Cancel |

3. Inthe 'Name' field, enter a description of the Discovery Rule.

4. From the Available servers drop-down list, choose the SCOM server e.g.,
SCOM.iLync15.local, and then click Next; the Discovery Method window is displayed:

SCOM 27 AudioCodes Management Pack



/S )
(™ AudIOCOdES AudioCodes SCOM Management Pack

Figure 4-4: Discovery Method

F MNetwork Devices Discovery Wizard [ %]

e

General Properties

@) Help
Select a discovery type
Default Accounts
] (+ Explicit discovery
Devices Operations Manager will discover only those network devices you specify.
Schedule Discovery
Summary " Recursive discovery
Completion Operations Manager will discover the devices that you specify and all devices that are

connected to the devices that you specify

IZ@ZIMore about discovering network, devices

<Erevi0us| Mext > I Save | Cancel |

5. Select the appropriate actions, and then click Next; the Defaults Accounts page is
displayed:

Figure 4-5: Default Accounts

F Network Devices Discovery Wizard [ %]

General Properties @) Help

Discovery Method specify the default Run As accounts for discovery

Select one or more SHMPYT or SNMPv2 Run &3 accounts as the default accounts for
Devices discovering network devices. You can overide the default accounts for individual network
devices or add accounts for SNMP3 devices later in this wizard.

Schedule Discovery

Surnmar
Y Create Account...

Completion
" Bun Az accounts:
| Account Mame | Description |
public
Select Al Clear &l |

More about Fun &3 accounts

< Previous | Mest » Save Cancel
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6. Choose the default SNMP SCOM account (this account is always-'public’) or click
Create Account button to create a new default account; a wizard opens. Enter a
Display Name and Community String (use the same community string that is
configured on the network device that you wish to discover), and then click Create.

7. Click Next; the Devices page is displayed with the new user details:

Figure 4-6: Devices

F MNetwork Devices Discovery Wizard [ %]
.
General Properties @ Help
Dizcovery Method specify devices
Default Accounts Specify the network devices that you want ta dizcover and manage. You can also import a

text file that contains the P addreszes of your network. devices.

Schedule Discovery

Summary || Import... I;':',:&dd... B‘Edit... Kﬁemove
Caompletion Devices:
Device | Fiun Az Account | SHMP Versionl Fort | Accesz Mode |
1595.189.192.249 Usze default accounts W1 oy 161 SHEP
10.30.60.218 public W1 ory2 161 SHMP
10.30.50.217 Usze default accounts W1 oy 161 SHEP
10.30.50.219 Usze default accounts W1 oy 161 SHEP

| Advanced Discovery Settings. .. I

':@:'MD[E about network, dizcovery settings

< Previous | Mest » | Saye | Cancel |

8. Click the “*##.. pytton to add the IP addresses of devices to be discovered (if you
wish to add a device with SNMPv3, see Section 5 on page 37); the Add a Device
dialog is displayed:
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Figure 4-7: Add a Device

Add a Device E3

Specity the settings for the netwark, device you want to dizcowver.

Mame or IF address: ()

Access mode: SHMP version:
Iv'l or e j
Fort number: SHMP YT or'Y2 Run As account:
161 z IUSE selected default accounts j

Add SHMP 1 or W2 Bun Az Account |

'Z'E'Z' bore about network, discoveny settings

[F I Cancel

9. In the 'Name or IP address' field, enter the Enter the Name or IP address of the
device.

10. From the Access mode field drop-down list, select SNMP.

11. Optional: From the 'SNMP V1 or V2 Run As Account' drop-down list, select a different
already configured default account.

e If you wish to configure a new SNMP V1 or V2 default account, then click the
Add SNMP V1 or V2 Run As Account button; a wizard opens. Enter a Display
Name and Community String (use the same community string that is configured
on the network device that you wish to discover), and then click Create.

Note that the same dialog opens as in the 'Default Accounts' step above.
12. Click Next; the Schedule Discovery screen is displayed:
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Figure 4-8: Schedule Discovery

F Metwork Devices Discovery Wizard
b
General Properties @ Hebp

Dizcovery Method Schedule the network discovery

Detault Azcounts
" Run the discovery mile at scheduled times

Devices

Scheduls Time of day:
Summary IDD:DD 3:
Diaps of the week:
[T Sunday

I~ tanday

I~ Tuesday

[T wednesday
[~ Thursday

™| Friday

[T Saturday

Carmpletion

% Fun the discovery rule manually

< Previous | Mext > I Save Cancel

13. Select the Run the discovery rule manually option, and then click Next; the
Summary page is displayed:
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Figure 4-9: Summary

F MNetwork Devices Discovery Wizard [ %]
General Properties @ Help
Discovery Method Confirm the settings
Default Accounts J
Devices Name .

Audiocodes GWs discovery
Schedule Discovery

Description:
Summary
Completion Run As accounts:

public

Discovery method:

Explicit

Number of devices specified:

4

Schedule:

Run Manuzly

< Previous I et > Save | Cancel |

14. Review the settings, and then click Save.
15. Wait for the discovery rule to complete saving.

Figure 4-10: Discovery Saving Progress

f‘ Metwork Devices Discovery Wizard [ %]

General Properties @ Helb
Dizcovery Method Creating the discovery...

Default sccounts :‘l“' Please wait while the discovery e is created.  This could take a minute

Devices » depending on the speed of your computer.

Schedule Discovery
Summary

Cormpletion

< Brevious | et > | Saye | Cancze

16. Click the Close button; a confirmation window is displayed:

User's Manual 32 Document #: LTRT-30804



User's Manual 4 Discovering Gateway Devices

Figure 4-11: Network Discovery Rule Confirmation

E Network Devices Discovery Wizard

General Properties @) Help

Digcovery Method
Y @ The network discovery rule was successfully created

Default dccounts

Devices

Schedule Discover . § .
Y ¥ Bur the netwark. dizcovery e after the wizard iz closed

Summary

Campletion . . . . L
" To wiew progress when a network. dizcovery rule iz running, open the Administration
workepace, expand Metwork M anagement, and click Discoven Rules.

LCloze |

The newly created rule should appear in the 'Discovery Rules' pane. When the rule
has been successfully created, it should have the status 'Idle'.

Wait for 5-8 minutes to allow the SCOM to make a full discovery.

Figure 4-12: Discovery Rules Confirmation
[_[o]x]

PR piscovery Rules - Audiocodes - Dperations Manager

File Edit View Go Tasks Tools Help
Searchv _ i ¥,

Administration < Discovery Rules (1)

[ Agentiess Managed 2| ALookfor: EindWow  Clear x

&l Management Servers | Wetwork Discavery Server + | status ¢ | LastDiscovered /| LastPending | LastRun Time I
01/12/2012 22:50:27

& Pending Management SCOM_SGL2008_R2.Giant-Steps... Idle 1 o
3 UND{Linux Camputers
% Management Packs
4 (3 Network Management
1 Discovery Rules
2 Netwark Devices
¥ Metwark Devices Pending Management
4 Notifications
% Channels
&) Subseribers
“5] Subscriptions
4 & Product Connectors
Q0 Internal Connecors
4 Resource Pools
4 5 Run &s Configuration Al
i Accounts Details:

2. profiles -

i

aued yse|

<

Discovery Wizard...

Bl Monitoring
A Authoring
"\ Administration

7{, My Workspace

Ready
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17. Click the Administration pane, and then in the Navigation tree, select Network
Devices.

Figure 4-13: Network Devices
il E3

PR Network Devices - Audiocodes - Dperations Manager

File Edit View Go Tasks Tools Help

Administration < Metwork Devices (5)

B agentiess Managed | A Lookfor: | Find How Clear M

]
&l Management Servers kame 4| 1P Address RunAs Account Access Mode

PG g e 4 Resource Pool: All Management Servers Resource Pool (5)
[ UND¥Linus Computers
W Management Packs
4 ,-=§ Metwork Management
ﬂj Discowery Rules
= Netwark Devices
5¥ Metwark Devices Pending Management Audiocades.com

10.30.50.217 10.30.50.217 public SMMPONLY

10.30.50.217 10.30.50.217 puhlic SHMPOMLY

10.30.50.219 10.30.50.219 puhblic SHMPOMNLY

Audiocodes,com 195.189,192.249 public SMMPOMLY
195.189,192.249 public SHMPORNLY

4 ] Motifications
i Channels
;‘3] Subscribers
“2) Subseriptions
4 & Product Connectors
L5 Internal Connectars
A4 Resource Pook
Fl {3’; Run &3 Configuration
7] Accourts
3. Profiles

=l
S0 LIRIT L v e S m ik

Discovery Wizard,..

aueq yse|

.‘ Monitaring
_/I‘ Authering
Administration

@ My Workspace
T 4l | 2l

Ready

All discovered gateways are displayed in this window.

Note: Wait for five-eight minutes to allow the SCOM to make a full discovery.
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4.2 Managing SCOM Accounts

SCOM accounts are managed in the Accounts screen.

>
1.

To view currently defined SCOM user accounts:

Open the Accounts page (Administration > Run as Configuration > Accounts); a
screen similar to the following is displayed:

Accounts Page

Accounts (13) * Tasks

Mame # | Description Last Modified = ‘@‘

4 Type: Action Account (2) Actions ~
6’} ILYMC1SWAdministrator This is the user account under which all rules run by default on the agent, 117372013 11:39:22 AW 3
@ Local System Action Account Built in SYSTEM account o be used 35 an action accaunt 10303 s ap | P

4 Type: Community Sting (1) /% Delete
L pusiic 11742013 T2z Py ¢ (o) Creste Run As Account.

4 Type: SNMPv3 Authentication (7)

ALy Brad
& Brad
& Brad
& Daniel
L Mike
L Mike
& Ofer

4 Type: Windows (3)

‘r.z Data Warehouse Report Deployment &., Data \Warehouse Report Deployment Account 11/3/2013 11:47:10 &M
7 Local System Windows Account Built in SYSTEM account 11/3/2013 11:18:27 &b
S Metwork Service Windows Account Built in Metwork service account 117372013 11:18:27 &b

11/6/2013 11:36:25 Abd
11/5/2013 f:29:53 PM
11/6/2013 11:39:37 Ak
11/6/2013 2:55:07 PM
11/6/2013 2:17:27 PM
11/6/2013 2:13:41 PM
11/6/2013 2:19:45 P

[l

e To view the account properties, select an account, and then in the Tasks pane,
click the Properties button.

e To delete a user, select an account, and then in the Tasks pane, click the Delete
button.

42.1 Adding Network Devices to Discovery Rule

This
>
1.

section describes how to add network devices to an existing Discovery Rule.

To add network devices to an existing discovery rule:

In the Discovery Rules window, double-click the Discovery Rule; the Network Devices
Discovery Wizard is displayed with the existing settings.

Run the wizard as described above in Section 4.1 on page 25.
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5 Configuring SNMP

This section describes how to configure the SNMP connection between the managed
AudioCodes devices and the SCOM.

The following topics are described:

B Adding SNMPv3 Users. See below.

B Disabling SNMP trap service. See Section 5.2 on page 46.

B Setting up the device to send SNMP traps. See Section 5.3 on page 47.

5.1 Adding SNMPv3 Users

This section describes how to add SNMPv3 users. You initially need to create the SNMPv3
on the device in the Web Interface, and then add the same user in the SCOM using the
Discovery Wizard.

Note: You must configure identical user credentials in the SCOM as you configure in the
Web Interface.

51.1 Adding SNMP V3 Users in the Device Web Interface

The SNMP v3 Users page allows you to configure authentication and privacy for up to 10
SNMP v3 users.
» To configure SNMP v3 users:

1. In the device Web Interface, open the SNMP v3 Users page (Configuration tab >
System menu > Management sub-menu > SNMP sub-menu > SNMP V3 Users).

2. Click Add; the following dialog box appears:
Figure 5-1: SNMP V3 Setting Page - Add Record Dialog Box

Add Record

Index ]

ser Mame

Authentication Protocol Mone -
Privacy Protocol Mone -

Authentication Key

Privacy Key

Sroup Read-Wiite -

@ Submit *® Cancel

3. Configure the SNMP V3 Setting parameters according to the table below.
4. Click Submit to apply your settings.
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Parameter

Index
[SNMPUsers_Index]

User Name

[SNMPUsers_Username]

Authentication Protocol
[SNMPUsers_AuthProtocol]

Privacy Protocol
[SNMPUsers_PrivProtocol]

Authentication Key
[SNMPUsers_AuthKey]

Privacy Key
[SNMPUsers_PrivKey]

Group
[SNMPUsers_Group]

Table 5-1: SNMP V3 Users Parameters

Description

The table index.
The valid range is 0 to 9.

Name of the SNMP v3 user. This name must be unique.

Authentication protocol of the SNMP v3 user.
= [O] None (default)

= [1] MD5

= [2] SHA-1

Privacy protocol of the SNMP v3 user.

= [O] None (default)

= [1] DES

= [2] 3DES

= [3] AES-128

= [4] AES-192

= [5] AES-256

Authentication key. Keys can be entered in the form of a text

password or long hex string. Keys are always persisted as long hex
strings and keys are localized.

Privacy key. Keys can be entered in the form of a text password or
long hex string. Keys are always persisted as long hex strings and
keys are localized.

The group with which the SNMP v3 user is associated.
= [0] Read-Only (default)

= [1] Read-Write

= [2] Trap

Note: All groups can be used to send traps.

User's Manual
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512 Adding SNMPv3 Accounts in SCOM

This section describes how to add SNMPv3 users in the SCOM.

» To add SNMPv3 accounts:
1. Inthe Add a Device dialog, from the 'SNMP Version' field drop-down list, choose v3.
Figure 5-2: Add a Device

Add a Device E3

Specify the settingz for the network, device pou want to dizcover.

Mame or P address: ()

Accezs mode: SHEP wersion:

SNMP 1 orv2 =l
Part number: SHMP %1 or V2 Bun Az account:

161 = IUSE zelected default accounts j

Add SHMP YT or W2 Bun bz Account |

[@I‘ Maore about nebwark. dizcoven sethings

[ I Cahel |

Figure 5-3: SNMPv3 Device Settings

ndd apewce

Specify the settings for the network device you want to discover.

Mame or IP address: ()

[10.15.21.15

Access mode: SHMP wersion:

[ICMP and SNMP 3 =l
Part number: SHMP %3 Run As account: G

|'|E1 3:

Add SHRP Y3 Bun As Account

'Z'E'Z' bore about nebwork. dizcoverny settings

[ I Cancel
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2. Do one of the following:

e  From the 'SNMP V3 Run As Account' drop-down list, select an existing SNMP V3
account, and then click OK. Proceed to step 5.

e Click the Add SNMPv3 Run as Account button; another wizard is displayed:
Figure 5-4: General Properties

?;. Create Run As Account Wizard

Introduction

General Properties Specify general properties for the Run As account

Credentialz
Select the type of Run As account that wou want to create, and then provide a display name

and description.

Run As account type:

ISnmp\-‘S.ﬂ.ccnunt j

Display name;

IBrad|

Description {optional):

&

<F'revicnusl MHext » Create Cancel |

4
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3. Enter an appropriate Display Name, and the click Next; the Credentials screen is
displayed:

Figure 5-5: Credentials

?;, Create Run As Account Wizard

Introduction

General Properties Provide account credentials

Credentialz

Provide credentials For this Fun As account For SMMPw3 devices.

Uzer name: Context [optional):

[ o [

Authentication protocal: Frivacy protocal:

INone j INDne j
Luthentication kew Frivacy kew

Confirm authentication kew: Confirm privacy ke

<F'leviaus| st > | Create | Cancel |

4

4. Enter the the same credentials that you entered in Section 4.1 on page 25 and in
Section 5.1.1 on page 37, and then click Create; the following is displayed:
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Figure 5-6: Confirm Device Settings

Device Settings
Specify the zettings for the network device pou want to discover.
Marne or [P address:
Access mode: SMMP wersion:
[ICMP and SHMP =l v ~|
Port rurmber: SHMP Y3 Run &s account:
161 : |Brad I
Add SHMP Y3 Run As Account |
IZIE' M aore about network: dizcoveny zettings
ak. I Cancel
The Devices page is displayed with the details of the new SNMPv3 account:
Figure 5-7: Devices Page
!ﬂ Network Devices Discovery Wizard [ x|
A
General Properties @ Help
Dizcovery Method Specify devices
Default Accounts Specify the network devices that you want to dizcover and manage. “r'ou can also import a
tewt file that contains the P addresses of pour network. devices.
Schedule Discovery
Surmmary || Import... 2aadd... [ Edit.. 2 Remove
Campletion Devices:
Device I Run &g Account I SHMP Velsinnl Fort I Access Mode I
10.15.7.8 Use default accounts W1 or 2 161 ICHP and SH...
108731 Use default accounts W1 o2 161 ICHP and SH...
1039037 Use default accounts W1 o2 161 ICHP and SH..
10.393.230 Use default accounts W1 o2 161 ICHP and 5H..
1015.21.15 Brad W3 161 ICHF and SH...
| Advanced Discovery Settings... |
IZ:ZQ:IIMDIE about network. discowveny settings
< Previous | Hext » | Save | Cancel |
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5. Click OK; the Schedule Discovery screen is displayed:

Figure 5-8: Schedule Discovery

F' Network Devices Discovery Wizard
)
General Properties @ Help

Dizcovery Method Schedule the network discovery

Default Accounts
" Run the discovery mle at scheduled times

Devices

Schedule 1 Time of day:
Summary Im
Days of the week:
[T Sunday

[T Monday

[T Tuesday

[T wednesday
™ Thursday

[~ Erday

[T Saturday

Completion

" Run the discoveny iile manually

< Previous | Mext > I Sawe Cancel

6. Select the Run the discovery rule manually option, and then click Next; the
Summary page is displayed:
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Figure 5-9: Summary

f‘ MNetwork Devices Discovery Wizard [ %]
General Properties @ Help
Discovery Method Confirm the settings
Default Accounts J
Devices Name .

Audiocodes GWs discovery
Schedule Discovery

Description:
Summary
Completion Run As accounts:

public

Discovery method:

Explicit

Number of devices specified:

4

Schedule:

Run Manuzly

< Previous I et > Save | Cancel |

7. Review the settings, and then click Save.
The following message may be displayed:
Figure 5-10: Warning
YWarning |

The following accounts need ko be distributed to the health service
! L 'SCOMLikynclS.local' and the members of the management pool "all

Management Servers Resource Pool' inarder for the discovery to

vk

Brad

Would wou like Sperations Manager ko distribute the accounts?

ves: Distribute accounts and create the discovery,
Mot Do nok distribuke accounks and do nok create the discovery,

8. Click Yes to confirn.
9. Wait for the discovery rule to complete saving.
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Figure 5-11: Discovery Saving Progress

I Network Devices Discovery Wizard E

General Properties @) Help

Dizzovery Method Creating the discovery...

Defait Accaunts #"5.  Please wait while the discovery rile iz created.  This could take a minuke

»
Devices % depending on the speed of your computer.

Schedule Discovery
Summary

Completion

<Erevious| et > | Save | Canicel

10. Click the Close button; a confirmation window is displayed:

Figure 5-12: Network Discovery Rule Confirmation

F Network Devices Discovery Wizard

General Properties @) Help

Digcovery Method
Y @ The network discovery rule was successfully created

Default Accounts
Devices

Schedule Discover . § .
Y ¥ Bum the netwaork dizcovery e after the wizard iz closed
Summary

Campletion . . . . L
" To wiew progress when a network. dizcovery rule iz running, open the Administration

workepace, expand Metwork M anagement, and click Discoven Rules.

LCloze |

Wait for the SCOM to make a full discovery.
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5.2 Disabling SNMP Trap Service

In order to view traps from the monitored AudioCodes devices, you must disable the SNMP
Trap service.

» To disable SNMP Trap services

1. Click > Start > Administrative Tools > Services.

2. Ensure that the service SNMP Trap is disabled.

3. Restart the service System Center Management.
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5.3  Setting up the Device to Send SNMP Traps
In order for the device to automatically send SNMP traps to the SCOM server, you must
confiigure the IP address of the SCOM server as a Trap Destination.
» To send SNMPv3 traps to the SCOM:
1. Open the SNMP Community String page (SNMP > Community String).
Figure 5-13: SNMP Community String
( SNMP Community String 7
Read Only 1
Read / Write
Read / Write
Read / Write
Read / Write
Read / Write
% Disable SNMP [ -
Trap Community String public
Trap Manager Host Name SCOM o
v
Subimit
2. Ensure that the parameter 'Disable SNMP' is set to default No.
3. Click Submit to apply the changes.
4. Open the SNMP Trap Destinations screen (SNMP > SNMP Trap Destinations).
Figure 5-14: SNMP Trap Destinations
( SNMF Trap Destinations W
IP Address Trap Port Trap User Trap Enable
O SNMP Manager 1|10.15.25.35 162 Brad - Enable =
0| snmp Manager  2/0.000 162 v2cParams v | Enable +
Ol snmp manager  3/0.0.0.0 162 v2cParams ~ |  Enable ~
0| snmp Manager  4/0.00.0 162 v2cParams v | Enable +
«
Ol snmp manager  5/0.0.0.0 162 v2cParams ~ | Enable ~ Submit
5. In the IP Address field, type the IP address of the SCOM server to which you wish to
send traps.
6. From the Trap User drop-down list, select the SNMP Trap User that you defined in
either Section 5.1.1 on page 37 or in Section 4.1 on page 25.
7. Click Submit to apply the changes.
(Optional): In the SNMP Trusted Manager screen, type the IP address of the SCOM
server to which you wish to send traps.
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Figure 5-15: Trusted Manager IP Address

( SNMP Trusted Managers W
Delete Trusted Managers IP Address
SNMP Trusted Manager 1 10152635
SNMP Trusted Manager 2 0.0.00
SNMP Trusted Manager 3 0000
SNMP Trusted Manager 4 0.0.00
SNMP Trusted Manager 5 0.0.00

Submit

9. Click Submit to apply the changes.

SNMP Trap Destinations Parameters Description

Parameter Description
Web: SNMP Manager Enables the SNMP Manager to receive traps and checks
[SNMPManagerlsUsed_x] the validity of the configured destination (IP address and

port number).
= [O] (check box cleared) = (Default) Disables SNMP

Manager

= [1] (check box selected) = Enables SNMP Manager
Web: IP Address Defines the IP address (in dotted-decimal notation, e.g.,
[SNMPManagerTablelP_x] 108.10.1.255) of the remote host used as the SNMP

Manager. The device sends SNMP traps to this IP

address.
Trap Port Defines the port number of the remote SNMP Manager.
[SNMPManagerTrapPort_x] The device sends SNMP traps to this port.

The valid value range is 100 to 4000. The default is 162.
Web: Trap User Associates a trap user with the trap destination. This
[SNMPManagerTrapUser] determines the trap format, authentication level, and

encryption level.

= v2cParams (default) = SNMPv2 user community string

= SNMPv3 user configured in ‘Configuring SNMP V3
Users' (see Section 4.1 on page 25)

Trap Enable Activates the sending of traps to the SNMP Manager.
[SNMPManagerTrapSendingEnable_x] . [0] Disable

= [1] Enable (Default)
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6 Viewing Gateway Element States

This section describes the GW Elements States. The following topics are described in this
section:

GW Element State View. See Section 6.1 below.

Modules - All Modules State View. See Section 6.2 on page 51.
Modules - System Modules State View. See Section 6.3 on page 52.
Modules — Fan Tray State View. See Section 6.4 on page 53.

Modules — Power Supply State View. See Section 6.5 on page 54.
Trunks/Ports — Digital Trunks State View. See Section 6.6 on page.
Trunks/Ports — Ethernet Ports State View. See Section 6.7 on page 56.

6.1 GW State View

This section describes the GW State View.

» To open the GW State View:

B Inthe AudioCodes Gateway folder, select GW State View; a screen similar to the
following is displayed:

Figure 6-1: GW State View

B2 Gw state Yiew - Audiocodes - Operations Manager [ (O] x|
Fle Edit Wiew Go Tasks Tools Help
Monitoring < GW State View (1) ¥ Tasks
=] Windows Computers | 2 Look for: I Find Mow Clear x @ @
» [ Agentless Exception Maniorin i i
.3 9 [ 3 S.:fate | Mame | Display Mame | Device Version | Device Type | State Actions ~
2 Application Monitoing -:g,g:- Critical TestDewice TestDewvice £.404,058.005 Product: MG 1K
4 |5 Audincodes Gatewsys Ajj’ Start Maintenance |
| GW Alerts Wiew
S G Perfarmance i
=2 G state View =
[T Personalize view..
4 | Modules
| &l Modules Alert Wiew Node Tasks A
All Modules State iew
. [ ping
Fan Tray State \iew
Power Supply State Wiew C3 ring
£:7] system Modules State View T3 set Device Name
4 | TrunksfPorts 3 snow Active Alarmg
| Al Trunk/Parts Alert iew '=j SNMP GET
=% Digital Trunks State Wiew
== T3 sHMP Walk
2:i| Ethernet Ports State iew =
+ [ A Dataareh o F— & Telnet Console
7l ataAarehnie | = =| Detail View -
[F Testcan
-
Shovw or Hide Yiews... =
Y9 Audiocodes SNMP Device properties of TestDevice '=J Traceroute
Mews Wiews b -
estDevice T ~
. TestDevice
Bl monitoring SNMPONLY [=] Entity Properties
o GENERIC
p i Health Explorer
W[ fmifiify Product: MG 1K:SW Version: 6.40A.058.005 - P
) 00-80-8F-13-2E-68 I
"\ Administration 00-30-8F-13-26-68 Navigation A
m My Workspace | Alert view
- 161 7 N
2 D agram View
- act
ﬂ t2| Event View -
Ready A

This screen is described as follows:

e The GW State View window contains all discovered gateways and their current
health state.

o  The Detail View pane at the bottom of the GW State View window contains the
details of each selected gateway, including the Device address and
description.GW State View contains several fields with specific information about
the gateway, including 'State' and 'IP Address'.
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Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.

You can change the GW State View using the Personalize option — right-click any
column name and select Personalize View or in the Tasks pane, select
Personalize View; the Personalize View window is displayed:

Figure 6-2: Personalize View

-
Personalize View

ure = :

Columns to display

IF Address

[] DeviceVersion
[] DeviceDescription
[] Device Contact
[] Device Lacation
[] Device OID

[] community String
[] SNMP Version
|| Display Name
[] Device Type

[ Trunks Count

[] channels Count
[ Last Reboot Time
] Product Type

[] Device Name

] name

[] Audiocades System MaduleClass
|| [[] Audiocodes CPUModule

[] Audiocades IPMedia Module

[] Audiocodes IF Digital Module

[] Audiocodes IFAna
[7] Audiocodes IFBRI

Sort columns by

- ’IP Address ']

@ Ascending
() Descending

Group items by

(Mone)
= Then by:
(Mone)
Then by:
(Mone) @ |

log Module
Maodule -

[asatoosn ) o] [_cna llJ

In this window, you can select the fields you wish to view in the GW State View
and sort the data inside the view.

In addition, you can filter the data displayed in the view using the 'Look For filter:
Figure 6-3: Look For Filter

Look for: Find Mow
_{_
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6.2 Modules — All Modules State View

This section describes the All Modules State View.

» To open the All Modules State View:

B Inthe AudioCodes Gateways folder, select Modules > All Modules State View; a
screen similar to the following is displayed:

Figure 6-4: All Modules State View

2R all Modules State Yiew - Audiocodes - Operations Manager JE[=]
Fle Edt View Go Tasks Tools Help

i seach v _ B Seone @ .
Meonitoring < All Modules State View (5) * Tasks

[# Discovered Inventory | & rookfor: Find Now  Clear x 0@

5| Distributed Applicatiors

‘ _ Audiocades ‘ Audiocodes State
= State Name % | Slot (&9 Trunk Base: Ethernet Port .
.!-. Task Status A fa o Actions
jd:‘:’;‘;";“:;m&:‘;’s @ Heattny TestDevice: PowerSupply Module at Slat 1 Slot 1 ) W Start Maintenzn

= . k &3 Critical TestDevice: achecliantl000IFDigitalMadule at Slot 0 Slot 0 3 Critical

Agentless Exception Monitaring -

9;\ S @ Healthy TestDevice: achediant1000CPUmadule at Slot @ Slat 0

4 Application Manitaring
e @ Healthy Mal-10.30.52,31: Powersupply Madule at Slot 1 Slat 1 =

7= . = b

Deran— @ Healthy M4-10.30.52,31: Pawersupply Module st Slat 1 Slot1 e

bee] Gw Performance View
22 G State View
4 |5 Modules
= @ Heslth Explorer
=] AllModules Alert View
&%| All Modules State View
%] Fan Tray State View

Tasks ~

[E] Entity Propertieq

Navigation ~

- 2] Alert View
%] Power Supply State View
£7] system Modules State View <] Diagram View

4 |5 Trunks/Ports
| AnTrunk/Ports Alert view
&%| Digital Trunks State View
%] Ethernet Ports State View ] state View
4 Data Warehouse

+3| Event view
[ Network Vicini

5 performance Vit

4 Microsoft Audit Collection Servicss

A Microsoft Windows Client

A Microsoft Windows Server

4 Network Monitoring

4 Operations Manager

4 Synthetic Transaction

A UNDX/Linux Computers

A Web Application Transaction Moritoring

A Windows Service And Process Manitaring =| Detail View -
Shaw or Hide Views.. ' i E
B Audiocodes Module Base Class properties of TestDevice: PowerSupply Module at Slot 1
Hew View »
Display Name TestDevice: PowerSupply Module at Slot 1
. Full Path Name TestDevice: PowerSupply Module at Slot 1
.‘ Loeaiatiley IP Address 195.189.192.249
> Auth Slot slot1
¥ oo Index 2
o . Key OID 136141.50039.10.104.2313.2
Administration
[ My Workspace

Ready

This screen is described as follows:

e All Modules State View contains all modules of all discovered gateways as they
are hosted on the real devices. The data represented in this view can be
personalized as described in Section 6.1 on page 49.

e  Select a module to load the Detail View pane at the bottom of the All Modules
State View window.

e  Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.

Note: Performance view is not supported at this monitoring level.
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6.3 Modules — System Modules State View

This section describes the System Modules State View.

» To open the System Modules State View:

B In the AudioCodes Gateways folder, select Modules > System Modules State View;
a screen similar to the following is displayed:

Figure 6-5: System Modules State View

PR 5ystem Modules State View - Audiocodes - Operations Manager

JH[=1 E3
fle Edit View Go Tasks Tools Help
Monitoring ¢ System Modules State View (10) * Tasks
[ Discovered Inventory | & rookfor: Find Now  Clear x @@
5| Distributed Applicatiors a Audiocodes & B grate
1 State Mame * | Cperational State &9 Trunk Base Slot 29 Dig .
e Task Status = = 2! Actions
i o @ critical TestDevice: acMediantl000IFDigitalModule at Slot 0 Unknown: -1 & Critical slat 0 @ ) st Miaintensn
%] windows Comput:
e @ Heatthy TestDevice: acMediantl000CPUMadule at Slat 0 Unknown; -1 Siet
4 Agentless Exception Monitoring - P .
& Critical M1K-10.30,52.5: achediant10DOIFDigitalModule at Slot 0 Unknown: -1 9 Critical slat 0 & cr
4 Application Monitoring - : :
(@ Healthy MLK-10.30,52.5: acediantl000CPUmadule at Slot 357 Unknown: -1 Slat 967
4 |5 Audiocodes Gateways < -~ [T Personalize view
(] GW Alerts View & Critical MLE-10.30,52.4: acMediantl000IFDigitzIMadule st Slot 111 Unknown: -1 9 Critical Slot 111 & cr
5 GW Performance View (@ Healthy M1K-10.30,52.4: achediant1000CPUMadule at Slot 39 Unknown: -1 Slat 99 Tasks ~
¥ Gw State View & Critical MILE-10.30,52.3 acMediant1000IFDigitalModule at Siot 51 Unknown: -1 9 Critical Slot 51 O & = iy propertic
4 |5 Modules (@) Healthy MLK-10.30,52.3: acMediantl000CPUmadule at Slot 2038 Unknown: -1 Slot 2038
. = - - 8 Health Explorer
| AllModules Alert View (&3 Critical M1E-10,30,52,1: acMediant1000IFDigitalMadule at Slot 263 Uniknown; -1 &9 Critical Siot 263 &
£1] All Modules State View (@) Healthy M1E-10,30,52,1: acMediant1000CPUMadule at Slot 0 Uniknowm: -1 Slot 80 Navigation ~
%] Fan Tray State View
= 2] Alert View
%] Power Supply State View
%] System Modules State View <] Diagram view
4 |5 Trunks/Ports +3| Event view
o] AllTrunk/Ports Alert View [ Network Vicinity
&%| Digital Trunks State View 5 Performance vid
%] Ethernet Ports State View —
1] state View
1, Data Warehouse
5 Microsoft Audit Collection Services
3 Microsoft Windows Client
2 Microsoft Windows Server
A Network Monitoring
7 Operations Manager
A Synthetic Transaction
A UND{/Linux Computers
4 Web Application Transaction Monitoring 4 | =
2 Windows Service And Process Monitoring =| Detail View v
Show or Hide Views.. ) ) =
B Audiocodes System Module Class properties of TestDevice: acMediant1000IFDigitalModule at Siot 0
MNew View »
Display Name TestDevice: acMediantl000IFDigitalModule at Slot 0
. Full Path Name TestD: i i i at Slot 0
.‘ bttty IP Address 195.189.192.249
? Auth Slot Slot 0
¥ oo Index 67387393
oy . Key OID .1.36.1.41.5003.9.10.104.21.1.3.67387393
Administration
= Geagraphical Pasition (]
m e e Type acMediant1000IFDigitalModule
- Presence missing
= License Key List 2
Coviat Mumbiar : =l
Ready 7

This screen is described as follows:

e  System Modules State View contains all system modules of all discovered
gateways as they are hosted on the real devices. The data displayed in this view
can be personalized as described in Section 6.1 on page 49.

e  Select a module to load the Detail View pane at the bottom of the System
Modules State View window.

e  Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.

Note: Performance view is not supported at this monitoring level.
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6.4 Modules — Fan Tray State View

This section describes the Fan Tray State View.

» To open the Fan Tray State View:

B In the AudioCodes Gateways folder, select Modules > Fan Tray State View; a screen
similar to the following is displayed:

Figure 6-6: Fan Tray State View

PR Fan Tray State ¥iew - Audiocodes - Operations Manager M= =
Fle Edit View Go Tasks Tools Help

sy s @ .
Monitoring < Fan Tray State View > Tasks
] Discoversd Inventary | & Lookfor: Find Now  Clear X B @
%] Distributed Applications State + | Name |
;’2 Task Status Q/) Healthy 10.10.50.3 Fan... 10.10.50.3
28] UNDK/Limux Computers () Healthy 10.10.50.2Fan... 10.10.50.2
5] windows Computers (¥) Healthy 10.10.50.4Fan... 10.10.50.4
+ L Agentless Exception Monitoring @) Healthy FarTray 185, 189,132,240

State
Actions

2 Application Monitoring
4 | Audiocodes Gateways
=] GW Alerts View
B2 GW Performance View
5| GW State View
4 5 Modules
| AllModules Alert View
E:2] AllModules State View
=22] Fan Tray State View
5| Power Supply State View
2| System Modules State View
4 |5 Trunks/Ports
[ Al TrunksPorts Alert View
2| Digital Trunks State View
Ei%| Ethernet Ports State View
4 Data Warehouse

[T Personalize view

» g Microsoft Audit Collection Services
2 Microsoft Windows Cliernt
» [ Microsoft Windows Server
» [ Network Monitoring
4 Operations Manager
+ L Synthetic Transaction
7 UND{Linux Computers
+ [ Web Application Transaction Monitoring

4 Windows Service And Process Manitoring S| Detail View v

Show or Hide Views...

i) Select anitem inthe view above to display its details.
New View b ~c

Bl Monitoring
/| Authoring

% Administration

[#] my Workspace

Ready

This screen is described as follows:

e Fan Tray State View contains all fan trays of all discovered GWs as they are
hosted on the real devices. The data represented in the view can be personalized
as described in Section 6.1 on page 49.

e  Select a module to load the Detail View pane at the bottom of the Fan Tray State
View window.

e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.

Note: Performance view is not supported at this monitoring level.
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6.5 Modules — Power Supply State View

This section describes the Power Supply State View.

» To open the Power Supply State View:

B In the AudioCodes Gateways folder, select Modules > Power Supply State View; a
screen similar to the following is displayed:

Figure 6-7: Power Supply State View

PR power Supply State ¥iew - Audiocodes - Operations Manager =]
Fle Edit View Go Tasks Tooks Help

Searchw _ | By Scope @ .

Monitoring ¢ Power Supply State View (8) > Tasks
[ Discovered Inventory ;| & Look far: Find Now Clear x B @
2] Distributed Applicatiors State | Name: x| siat State
 Task Status () Healthy  TestDevice: PowerSupply Module at Slot 1 slot1 Actions
J UNDX/Linux Computers () Healthy  Mdk-10.30.52,32: PowerSupply Module at Slot 1 slot1 W start Mointeran
] windows Computers (&) Healthy  M4K-10.30.52,31 PowerSupply Module at Slot 1 slotl
SIR0Caless L Pl D B (@) Healthy  M4#K-10.30.52,51; PowerSupply Module at Slet 1 st L
Application Monits
i b | (@) Healthy  M1K-10.30.52,5: PowerSupply Madule at SIot L slat 1
4 | Audiocodes Gatew - "
_J T = (J) Healthy  M1K-10.30.52.4: PowerSupply Module at Slot 1 Slot1 [T Personaize view
ps erts View
D5 W Performance View () Healthy  M1K-10.30.52.3: PowerSupply Module at Slot 1 slot 1 T N
] Gw State view () Healthy  M1K-10.30.52.1: PowerSupply Module at Slot 1 slot 1

[=1 Entity Properties
4 [ Modules

=] AllModules Alert View
E2] AllMogules State View
£2] Fan Tray State View

M Hezith Explorer

Navigation

= =] Alert view

&%| Power Supply State View

&%] system Modules State View <| Diagram View
4 | Trunks/Ports +2] Event View

(=] Al Trunk/Ports Alert View
%] Digital Trunks State View
£%] Ethernet Ports State View

[E%] Wetwork vicinity

5 performance Vi¢

7 DataWarehouse ] sate view
% Microsaft Audit Collection Services
7 Microsoft Windows Client
 Microsoft Windows Server
4 Network Monitoring
4 Operations Manager
 Synthetic Transaction
% UNDO/Linux Computers
7 Web Application Transaction Monitoring
4 Windows Service And Process Monitoring = Detail View v
show ?r Hide Vievs. B Audiocodes Power Supply Madule properties of TestDevice: PowerSupply Module at Slot 1 =
e vien » Display Name TestDevice: Powersupply Module at Slot 1
Full Path Name TestDevice\TestDevice: Powersupply Module at Sot L
B Monitoring P Address 195.189.192.249
" siot slot1
\/ Authoring e ;
& pdministration Key OID 136141.5003.9.10104.2313.2
- HW Version
W My Workspace LEDs 1
@ Severity indeterminate
S Geographical Position 1 £
Ready P

This screen is described as follows:

e  Power Supply State View contains all power supply modules of all discovered
GWs as they are hosted on the real devices. The data represented in the view
can be personalized as described in Section 6.1 on page 49.

e  Select a module to load the Detail View pane at the bottom of the Power Supply
State View window.

e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.

Note: Performance view is not supported at this monitoring level.
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6.6  Trunks/Ports — Digital Trunks State View

This section describes the Trunks/Ports — Digital Trunks State View.

» To open the Trunks/Ports — Digital Trunks State View:

B Inthe AudioCodes Gateways folder, select Trunk/Ports > Digital Trunks State View;
a screen similar to the following is displayed:

Figure 6-8: Digital Trunks State View

R Digital Trunks State Yiew - Audiocodes - Dperations Manager

Hle Edit View Go Tasks Tools Help

i Search v _ | B Scope 9 .
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[ Task Status
#25] UMIX/Linux Computers
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A Agentless Exception Monitoring
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=] GW Alerts View
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5] Gw state view
4 |5 Modules
=] AllModules Alert View
2] AllModules State View
2] Fan Tray State View
2] Power Supply State View
2] System Modules State View
4 |5 Trunks/Ports
(2] All Trunk/Ports Alert View
2| Digital Trunks State View
22| Ethernet Ports State View
4 Data Warehouse

A Microsoft Audit Collection Services

3 Microsoft Windows Cliert
A Microsoft Windows Server
A Network Monitoring

4 Operations Manager

3 Synthetic Transaction

4 UND{Linux Computers

A Web Application Transaction Monitoring

A Windows Service And Process Monitoring

Show or Hide Views..

heew View b

Bl Monitoring
A Authoring

% Administration

B wy Workspace

Ready

< Digital Trunks State View (5) > Tasks

o] QLookfor: Find Now  Clear x @ @

State 5 | Hame | Alarm | State
&3 Critical TestDevice: acMediant 000[FDigitallodule at Slot 0: Digital Trunk #2 greyDisabled e
() Critical M1K-10,30,52,5: actediant1000IFDigitalModule 3t $lot 69: Digital Trunk #2 areyDisabled ,
R start Maintenan,
3 Critical M1K-10,30,52,1; ackediant1000IF DigitalModule at Slot 193 Digital Trunk #2 greyDisabled
(9 Critical M1K-10.30.52.3: acM ediant1000IF DigitalModule at Slot 0: Digital Trunk #2 greyDisabled
& Critical M1K-10,30,52,4; ackediant1000IF DigitalModule at Slot 25: Digital Trunk #2 greyDisabled

[ Personalize view
Tasks -~

[E] entity Properties

B Health Bxplorer

Navigation ~
| Alert View

<] Diagram view
2] Event View
[E%] Network Vicinity
b2 performance Vie|

£ state view

<| Detail View

B Audiocodes Digital Trunk Class properties of TestDevice: acMediant1000IFDigitalModule at Siot 0: Digital Trunk #2
Display Name TestDevice: acMediant1000IFDigitalModule at Slot 0: Digital Trunk #2
Full Path Name TestDevice\TestDevice: acMediant1000IFDigitalMadule at Slot O\TestDevice: i ig at Slot 0: Digital
Trunk #2
Gateway IP 195.189.192.249
Index 1
Key OID 13.6.1.4.1.50039.10.9.2.1.1.1.1.1
Led Status Color off
Led Status State Unknown: 10
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This screen is described as follows:

Digital Trunks State View contains all digital trunks of all discovered gateways as
they are hosted on the real devices. The data represented in the view can be
personalized as described in Section 6.1 on page 49.

Select a module to load the Detail View pane at the bottom of the Digital Trunks
State View window.

Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.
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6.7 Trunks/Ports — Ethernet Ports State View

This section describes the Trunks/Ports — Ethernet Ports State View.

» To open the Trunks/Ports — Ethernet Ports State View:

B Inthe AudioCodes Gateways folder, select Trunk/Ports > Ethernet Ports State
View; a screen similar to the following is displayed:

Figure 6-9: Ethernet Ports State View
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This screen is described as follows:

o Ethernet Ports State View contains all Ethernet ports of all discovered gateways
as they are hosted on the real devices. The data displayed in this view can be
personalized as described in Section 6.1 on page 49.

e  Select a module to load the Detail View pane at the bottom of the Ethernet
PortsState View window.

e Double-click a value in the 'Status' column to open the Health Explorer. For more
information, see Chapter 7 on page 13.
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6.8  Diagram View

The Diagram View displays the Gateways' modules in a diagram view. Right-clicking the
element in the diagram opens several additional options, such as opening element-related
views and element-related properties.

» To open the Diagram view:

1. Inthe Monitoring pane, select GW State View, and then select the desired entry.

2. In the Tasks pane, under Navigation, select Diagram View; a screen similar to the
following is displayed:

Figure 6-10: Diagram View
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6.9

Running Tasks

This section describes how to perform various tasks.

6.9.1

Pinging AudioCodes Device

This task describes how to execute the ping operation on the device.

>
1.

To execute the ping operation:

Open the GW State View (see Section 6.1 on page 49) and select the required

gateway.

Do one of the following:

a.

In the Node Tasks pane, left-click the Ping task.

Figure 6-11: Node Tasks Pane

R Gw state view - Audiocodes - Operations Manager
Fle Edit View Go Tasks Tools Help
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|| Active Blerts

=] DiscoveredInventony
w Distributed Applicatons
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52| windowws Computers
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> [ Application Monitoring

4 | Audiocodes Gateways

(| G Alerts View

52| Gy Perfarmance Wiew

£ Gy State Wiew

4~ Modules

=] All Modules AlertView
52| Al Modules State iew
52| FanTray State Wiew

£22] Power Supply State View
E22] system Modules State View

4 | Trunks/Ports

=] ANTrunk/Ports Alert view
£i2] Digital Trunks State View
2] Ethernet Ports State Wiew

Shini o Hide Wigws...

Iewe Wiews b
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_/{ Authoring
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Ready

< GW State View (3)

A Aok for |
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[

Detail View
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M1K-10.30.52.1
M4K-10.30.52.31

Eind Mow Clear

| Devics version
6.604,024.004

+ | Display Mame

M1K-10.30.52.1 6.404,058.005

M4K-10.3052.31  6.604.024.004

S¥  Audiocodes SNMP Device properties of M1K-10.30.52.1

M1K-10.30.52.1

M1K-10.30.52.1

SNMPONLY

GENERIC

Product: MG 1K;SW Version: 6.40A.058.005
00-90-8F-13-2E-£8

| Device Type
Product: MG 4K ...

Product: MG 1K
Product: MG 4K,

* Tasks

x @ @

FLaLe RLLGHS

Wi Start Maintenance Mode...

(1] Personalize view...

Tasks ~
= entity Properties

28 Health Explorer
Navigation ~
| Alert view

<| Diagram View

! 7| Event View

[5%] Wetwork Node Dashboard

m

[7%] Metwork Vicinity Dashboard
<] Performance View

fif| state view
Node Tasks ~
E Ping
¥ T3 ping
= E; Set Device Name
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3 snmpGer
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Cal Teinet Conscle

[ testacan
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OR
b.

In the Main Menu, choose Tasks > Node Tasks > Ping.

User's Manual

58

Document #: LTRT-30804




User's Manual 6 Viewing Gateway Element States

Figure 6-12: Tasks Menu
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The Ping Run Task window is displayed:

Figure 6-13: Run Task-Ping

Run the task on these targets

Target | Run an‘_a'!'i_nn |

Task Parameters

Marme | Walue |
Uszemname Admin

PinglP 127.0.01

Pagsword Admir

Deverride |

Task credentials Task description

(% Uz the predefined Run As Account
 Other:

User name : I

Password : I

Domain : |SCOM-PROJECT

Task confirmation

[~ Don't prompt when running this task in the future

Bun Cancel |
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Task confirmation of the task configuration window (see Figure 6-13), the next time the

f Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
Ping task is run immediately without the ability to change the task configuration.

2. (Optional) Override the Username and/or Password for the Telnet connection:

a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.

b. Setthe new values for Username and/or Password and Device Name.

c. Click the Override button.

3. In the Run Task window, click the Run button; the Task Status — Ping window is

displayed:
Figure 6-14: Task Status-Ping
@_ Task Status - Ping H=] E3
The kask completed successFully. &) Help
Task | Skakus | Task Target |
IE’)F‘ing Success 00
Task Output =2 Copy Text 521 Copy HTML
Fe
@ Ping Task Description ]
Skatus: Success
acheduled 12{14/2011 2:36:59 PM
Time:
Start Time: 12)14)2011 2:37:02 PM
. . SCOM-

Submitted BY: oo 0T Administrakar
Run As:
Run Lacatian:
Target:
Target Type:  Audiocodes SKMP Device o
Cakegory: Cuskom

Task Output:

| Qutppt |
ving 10_10.70.72 'l
‘ou can close this dialog at any time. Doing so will not inketrupt executing tasks, You can

check the status of tasks in a task status wiew.,
Close |

4

This window contains the Task execution status and output details.
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6.9.2 Displaying Active Alarms

This task describes how to display the active alarms in the ‘acActiveAlrmTable' table.

» To display the list of active alarms:

1. Open the GW State View (see Section 6.1 on page 49) and select the required
gateway.
2. Do one of the following:
a. Inthe Node Tasks pane, left-click the Show Active Alarms task.
OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Show Active Alarms.
The Show Active Alarms Run Task window is displayed:

Figure 6-15: Run Task-Show Active Alarms

(4 nton i o O,

@ Help

Run the task on these targets

Tanget Run Location
10.10.50.2

Task Parameters

Name Value
Usemame Admin
Password Admin
Task credentials Task description

@ Use the predefined Run As Account
) Other :
User name ;

Password :

Domain : GSTEPS

Task confirmation

[] Don't prompt when running this task in the future
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Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
Task confirmation of the task configuration window (see Section Figure 6-15), the next
time the 'Show Active Alarms' task is run immediately without you being able to change

the task configuration.

3. (Optional) Override the Username and/or Password for the Telnet connection:
a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.
b. Set the new values for Username and/or Password.
c. Click the Override button.

4. In the Run Task window, click the Run button; the Task Status — Show Active Alarms
window is displayed:

Figure 6-16: Task Status-Show Active Alarms

The task completed successfully. @ Help
Task Status Task Target
@) show Active Alarms Success test
Task Output 153 Copy Text 53 Copy HTML

~ -

@ Show Active Alarms Task Description

Status: Success

Scheduled Time: 02112010 10:03:04

Start Time: 02112010 10:03:06

Submitted By: GSTEPS\eduardg

Run As:

Run Location:

Target:

Target Type: Audiocodes SMMP Device

Category: Operations

Task Output:

logtpt |
The socket ia not connected.
None
Exit Code: 0

You can closethis dialog at any time. Doing so will not interrupt executing tasks. You can check the status of tasks in atask status view.

Close

This window contains the Task execution status and output details.
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6.9.3  Setting Device Display Name

This task describes how to change the device Display Name in the GW State View table.

» To change the device Display Name:
1. Open the GW State View (see Section 6.1 on page 49) and select the required
gateway.
2. Do one of the following:
a. Inthe Node Tasks pane, left-click the Set Device Name task.
OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Set Device Name.
The Set Device Name Run Task window is displayed:

Figure 6-17: Set Device Name

71, Run Task - Set Device Mame @
& Help

Run the task on these targets

Target Fiun Location

10.10.50.2

Task Parameters
M ame Walue
D eviceN ame Device Mame
CommunityS tring private

Override
Task credentials Task description

@ Ugze the predefined Run &s Account
) Other:

Uzer nare :

Pazsword :

Dromain : GSTEPS

Task confirmation

[ Dan't prampt when rnning this task in the future

Run ] l Cancel

Note: If you check the checkbox 'Don't prompt when running this task in the future' in the
Task confirmation of the task configuration window (see Section Figure 6-15), the next
time the 'Show Active Alarms' task is run immediately without you being able to change

the task configuration.
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3. (Optional) Override the DeviceName and/or CommunityString:
a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.
b. Set the new values for DeviceName and/or CommunityString.
c. Click the Override button.

4. In the Run Task window, click the Run button; the Task Status — Set Device Name
window is displayed:

Figure 6-18: Task Status-Set Device Name

%Task Shatus - Set Dewice Narne EI@
The task completed successFully, @ Help
Task Status Task Target
Set Device Name E s 10,10,50.2
4 1 | »
Task Output 53 Copy Text 53 Copy HTRL
-
(&) Set Device Name Task Description i
Status: Success
Scheduled Time:  12/12/2010 17:14:41
Start Time: 12/12/2010 17:14:44
Submitted By: GSTEPS\eduardg L
Run As: r
Run Location:
Target:
Target Type: Audiocodes SNMP Device
Category: Custom i
Task Output:
owtpot |
None

You can close this dialog at any time. Doing so will not inkerrupt executing tasks, You can

check the status of tasks in a bask status view,

This window contains the Task execution status and output details.
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6.9.4 Testing Call from Gateway

This task describes how to execute the test call from the gateway.

» To test acall from the gateway:

1. Open the GW State View (see Section 6.1 on page 49) and select the required
gateway.

2. Do one of the following:
a. Inthe Node Tasks pane, left-click the Test Call task.
OR
b. Inthe Main Menu, choose Tasks > Node Tasks > Test Call.

The Test Call Run Task window is displayed:

Figure 6-19: Run Task — Test Call

'@ Help

Run the task on these targets

Target Fun Location
10.10.50.4

Task Parameters

Name Walue
Usemame Admin
Password Adrmin
DTMFs 1234
DestinationPhoneMNumber 587654321
Task credentials Task description

(@ Use the predefined Run As Account
() Other :
User name :

Password :

Domain : GSTEPS

Task confirmation

[] Den't prempt when running this task in the future
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Note: If you check the checkbox "Don't prompt when running this task in the future" in

ﬁ Task confirmation of the task configuration window (see Figure 6-20 below), the next

time you run the 'Test Call' task, it is run immediately without you being able to change
the task configuration.

3. (Optional) Override the Username and/or Password for the Telnet connection:
a. Inthe Task Parameters pane, click the Override button; the Override Task
Parameters window opens.
b. Set the new values for the Username and/or Password.
c. Click the Override button.

A Note: Do not override the DTMFs and Destination PhoneNumber parameters.

4. In the Run Task window, click the Run button; the Task Status — Test Call window is
displayed:

Figure 6-20: Task Status-Test Call

F- b

Thetask completed successfully. @) Help
Task Status Task Target
) Test Cal Success test

Task Output

Scheduled Time:
Start Time:
Submitted By:
Run As:

Run Location:
Target:

Target Type:
Category:
Task Output:

Exit Code: 0

You can closethis dialog at any time. Doing so will not interrupt executing tasks. You can check the status of tasks in atask status view.

Close

The socket is not connected.

=1
| |

153 Copy Text 53 Copy HTML
a
Task Description
Success
02112010 10:04:30
02112010 10:04:33
GSTEPS\eduardg

Audiocodes SNMP Device
Operations

This window contains the Task execution status and output details.
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-

7.1

7.2

Monitoring Gateway Element Health

Once a gateway is discovered, SCOM starts monitoring the gateway to determine its health
state. Monitoring is performed for each discovered 'Gateway', 'Module’ and 'Trunk'
(together referred to as gateway elements).

Monitoring Types

The SCOM server collects data from the gateways using the following methods:
B Queries send from the SCOM to the gateway:

e Object-based monitoring is the polling of a specific SNMP object value change
i.e., the acSysModuleOperationalState module-related object is changed. For
example, there is a power supply failure for a gateway power supply module.

e Threshold-based monitoring is an alert issued when a threshold defined for a
performance counter is exceeded. This type of alert is applicable for gateways
and trunks. Each performance counter has two types of thresholds 'High' and
‘Low'. Each threshold type has two levels: 'Warning' and 'Critical’. Consequently,
the final severity of threshold-based alert depends upon which level of threshold
has been exceeded. Thresholds levels are described in Section 7.5 on page 76.

B Traps send from the gateway to the SCOM:

e Trap-based monitoring is an alert issued as a result of a trap that was captured
from an entire Gateway entity (Gateway, Module or Trunk).

Notes:
e  Trap-based monitoring is not automatic. To enable this monitoring, you must
configure the SCOM server as the trap destination. See Section 5.2 on page 46.

° For a full list of all SNMP traps supported by the SCOM, see Appendix A on page
103.

Aggregated Health State

The final Health state of any entity is the aggregation of an entity-related alert and the
Health states of its sub-elements (the Health state propagated from child element to the
parent element).

Rollup Policy is used to determine this final health state of an entity. There are two types of
Rollup policies used for the gateway health state definition:

B Best State rollup policy defines the state of an entity as healthy in the event where at
least one of its sub-elements is healthy, i.e. if a gateway contains several modules and
at least one of the modules is healthy, then the overall state of the gateway is
determined as 'Healthy'.

B Worst State rollup policy defines the state of an entity according to the worst severity
of any if its sub-elements, i.e. if a gateway contains several modules, where one of the
modules is healthy, another module has the 'Warning' state and another is 'Critical’,
then the overall health state of the gateway is determined as 'Critical’.

Note: Rollup Policy is not applicable for threshold-based alerts. For information on
Configuring Threshold levels, see Section 7.7 on page 78.
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7.2.1 Aggregated Health State-Gateway

The Aggregated health state of the gateway depends on the Fan Tray and Power Supply
modules health together with the health states of all system modules residing on the
gateway and is calculated according to the following rules:

B Worst state Rollup policy - It is sufficient for the Fan Tray or Power Supply module to
indicate 'Critical’ for the corresponding gateway to indicate 'Critical'.

Dependence Rollup 'Worst State' policy is applicable for all corresponding
Trunks/Ports residing on gateway modules.

B Best state Rollup policy - It is sufficient for a single system module to indicate
'Healthy' for the corresponding gateway to indicate 'Healthy'.

Table 7-1: Health Indication

SNMP Object Health State Indication
Green The object is healthy.
Grey The gateway exists in the list of network devices

(Administration > Network Devices), it was successfully
discovered at least once; however, is not responding to the
monitors' requests.

7.3 SNMP-SCOM Object Severity Mapping

731 Gateway

The table below describes the translation of the gateway element health states to the
corresponding SCOM health states.

Table 7-2: SNMP Gateway Objects Health State

SNMP Object Health State SCOM Object Health State
noAlarm(0) Healthy
intermediate(1) Warning
minor(3) Warning
major(4) Critical
critical(5) Critical
7.3.2 Module

The table below describes the translation of the module element health states to the
corresponding SCOM health states.

Table 7-3:SNMP Gateway Modules Objects Health State

SNMP Object Module SNMP Object Health State SCOM Health State
acSysModuleOperationalState | enable(2) Healthy
(System moduile) disable(1) Critical
acSysPowerSupplySeverity Cleared(1) Healthy
(Power Supply module) Indeterminate(2) Warning
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SNMP Object Module SNMP Object Health State SCOM Health State
minor(4) Warning
Major(5) Critical
Critical(6) Critical

7.3.3 Digital Trunks

The table below describes the translation of the digital trunk element health state to the
corresponding health state in the SCOM.

Table 7-4: Digital Trunk SNMP Polling

SNMP Object SNMP Object Health State SCOM Health State Indicator
acTrunkStatusAlarm greenActive (1) Healthy
Other values Critical

The monitor 'AudioCodes Digital Trunk Alarm' queries SNMP Object "Alarm" from table
with OID 1.3.6.1.4.1.5003.9.10.9.2.1.1.1.1.

7.34 SNMP Traps

The table below describes the SNMP traps which cause the gateway module to indicate
the Unhealthy state in the SCOM.

Table 7-5: Unhealthy State

Gateway Module Trap SCOM Unhealthy State
System modules acHwFailureAlarm Warning or Critical
Power Supply module acPowerSupplyAlarm Warning or Critical
Fan Tray module acFanTrayAlarm Warning or Critical
analog trunk module acAnalogPortHighTemperature Critical

acAnalogPortSPIOutOfService

Digital Trunk module acTrunksAlarmNearEndLOS Critical
acTrunksAlarmNearEndLOF
acTrunksAlarmRcvAIS
acTrunksAlarmFarEndLOF

Ethernet ports module acBoardEthernetLinkAlarm Critical

For more information on the traps described in the table below, see Appendix A on page 103.
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7.4  Alert Monitoring

The SCOM Management Pack includes the following active alerts views:

B GW Alerts View. See Section 7.4.1 on page 70.
B All Modules Alerts View. See Section 7.4.2 on page 74.
B All Trunks/Ports Alerts View. See Section 7.4.3 on page 75.

741 GW Alerts View

GW Alerts View shows the entire gateway-related alerts (alerts related to the gateway and

all hosted entities).

» To view gateway alerts:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.

2. Select the GW Alerts View; a screen similar to the following is displayed:

Figure 7-1: GW Alerts View
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3. Select a specific Alert; the Alert Details are loaded:
Figure 7-2: Gateway Module Alert Details
1] | |

Alert Details
=

1. Audiocodes GW aclcanontigurtionLmor Monitor Alert Alert Descripbon

Knuwhedge W View sdgtional knewiecge.,
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4. Click on the View additional knowledge Link to view additional information on the
alert. The Alert Properties are displayed:

Figure 7-3: Alert Properties

Alert Properties E3

General |Product knowledge I Compary Knowledge I Hiskary I Alert Context I Zustom Fields I

4 Audiocodes: G'W acB eardConfigurationE rmor Monstor Alert

Key Details:

Alert source: —

Severity: Warning

Priority: Mediunn

Age: 8 Days, 5 Hours, 4 Minutes

Cner I Change... |
Ticket 1D |

Alert Description:

hd

Alert Status:

Once vou have identified the problen and taken corrective action, wou can select 'Closed’ which will remaowe the Alert Fram
the system once changes are committed,

T ﬂ

& Previous ¥ MNext Ok I Cancel | Apphy

Additional Information may be displayed in the Alert Description pane.
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5. To view SNMP detailed information, select the Alert Context tab; the SNMP details
for the alert are displayed:

Figure 7-4: Alert Properties-SNMP Information
" General I Product Knowledge I Company Knowledge I History  Alert Context |Cust0m Fields I

Source 10.15.21.15
Destination 127.0.0.1

Version 2
ErrorCode SUCCESS

Object Identifier Syntax [Value

.1.3.6.1.2.1.1.3.0 Timeticks|52094533

.1.3.6.1.6.3.1.1.4.1.0 Qid .1.3.6.1.4.1.5003.9.10.1.21.2.0.2
.1.3.6.1.4.1,.5003.9.10.1.21.1,1.0 |Integer |1

PSTNCheckClockMaster: Clock might be un-stable - Trunk 0 is set as
acCLOCK,_MASTER_OFF while TDMBusClockSource is Internal. [Tru

1.3.6.1.4.1.5003.9.10.1.21.1.3.0 |Octets [Board#1
1.3.6.1.4.1.5003.9.10.1.21.1.4.0 |Integer |1
1.3.6.1.4.1.5003.9.10.1.21.1.5.0 |Integer |4
1.3.6.1.4.1.5003.9.10.1.21.1.6.0 |Integer |4
.1.3.6.1.4.1.5003.9.10.1.21.1.7.0 |Integer |56
1
1
1
1

.1.3.6.1.4.1.5003.9.10.1.21.1.2.0 |Octets

.3.6.1.4.1.5003.9.10.1.21.1.8.0 |Octets
.3.6.1.4.1.5003.9.10.1.21.1.9.0 |Octets
.3.6.1.4.1.5003.9.10.1.21.1.10.0|Octets
.3.6.1.4.1.5003.9.10.1.21.1.11.0|Cctets  |=-0n07-0w D000 E-00 140w 00000 OF-00003-0e 00

=]
4 Previous B Mext [0]'4 I Cancel | Apply

6. If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert
Monitor, for example, click the Audiocodes GW acBoardConfigurationError
Monitor link as shown in the figure below.

5

Figure 7-5: Gateway Monitor Alert Details

| ]
& Alert Details
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The gateway alert monitor properties are displayed:

Figure 7-6: Gateway Alert Monitor Properties
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General properties

Specify the name and description for the monitor wou are creating.

Marmne:

|!-'-‘-.udioccndes @ acBoardCaonfigurationE rmar b onitor

[Dezcription [optional):

M anagement pack: Audiocodes Gw' Management Pack

konitor target:

Audiocodes SMMP Device Select. |
Farent maonitor:

I Configuration j

v tanitar iz enabled

o]

Cancel Apply |

Y

7.

Select the Overrides tab to override the monitor. For more information, see Chapter 8

on page 85.
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7.4.2 All Modules Alerts View

All Modules Alerts View shows the module-related alerts (alerts at the module level).

> To view alerts for all modules:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.
2. Select the All Modules Alerts View; a screen similar to the following is displayed:

Figure 7-7: All Modules Alert View

B all Modules Alert Yiew - Audiocodes - Operations Manager [-[O]x]
Fle Edit View Go Tasks Tooks Help

I sewchv _ |Ovemdes _ i Scope @ .

Monitoring < All Modules Alert View (5)
[ Discovered Inventory | & Lookfor: Find Now  Clear
£2%] Distributed Applicatiors
5 Task Status
28] UNDG/Linu Computers

> Tasks
x @ e

| 2 Alert
Actions

- Icon | Source | Name Resolution State | Created

4 Severity: Critical (5)
M1K-10,30.52,1 ackediantL000FDigitalModule 3t Sl Audiocodes Digital Trunk Alarm Monitor Alert

= Mew 010142013 18:08:00
£2%] Windows Computers

MIK-10.30.52,5 achediantL000[FDigitalModule at Sl..  Audiocodes Digital Trurk Alarm Monitor Alert  New
4 Agentless Exception Monitoring

0170172013 18:07:37
4 Application Monitoring MI1K-10.30.52.4; acMediantl000IFDigitalModule at 5., Audiocodes Digital Trunk Alarm Monitor Alert  New 010172013 18:07:37
4 | Audiocodes Gatewass
| GW Alerts View
Pl GW Performance View

25| Gw state iew

M1K-10.30.52.3: acMediantL000FDigitalModule 3t Sl Audiocodes Digital Trunk Alarm Monitor Alert  New 01/02/2013 18:07:36

3
TestDevice: acMediantl000IFDigitalModule 3t Slat 0: ... Audiocodes Digital Trunk Alarm Monitar Alert  New 01/02/2013 1455:00

[Ts] personalize view

Subscriptio
4 [ Modules n
| All Modules Alert View
2] All Modules State View
2] Fan Tray State View

~

#1| Power Supply State View
&1 System Modules State View
4 |5 Trunks/Ports
] AllTrunk/Ports Alert View
#%] Digital Trunks State View
7] Ethernet Ports State View
7 DataWarenouse
4 Microsoft Audit Collection Servicss
4 Microsoft Windows Cliert
& Microsoft Windows Server
A Network Monitoring
7 Operations Manager
4 Synthetic Transaction
A UNIX/Linux Computers
4 Web Application Transaction Monitoring < o
~| Alert Details

A Windows Service And Pracess Monitoring

Show or Hide Views.. Y
i) select anitem inthe view sboveto display its details.
New View b ~

Bl Monitoring
#[ Authoring

"% Administration

] My Workspace

Ready

3. Select a specific Alert; the Alert Details are loaded.

Figure 7-8: Power Module Alert Details

| Alert Details i
B3 Audiocodes Pawer Supply Severity Monsios Alert Alet Desmiptian

4. Click the View additional knowledge link to view additional details on the alert.
5. If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert
Monitor, for example, click the Audiocodes Power Supply Severity Monitor link as
shown in the figure above.
6. Select the Overrides tab to override the monitor. For more information, see Chapter 8
on page 85.
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All Trunks/Ports Alerts View

All Trunks/Ports Alerts View shows the trunk/port-related alerts (alerts on trunk/port level).

» To view alerts for all trunks/ports:

1. Select the Monitoring pane, and then open the AudioCodes Gateways folder.
2. Select the All Trunk/Ports View; a screen similar to the following is displayed:

Figure 7-9: All Trunk/Ports View

Audiocodes - Oper.

Fle Edit View Go Tasks Tooks Help

Search ¥

weridesw _ i Bl Scope

Menitoring <

| Discovered Inventory
£2¥] Distributed Applicatiors
(o) Task Status
28] UNDG/Linu Computers
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4 Agentless Exception Monitoring
4 Application Monitoring
4 | Audiocodes Gatevays
] GW Alerts View
b GW Performance View
EiZ] W State View
4 |5 Modules
] Al Modules Alert View
1] All Modules State View
Fan Tray State View

Fower Supply State View
&1 System Modules State View
4 | Trunks/Ports
] All Trunk/Ports Alert View
Digital Trunks State View
Ethernet Forts State View
7 DataWarenouse

4 Microsoft Audit Collection Servicss
4 Microsoft Windows Cliert

& Microsoft Windows Server

A Network Monitoring

7 Operations Manager

4 Synthetic Transaction

A UNIX/Linux Computers

4 Web Application Transaction Monitoring

4 Windows Service And Process Monitoring =

Show or Hide Views..

MNew View »

Bl Monitoring
A Authoring
Administration

] My Workspace

Ready

All Trunk/Ports Alert View (64)

_ Ieon | source
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4 severil
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M1K-10.30.52.1.
M1K-10,30,52.3:
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Alert Details
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| & Lookfor: Find Now  Clear

e

Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
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Audiocodes Digital Trunk Alarm Monitor Alert
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Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitor Alert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar &lert
Audiocodes Digital Trunk Alarm Monitar &lert
Audiocodes Digital Trunk Alarm Monitar &lert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar Alert
Audiocodes Digital Trunk Alarm Monitar Alert

i) select anitem inthe view sboveto displayits details.
<

Resolution Stats

Closed
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Closed
Closed
Closed
Closed
Closed
Closed
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Closed
Closed
Closed
Closed
Closed
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Closed
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Created

0140172013 18:08:00
0140172013 18:07:37
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01/02/2013 0455:32
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010242013 04:55:09
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> Tasks
x @ e

=1 Alert
Actions

3

[ii| Personalize view

Subscriptio
n

~

3. Select a specific Alert; the Alert Details are loaded.
Figure 7-10

= Alert Deebails

J €3 Asdiecodes Digital Tank Alarm Mositer Alert

]

Knowledge:

Alert Desription

View additionsl know

: All Trunk/Ports Alert Details

4. Click the View additional knowledge link to view additional details on the alert.

o

If you wish to configure the Alert Monitor, in the Alert Details screen, click the Alert

Monitor, for example, click the Audiocodes Digital Trunk Alarm Monitor link as
shown in the figure above.

6. Select the Overrides tab to override the monitor. For more information, see Chapter 8
on page 85.
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7.5 Performance Monitoring

The AudioCodes device enables performance monitoring in the form of ‘counters' for
gateway and trunk modules. For a gateway module, for example, the 'AudioCodes
Mediant4000 Device'counter 'Attempted Calls IP2Tel' polls the number of attempted IP to
Tel calls during the last interval. For a trunk module, for example, the Audiocodes Digital
Trunk Available Channels counter polls the number of available in service trunks for a
specific trunk group. In the SCOM, the PM counter is represented by a rule (see
Section 7.6 on page 77).

Counters always increase in value and are cumulative. Counters, unlike gauges, never
decrease in value unless the server is reset, and then the counters are reset to zero.

Additionally, each counter rule is represented by a pair of threshold monitors (a high
threshold monitor and a low threshold monitor). For example, the "Attempted Calls IP2Tel"
PM is represented in the SCOM by the "AudioCodes Attempted Calls IP2Tel High
Threshold Monitor" and "AudioCodes Attempted Calls IP2Tel Low Threshold Monitor". For
more information, see Section 7.7 on page 78.

For details on the performance monitoring counters that are supported by the AudioCodes
Management Pack, see Section B on page 163.

75.1 Performance View

This section describes the performance view.

» To open the Performance View,

B Inthe Monitoring pane, select GW Performance View; the Performance View is
displayed:

Figure 7-11: GW Performance View

ope B Actions | (®

Monitoring GW Performance View
= L@ Monitoring
4] Active Merts
23] Discovered Invertory
%] Distributed Applications
|, Task Status

=28 Unibe/Linee Servers
ﬁﬂ Windows Computers
@ Agertless Exception Monitoring
B [ Audiocodes Gateways
| A] GW Merts View
=
%] GW State View
Bl [ Modules 0 13102 13102 13102 13102 13102 13102 13102 13102 13102 13102 13102 13102
4] Al Modules Alert View 01013, 010 13.. 01013 01013 010 13.. 01014 010 14.. 010 14.. 01014 010 14.. 010 14 010 14..
=25 All Modules State View

\iﬂ System Modules State View
B [ Trurks/Forts Target Counter Instance *
4] All Trunk/Ports Alett View

Audiocodes MoA... Gateway MoAnswer Calls L...
Audiocodes MoR.... Gateway MoRoute Calls T...
< E”:,'Ijr"”"”‘ Docn Q4in ""i‘"' D Audiocodes NoA... Gateway Mosnswer Calls ...
Audiocodes Atte... Gateway Attempted Calls ...
Audiocodes MoM... Gateway MNoMatch Calls IP...
Audiocodes Esta... Gateway Established Calls. ..
Audiocodes Atte... Gateway Attempted Calls ...

Show or Hide Views..
MNew View »

Audiocodes MoR... Gateway MoResources Cal...

Audiocodes NoM... Gateway MoMatch Calls T...

Audiocodes Busy... Gateway Busy Calls IPZTel

Audiocodes Busy... Gateway Busy Calls Tel2IP

Audiocodes Esta... Gateway Established Calls...
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e Right-clicking the graph opens the Personalize View and other options which
allow you to customize the graph.

e The GW Performance View allows you to view gateway performance counters
behavior. In the Legend window, you can select one or more counters to view
them on the graph. Each counter on the graph has its own color. Using the 'Look
for:' filter, you can limit the Legend to show only the counters on the graph (Items
in the Chart) or only the counters which are not shown on the graph (Items not in
the Chart) or specific counters (Iltems by text search). By default, all counters are
available for selection in the Legend window (All Items).

e The GW Performance View provides updated information on most counters every
15 minutes. Counters for Channels provide updated information per minute. A
graph can be refreshed manually (F5) or automatically.

7.6  Rules Monitoring

Rules are used in the SCOM for managing the AudioCodes SIP Performance Monitoring
counters and for managing the Trunk Service Information.

Figure 7-12: Rules Monitoring

TP ACE GBS 306 Mo 0P 6 5 A e 4T Pach-BPMCIIO M, Aud i des acfruris Pck-MEDIANTZI0 M dule, Audoiea¢ s Analog Fruris Class, AUt coes S Modus, Audr<odes DEhsnnel Chiss Sudiossdss B Tr.. Shange Sise.. X
Aok for Frebow Do *®
i Wveted fram i Pk Ereted Enviied by defont 2
4 Types Autios inies Digilal Tiunk Gl (51

Butineoder G Management Pack

saintader GW ManageRent Fack

Madionades Hoknr 1 Bl locodes SHMP Device A g AL AT 1 =

7.6.1 SIP Performance Monitoring Counters

SIP PM counters rules poll data from the AudioCodes devices by default every 15 minutes.
The AudioCodes Management Pack includes a corresponding rule for each supported PM.
For example, "Attempted Calls IP2Tel Counter Rules".

For a full list of PM counters supported by the SCOM, see Appendix B on page 163.

7.6.2 Trunk Service Information

Trunk Service counters (Trunk Performance Statistics) monitor the Channels states
(channel in-service and channel out-of-service). The counters 'AudioCodes Digital Trunk
Available Channels Counter Rule' and the 'AudioCodes Digital Trunk Blocked Channels
Counter Rule' poll the trunk channel information.
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7.7

A\

Normal
Normal
Warning
Warning
Critical

Critical

A\

Threshold Monitoring

This section describes how to configure the threshold values for the device PM counters.
For each supported PM counter rule there is a pair of threshold monitors; a high level
threshold monitor and a low level threshold monitor. For example, for the IP2Tel Counter
rule there is the corresponding pair "AudioCodes Attempted Calls IP2Tel High Threshold
Monitor" and "AudioCodes Attempted Calls IP2Tel Low Threshold Monitor".

You can set, based on your network environment, the low-level and high-level threshold
integer values for these monitors. You can configure these integer values under the
following circumstances:

B When the monitor reaches its HighWarningLevel threshold
B When the monitor reaches its HighCriticalLevel threshold
B When the monitor reaches its LowWarningLevel threshold
B When the monitor reaches its LowCriticalLevel threshold

An alarm is by default triggered when the High-Threshold value is exceeded or the Low-
Threshold value is crossed. The alarm is cleared when the PMs value passes below the
pre-defined High-Threshold or above the Low-Threshold value.

Note: The log trap ‘'acPerformanceMonitoringThresholdCrossing’ (non-alarm) (see
Section A.2.6 on page 154) is sent each time a PM threshold is exceeded. The severity
field is 'indeterminate’ when crossing above the threshold and 'cleared' when it returns
below the threshold. The 'source' varbind in the trap indicates the object for which the
threshold is being crossed.

The following table describes the different alarm states when a threshold is crossed, and
the different states when it is cleared:

Table 7-6: Alarm States

Alarm Initial State Alarm Change State

Warning
Critical
Critical
Clear
Warning
Clear

The alarm that is raised depends on the counter value that is exceeded above the
threshold or is crossed below the threshold.

For example, when the IP to Tel calls counter exceeds 50, an alarm is sent from the
device. Alternatively, when the IP to Tel calls counter drops below 10, an alarm is sent from
the device.

You can either set the threshold level for a specific object or for all objects of class: SNMP
Network device.

Note: See Section 7.3 on page 68 for the mapping between the SNMP severity levels
and the SCOM severity levels.
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» To configure the threshold values:

1. Inthe GW State View, right-click the gateway module that you wish to configure, and
then choose Open > Health Explorer for <GW IP>; the Health Explorer is displayed:
Figure 7-13: Health Monitor-Initial View
" Health Explorer for H[=]

Reset Health Recalculate Health 'f Filter Monitors "\. Refresh Properties lélHelp Cwertides -

Health monitors for

Scopeis only unhealthy child monitors, x  Knowledge | State Change Events I

4 't:i:' Entity Health - 00-30-3F-22-17-D7 [Object)
- 'Z!E} Lvailability - 00-90-8F-22-17-D7 [Object)
rl l!:)l Audiocodes GiA Power Supply Dependency Monitor- 00-30-81
- I.QZQJ Entity Health - : PowerSupply Module at Slot 2 [Objed)
4 [ swsilability- : Powersupply Module at Slot 2 (Objed)
lg:?\ Audiocodes Power Supply Severity Monitor- : PowerSupr
'tz:#' Audiocodes GW Severity Monitor- 00-90-8F-22-17-D7 [Audioc

Note: You can also configure thresholds for performance monitors in the Monitors
window (Authoring > Monitors); however, this method is easier if you are currently in
the Monitoring pane.
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2. Click the X adjacent to the message "Scope is only unhealthy child monitors"; the full
list of monitors are displayed:

Figure 7-14: Health Monitor-Expanded View
Health Explorer for [_ O] =]

@ Reset Health :.ﬁ Recalculate Health f Filter Manitars T Refresh [ | Properties

elp 5 Ouertides =

Health monitars for

Entity Health - 00-30-8F-22-17-D7 [Ohject] a| Knoudedge | state Change Evants 2] |

Availability - 00-90-8F-22-17-D7 (Object] d
@ Audiocodes acBoardCallResourcesAlarm Monitor- 00-90-5 Summary
@ Audiocodes acBoard ControllerFailureAlarm Monitor - 00-9 This monitor is the rollup monitar for all other monitors running against this object. If the state is
@ Audiocodes acBoardFatalError Manitar - 00-90-8F-22-17-D unknown, either monitoring has not begun for this object or there are no monitors defined.
@ Audiocodes acBoard OverloadAlarm Monitar- 00-30-6F-22- Causes
@ Auydiocodes acDChannelStatus Monitor- 00-90-8F-22-17-C An unhealthy state for this menitor indicates some problem with another monitor running against this

@ Sudiocades GW acBoardTemperaturedlarm Monitor- 00-81 object. View all current alerts from this object using this link:

@ Audiocodes GW acFeatureKeyErrar Monitor- 00-90-8F-22-1 View Alerts

@ Audiocodes GW acgwadminstateChange Manitar - 00-90- Resolutions

@ Audiocodes GW achTPServerStatusAlarm Manitor - 00-90-8 Use the health explorer to drill down and find the cause of the unhealthy state. Use the knowl,
@ Ludiocodes GW coldStart Monitor- D0-90-8F-22-17-D7 (AU the specific monitor causing the issue to troubleshoot and fix the problem.

> @ Audiocodes GW Fan Tray Dependency Monitor - 00-90-5F-2
@ Sudiocodes GW Management Pack aclDAPLostConnection
@ Audiocodes GW Management Pack acBoardWanLinkAlarm
@ Audiocodes GW Management Pack achdediaProcessOverlo
@ Audiocodes GW Management Pack acirelessCellularMod
@ Audiocodes GW Management.Pack actnalogPortGroundF
@ Sudiocodes GW Management,Pack acOCSPServerStatusilc
V] -e_:ﬂil Audiocodes GW Power Supply Dependency Manitor- 00-31
> @ Entity Health - : PowwerSupply Module at Slot 1 [Objed)
4 -(:9' Entity Health - : PowverSupply Module at Slot 2 [Objed)

Lyailability - PowerSupply Module at Slot 2 [Objed)
@ Audiocodes Power Supply acPowerSupplySlarm Mani
IQ_ZQZ' Audiocodes Power Supply Severity Manitor- | Powersy
O Configuration - : PowerSupply Module at Slot 2 [Objed)
O Performance - : PowerSupply Module at Slot 2 [Objedj_lJ
3

3. Inthe Entity Health tree, expand Performance node.

4. Select the required monitor right-click and choose Monitor Properties; the Threshold
Monitor properties window for this monitor is displayed:
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Figure 7-15: Threshold Monitor Properties
'. Audiocodes Attempted Calls IP2Tel High Treshold Monitor Properties | x|

. Generall Healthl .-’-‘-.Iertingl Diagnoztic and Recavery I En:nnfiguratin:nnl Praduct Knowledge  Overides |

Ovemdes are wzed to change the monitor, diagnostic and recovery configuration. You can also
view all overndes applied to each by opening the summary dialog,

Chooze the monitor, diagnostic or recoven from the list below for which you want to apply
overndes for o view summary on;

Monitor [Audiocodes Attermpted Calls IP2T el High Treshold konitor)

Digzable... Ovemide... Wiew summary...

Examplex

Dizable a maritar: | want to dizable monitar far all ‘wWindows Computers.
Ovemde a diagnostic: | need to overnide thiz diagnostic for one of my wWindows Computers.

Wiew surmmany of a recoveny: | need to view the objects thiz recoven haz been enabled for.

(] I Cancel Apply |

5. Click the Overrides tab; the Overrides screen is displayed.
6. Click the Override button.

Figure 7-16: Override Thresholds
11
Dizable... Oweride. .. For the object: 00-90-8F-30-48-67

Faor all objects of class: Mode

i Far a group...
tor far all ‘windows Cormpters.
For a specific object of class: Mode

thiz diagnostic far one af my SWindow

Far all ohjects of anaother class. ..

Choose one of the following options:

e For the object <GW IP> - only the threshold levels for this specific gateway are
changed.
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e For all objects of class: SNMP Network Device — the threshold levels for all
currently discovered SNMP gateways in the network.

The Override Properties window is displayed:

Figure 7-17: Override Properties - High Threshold Monitor

Override Properties E

b onitar name: Audincades Attempted Calls IP2Tel High Treshaold konitar
Categony: Cuztom
Owerrides target: Object:

Owernde-controlled parameters:

Overmide | Parameter Mame ¢ | Parameter Type Default Walue | Overide Walue | EffectiveValue | Change Status LI

|_ Alert zeveriy Enurmeration Match monit... | Match monita... | Match monitar... | [Mo change]

- Auto-Fesolve Alert Boolean Trug True True [Mo chanage]
[ 2 n Enabled Boolean Falze Falze Falze [Mo chanage]

Il Generates Alert Boolean True True True [Mo change]

r HighCriticalLewvel Integer 25 28 25 [Mo change]

- Highwf armingLeswvel Integer 10 10 10 [Mo change]

|_ IntervalSeconds Integer 300 300 300 [Mo change]

- SyncTime String 1200 1200 1200 [Mo chanage] =
< | o

Details:

Enabled Description Edi...
The pararmeter i ot set by a custorn overide or by a
management pack. The effective value of thiz parameter
iz the default value of thiz parameter.

Management pack

Select destination management pack:

Audiocodes G Management Pack j ...

Help | )8 Apply Cancel |

' 4
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Figure 7-18: Override Properties - Low Level Threshold Monitor

Override Properties [ x|
tonitor name: Audiocodes Attermpted Callz IP2Tel Low Treghold Monitor
Cateqary: Custam
Owemndes target; Object:

Overide-controlled pararmeters:

Owerride | Parameter Mame  * | Parameter Type Default Walue | Overide Value | Effective Walue | Change Status :I
- Alert zeverity E numeration b atch monit.. | Matzch manita, . | katch maonitar.. | [Mo change]
- Auto-Fesole dlert Bioolean True True True [Mo change]
P—n Enabled Boolean Falze Falze Falze [Mo change]
I - Generates Alert Boolean True True True [Ma change]
- IntervalS econds Inteqer 900 300 00 [Ma change]
- LowCriticalLewvel Integer - Bl -1 [Mo change]
- Lowiaf arningLewel Integer - Bl -1 [Mo change]
- SyncTime String 1200 12:00 1200 [Ma change] =
| | o
Details:
Enabled Description Edi...

The parameter iz not set by a custon overide or by a
management pack. The effective value of this parameter
iz the default walue of thiz parameter.

Management pack

Select destination management pack:

Audiocodes G Management Pack j fdEw...

Help | QK | Apply | Cancel |

4

The following parameters define threshold levels for AudioCodes Management Pack
monitors:

e High Threshold Monitors: 'HighCriticalLevel' and 'HighWarningLevel'

e Low Threshold Monitors: 'LowCriticalLevel' and 'LowWarningLevel'

7. In the 'Override' column, select the checkbox adjacent to the parameter whose
threshold value you wish to change.

8. Inthe corresponding 'Override Value' column, set the required value.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

9. Click OK to apply the change.
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8

Optimizing SCOM Server Loading

This chapter describes how to optimize the load on the SCOM server for AudioCodes
MP-related functional items. The following sections are described in this chapter:

B Displaying AudioCodes Objects. See Section 8.1.1 on page 86.
B Optimizing Monitors Load. See Section 8.1.2 on page 89.

B Optimizing Discoveries Load. See Section 8.1.3 on page 93.

B Optimizing Rules Load. See Section 8.1.4 on page 75.

Note: For detailed information, see Appendix C on page 167.

8.1 Introduction

One of the key factors affecting the performance of the SCOM server when working with
the AudioCodes MP is the overloading on the CPU that is triggered by the disparate
launching of AudioCodes MP-related functional items. For example, the discovery of
gateways and their modules and trunks. For each of these operations, a script is run. When
many of these scripts are run simultaneously, the performance of the SCOM server is
significantly affected. When the SCOM server load is optimized, the script running is
smoothly distributed over time so as to prevent CPU bottlenecks and therefore maintain
performance.

This smooth distribution is achieved by overriding the values of the following parameters

for the respective discoveries, monitors and rules:

B Polling interval — defines the polling frequency interval; how often (seconds)
functional items are launched (least possible resolution is 60 seconds).

B Sync time — specifies at which time the polling is rearranged; this allows you to set
the exact time in minutes within the hour when a functional item is launched. For
example, if the IP2Tel Calls counter rule is launched every 10 minutes (i.e. the Polling
interval) — this parameter sets the starting time and therefore the subsequent time
sequence for launching this item within the hour (in minutes) i.e., 0, 10, 20 or 3, 13,

23, etc.). For example, when the 'Sync time' is set to 00:04, the IP2Tel Calls counter
rule is launched in the following time sequence: 4, 14, 24, 34, 44, 54 minutes of each
hour.

Note the following:

B When you override the 'Sync' time to launch functional items at different starting times,
this smoothens CPU utilization over time and therefore enhances performance.
However, on the other hand leads to delay, as the time between the relative launching
of each functional item increases.

B Generally it is not recommended to override the 'IntervalSeconds' parameter; because
most of the counters have a low polling frequency with a default value of fifteen
minutes, and depend on the actual information refresh on the gateway devices
themselves. The exception is in the case of specific Trunk counters (see Section 8.1.4
on page 96).

B For a detailed load balancing scenario for SCOM server, see Appendix C on page
167.
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8.1.1 Displaying AudioCodes Objects

Before you configure the properties of the monitors, discoveries and rules, for the purposes
of easy management, it is recommended to set the object scope to view only AudioCodes

functional items.

» To filter the management pack functional items view:

1
Figure 8-1: Views

4 | Authoring
2=l Management Pack Templates
%% Distributed Applicatiors
=1 Groups
4 &g Management Pack Objects
=| Attributes

) Monitors

|:fy Object Discoveries
@ Owerrides

A Views (—

In the Authoring pane, select Management Pack Objects > Views.

The right-hand pane displays all the functional items that are defined in the current

scope.

e  Select View > Scope or press Ctrl+M.

In the Main Menu, ensure that the Scope setting is selected:

Figure 8-2: View Scope

B object Discoveries - Audiocodes - Dperations Manager

File Edit

A" Go  Tasks Tools Help
i || v navigation Pane Alt+F1 @ 5 Find -
Authoring = o Object Discoveries (269)
a2 tuth Management pack objects are now scopedtor Sudiocodes Analog Trunk Class, Audiocodes..,
) Mal MName Target
#EDist v Detail Pane Cti+D 4 Discovered Type: Audiocodes Analog Trunk Class (2)
== ) |Find CHl+F | Audiocodes Trunks on Analog Module Initial Discovery Aydiocodes IF &nalog M.,
4 lTJ_Ma' ’ 90 Audiacodes W Analog Trunk Secondary Discovery Audiocodes Analog Trun...
sl 4 Discovered Type: Audiocodes CPU Module (4)
@ Z v Scope Ctrl+M 90 Audiacodes Mediant 4000 CPU Module Initial Discovery Audiocodes SHNMP Device
|.i;- ol T Refresh F5 0 dudiocodes CPU Madule Index Discovery sudiocodes CPU Module
R(| o | Status Bar g Audiocodes Mediant 1000 CPU Module Initial Discovery Audiocodes SMMP Device
=7 Service Level Tracking |ipf Audiocodes Mediant 800 CPU Module Initial Discovery Audiocodes Mediants00 ...
: Tasks 4 Discovered Type: Audiocodes Digital Trunk Class (7)
L] Wiews (i Audiocodes Digital Trunks on Digital Maodule Initial Discow.,  Audiocodes IF Digital Ma..
|:p Audiocodes Digital Trunks on acTrunkPack-MEDIANTZ2000 ... Audiocodes acTrunkPack-..
(i Audiocodes Digital Trunk Secondary Discovery Audiocodes Digital Trunk...
|iff) Audiocodes Mediant 800 IF Digital Module Trunk DigitalIn... Audiocodes Mediant 800 ..
g Audigcodes Digital Trunks an BRI Module Initial Discovery Audiocodes IF BRI Module
|iff) Audiocodes Mediant 800 IF BRI Module Trunk Digital Initia... Audiocodes Mediant 800 ..
| :p Audiocodes Digital Trunk on acTrunkPackIPM2000 Module ... Audiocodes acTrunkPack-..
4 Discovered Type: Audiocodes Ethernet Port Class (3)
| Audiocodes Ethernet Port Initial Discovery Aydiocodes CPU Module
Add Monitaring Wizard. . (i Audiocodes Ethernet Port Secondary Discowery Audiocodes Ethernet Port.,,

Mew Distributed Application, ..

Mew Group...

.‘ Monitoring
;}I\ Authoring
y Administration

T_?:\ My Workspace

Ready

<

Object Discovery Details:

@ Select an object discovery above to view details

* Tasks
Change Scope.. b4 E 'g‘
Management Pack j[)hject R

Discovery

Audiocodes G Mar
Audiocodes G Mar

Audiocodes G Mar
Audiocodes GA Mar
Audiocodes G Mar
Audiocodes GA Mar

Audiocodes G Mar
Audiocodes G Mar
Audiocodes G Mar
Audiocodes GA Mar
Audiocodes GA Mar
Audiocodes GA Mar
Audiocodes G Mar

Audiocodes G Mar

Audiocodes GW Mar 4
3
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The Scope Management Pack Objects window is displayed:

Figure 8-3: Scope Management Pack Objects

Scope Management Pack Objects [ x|

Select the class, group, or object that you want to target from the list below. You can also filter or sort the list to make
items easier to find.

Look for:

|.-’-‘n.u-:|icu:c-des Clear |
-

" View commen targets
£+ Viiew all targets

Target - | Management Pack | Descriptian

[] Audiocodes acTrunkPack Audiocodes GW Manageme

[] Audiocodes acTrunkPack Audiocodes GW Manageme

|:| Audiocodes Snalog Trun Audiocodes G4 Manageme

[ Audiocodes CPU Module 2udiocodes GW Manageme

[ Audiocodes Dhannel €I Audiocodes GW Manageme

|:|Audic-cc-desDigitalTrunkAudiocodesGWManageme

[ Audiocades Ethemet Por Audiocodes G Manageme

DAudiocodes Fan Tray Aydiocodes GW Manageme

|:| Audiocodes GW Mediant Audiocodes G4 Manageme  Device Mediant4000

[] AudiocodesIF AD5L Mo Audiocodes GW Manageme

|:| AudiocodesIF Analog M Audiocodes GA Manageme

[] Audiocodes IF BRI Modul Audiocodes GW Manageme

|:| Audiocodes IF Digital Mo Audiocodes G4 Manageme

[]AudiocodesIF SHDSL M Audiocodes GW Manageme

[ Audiocodes IF TLAAM M Audiocodes G Manageme

[ Audiocodes IF veaM Mo Audiocodes G Manageme

[ Audiocades IP Media Mo fudiocodes G Manageme _ILI
| B

|
SelectAll |

ear A | 1033 total Targets, 45 visible, 0 selected

Help | o |7 cancel 1.
3. Inthe 'Look for' field, enter "Audiocodes".
4. Select the View all targets option.

5. Click either Select All or select only specific targets whose functional items (monitors,

discoveries or rules) should be changed, and then click OK.
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All AudioCodes Management Pack related-entities are displayed in the right-hand

pane:
Figure 8-4: AudioCodes Management Pack Entities
Monitors
Management pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocades,.. Change Scope.., x
Target Type Inherited From MalLs

Audiocodes Analog Trunk Class
Audiocodes CPU Module
Audiocodes DChannel Class
Audiocodes Digital Trunk Class
Audiocodes Ethernet Port Class
Audiocodes Fan Tray

Audiocodes GW Mediant4000

Audiocodes IF ADSL Module |-
Audiocodes IF Analog Module

Audiocodes IF BRI Module

Audiocodes IF Digital Module

Audiocodes IF SHDSL Module

Audiocodes IF TI'WAM Module

Audiocodes IF WAM Module

Audiocodes IP Media Module

Audiocodes MI1K Device

Audiocodes M2K and M3K G\W Devices Family Class
Audiocodes M2K Device

+ Audiocodes M3K Device -
1| 3
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8.1.2  Optimizing Monitor's Load

This section describes how to configure when monitors are launched.

The following monitors have a high level of CPU utilization, and therefore it is highly
recommended to synchronize the times when they are launched:

B Gateways:
e Audiocodes Blocked Channels High Threshold Monitor
e  Audiocodes Free Channels Low Threshold Monitor
e  *Audiocodes Low Threshold Monitor <PM>— family of monitors
e  *Audiocodes High Threshold Monitor <PM> — family of monitors

Note: All threshold monitors have corresponding counter rules. For example, the
Audiocodes Blocked Channels High Threshold Monitor has the corresponding rule
'‘Audiocodes Digital Trunk Blocked Channels Counter Rule (see Section 8.1.4 on page

96.)

B Trunks:
e  AudioCodes Digital Trunk Alarm Monitor (see Section 7.3.3 on page 69).

*For the AudioCodes *Low Threshold Monitor and AudioCodes *High Threshold Monitors
family of monitors, where <PM> is the name of the PM (performance monitor), such as
‘Tel2IP Failed Calls'.
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» To optimize monitors' loading:
1.

In the Authoring pane, select Management Pack Objects > Monitors.

Figure 8-5: Monitors Option

4 | 7 Authoring
2=l Management Pack Templates
%% Distributed Applicatiors

E2 Groups
4 &g Management Pack Objects
Attributes
) Monitors  (EE—

|7y Object Discoveries
B Overrides

Rules

|z Service Level Tracking

Tasks

| Views

The Monitors window is displayed:

Figure 8-6: Monitors

B Monitors - Audiocodes - Operations Manager [_ 1ol =]
Fle Edit View Go Tasks Tools Help
l— searchw _ | Create aMonitor v _ | Ovemides v _ -
Authoring Monitors » Tasks
4 [ uthoring Management pack objects are now scopedto: Audiocodes Analog Trunk Class, Audincodes... ChangeScope.. X | [ @
I Management Pack Templates Target |Type Inherited From |Ma|d MDnit;}r N
ZE Distributed applications » Audiocodes IF BRI Module
& Groups > Audiocodes IF Digital Module ceellhiones
o e Cles > Audiocodes IF SHDSL Module [ Praperties
b > Audiocodes IF TIWAN Module Disable
Manitars N .
B Gupemmmas » Audiocodes IF WAN Module 5 Overrides »
B Cverrices * Audiocodes IP Media Module 7 Delete
=) Rules 4 Audiocodes M1K Device
B e N s 4 [ Entity Health Aggregate Rollup  Object He:
-_: Tasks > Aarzilability Aggregate Rollup Ohbject He:
(4] views > onfiguration Aggregate Rallup Ohject He:
a erformance Aggregate Rallup Object He:
Audiocodes Atkempted Calls IP2Tel High Treshold M., Audiocodes Cumul.,  Audiocodes SHMP L. &u
Audiocodes Attempted Calls IP2Tel Low Treshold M. Audiocodes Cumul..  Audiocodes SHMMP .. A
Audiocodes Attempted Calls Tel2IP High Treshold M. Audiocodes Cumul..  Audiocodes SMMP .. A
Apdiooodes Atkempted Calls Tel2IP Low Treshold M., Audiocodes Cumul.,  Audiocodes SNMP L, Au
Audiocodes Blocked Channels High Treshold Monitor Audiocodes Blocke..,  Audiocodes SMMP .. &un
Audiocodes Busy Calls IP2Tel High Treshold Maonitar  Audiocodes Cumul..  Audiocodes SHMMP .. A
Audiocodes Busy Calls IP2Tel Low Treshald Monitor Audiocodes Cumul..  Audiocodes SMMP ... A
Add Moritoring Wizard. . Apdiocodes Busy Calls Tel2IP High Treshold Monitor  Audiocodes Cumul.,  Audiocodes SNMP L. A,
Mew Distributed Application. .. : I I :
P Monitor details: v

Bl wMonitoring
;'/f Authoring

i Administration

Audiocodes Blocked Channels High Treshold Monitor

Monitor Description:

Management Pack:  Audiocodes GW Management Pack

Target Audiocodes SHMP Device
W My Workspace Inherited From: Audiocodes SHMP Device
Knovidedge: View knowledge

Ready

|
4

2.
override.

In the 'Monitors' list, expand the tree and select the monitor whose value you wish to
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Figure 8-7: Overriding Object Monitors

Monitors * Tasks
Management pack objedts are now scopedto Audiocodes Analog Trunk Class, Audiocodes... Change Scape.., x E] 71

Target Type Inhetited From MalLI i _
- & | Monitor ~

Audiocodes IF BRI Module

Audiocodes IF Digital Module Create a Monitc

Audiocodes IF SHDSL Module =:| Properties

Audiocodes IF TIWAN Module Disable

Audiocodes IF WAN Module i
Disable the Maonitor 3 (o ot =i

Audiocodes IP I Delete
For all objects of class: Audiocodes M1K Device Override the Monitor 3
4 Audiocodes M1
4 "2 Entity Hes otalornr Disable Diagnostic

For a specific object of dass: Audiocodes M1K Device

1 Awailat Override Diagnostic
"8 Config For all objects of another class... ) i
- Disable Recovery
4 5 Performance Aggregate Rollup

Override Recovery
Audiocodes Atkternpted Calls IP2Tel High Treshold M., Audiccodes Cumul.,
Summary 3
Aydiocodes Atkernpted Calls IP2Tel Lowe Treshold M., Audiccodes Cumul.,
Audiocodes Attempted Calls Tel2IP High Treshold M., Audiocodes Cumul..,  Audiocodes SMMP .. &
Audiocodes Atternpted Calls Tel2IP Low Treshold M., Audiocodes Cumul,.,  Audiocodes SNMP .. A
Audiocodes Blocked Channels High Treshold Monitor Audiocodes Blocke,,,  Audiocodes SMNMP .. A
Aydiocodes Busy Calls IP2Tel High Treshold Monitor  Audiocodes Cumul.,,  Audiocodes SMMP . A
Audiocodes Busy Calls IP2Tel Lowe Treshaold Monitor Audiocodes Cumul.,,  Audiocodes SMRMP .. A
Audiocodes Busy Calls Tel2ZIP High Treshold Monitor  Audiocodes Cumul,,  Audiocodes SNMP L. Al
1| | 3

3. Right-click the monitor, choose Overrides > Override the Monitor, and then in
pop-up dialog, select the scope affected by the modification e.g. "For a group".
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The Override Properties window is displayed:

Figure 8-8: Override Properties-Object Monitors-High Level Threshold Monitor

Dverride Properties
taonitar name: Audiocodes Blocked Channels High Treshold Monitar
Categony: Custari
Owerrides target: Clazs: Audiocodes M1k Device
Oweride-controlled parameters: Show Monitor Properties... |
Overide | Parameter Mame ¢ | Parameter Type Defaul Yalue | Overide Yalue | Effective Walue | Change Status il
- Alert severity E numneration Match monit... | batch monito... | katch monitar.. | [Mo change]
[ Auto-Fesolve Alert Boolean True True True [Ma change]
[ Enabled Boolean True True True [Ma change]
[ Generates Alert Boolean True True True [Mo change]
- HighCriticalLewvel Integer 40 40 40 [Mo change]
- Highw/arningLewel Integer a0 an an [Mo change]
- Intersals econds Integer 0 B0 B0 [Ma change]
» n SypncTime String 1z:00 1200 1200 [Ma change] =
«| | i
D etails:
SyncTime Description Edi...
The parameter iz not set by a custom overide or by a
management pack. The effective value of this parameter
iz the default value of thiz parameter.
Management pack
Select destination management pack:
Audiocodes G banagement Pack j =0
Help | Ok | Apply | Cancel |
4

4. Select the 'Override' check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

5. Inthe 'Override Value' field for 'SyncTime', type the appropriate value.
6. Click OK.
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8.1.3  Optimizing Discoveries' Load

This section describes how to configure when discoveries are launched. SCOM periodically
discovers gateways and their modules and trunks to update their respective health states.
The different types of discoveries are described below:

B Gateways:

e Device Discovery
B Modules:

e Initial Discovery

e Index Discovery

e  Secondary Discovery
B Trunks:

e Initial Discovery

e  Secondary Discovery
B Ethernet Port:

e Initial Discovery

e Index Discovery

e  Secondary Discovery

Note: Since the number of trunks which have to be discovered is much higher relative to
the number of modules and gateways, reducing the polling frequency for the number of
trunk-related discoveries will significantly improve the performance of the SCOM server.

For more information, see Appendix C on page 167.

» To optimize discoveries' loading:
1. Inthe Authoring pane, select Management Pack Objects > Object Discoveries.
Figure 8-9: Object Discoveries Option

4 | 7 Authoring
> %) Management Pack Templates
#¥ Distributed Applicatiors
= Groups
4 &5y Management Pack Objects
i=| Attributes
1 Manitars
|ty Object Discoveries (m—
B Cverrides
|=| Rules
|z Service Level Tracking
_"' Tasks

£ Views
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The Object Discoveries window is displayed:

Figure 8-10: Object Discoveries

Object Discoveries (269)

Management pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocodes,.,

Marne

4 Discovered Type: Audiocodes Analog Trunk Class (2)
g Audiocodes Trunks on &nalog Module Initial Discowery
g Audiocodes G Analog Trunk Secondary Discovery

4 Discovered Type: Audiocodes CPU Module (9
g Avdiocodes Mediant 4000 CPU Module Initial Discovery
g Avdiocodes CPU Module Index Discowery
g Avdiocodes Mediant 1000 CPU Module Initial Discovery
g Audiocodes Mediant 300 CPU Module Initial Discowvery

4 Discovered Type: Audiocodes Digital Trunk Class (7)
g Audiocodes Digital Trunks on Digital Module Initial Discov,.,
g Audiocodes Digital Trunks on acTrunkPack-MEDIANT2000 ..
|y Audiocodes Digital Trunk Secandary Discovery

iy Audiocodes Mediant 300 IF Digital Module Trunk Digital In..

| Audiocodes Digital Trunks on BRI Module Initial Discovery
| Audiocodes Mediant 800 IF BRI Module Trunk Digital Initia...

g Audiocodes Digital Trunk on acTrunkPackIPM2000 Module ...

4 Discovered Type: Audiocodes Ethernet Port Class (3)
g Audiocodes Ethernet Port Initial Discovery

| Audiocodes Ethernet Port Secondary Discovery
l

Target

Audiocodes IF &nalog M.

Audiocodes Analog Trun..,

Audiocodes SMMP Device
Audiocodes CPU Module
Audiocodes SMMP Device
Audiocodes Mediantod ..

Audiocodes IF Digital Mo..,
Audiocodes acTrunkPack-..
Audiocades Digital Trunk..,
Audiocodes Mediant 00 ...
Audiocodes IF BRI Module
Audiocodes Mediant 00 ...

Audiocodes acTrunkPack-..

Audiocodes CPU Module
Audiocodes Ethernet Part..,

2.
you wish to override.

Change Scope.. x

fManagement Pack j

Audiocodes GW Mar
Audiocodes GW Mar

Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW kar

Audiocodes GYW Mar
Audiocodes GYW Mar
Auydiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar
Audiocodes GW Mar

Audiocodes GiW Mar

Audiocodes GWM_aij
3

Figure 8-11: Overriding Object Discoveries

Object Discoveries (269)

Management pack objects are now scopedtor Audiocodes Analog Trunk Class, Audiocodes...

Marne

4 Discovered Type: Audiocodes Analog Trunk Class (2)
g Avdiocodes Trunks on Analog Module Initial Discoveny
i Audiocodes G Analog Trunk Secondary Discovery

4 Discovered Type: Audiocodes CPU Module (4)
g Avdiocodes Mediant 4000 CPU Module Initial Discovery

B For all objects of class: Audiocodes Digital Trunk Class

Target

Audiocodes IF Analog M.,

Audiocodes Analog Trun..,

Audiocodes

Change Scope... b 4

fManagement Pack j

Audiocodes GV Mar
Audiocodes GW Mar

Disable the Object Discovery

Cverride the Object Discovery

Summary

I For a group...
B ¢ For a specific object of class: Audiocodes Digital Trunk Class
a [x

For all chjects of ancther dass...

._% SLTUTOLOLES DITYTCAT TIUTTE S OTT LYo MU TE ITTord T DT one, .

i Avdiocodes Digital Trunks on acTrunkPack-REDISNT2000 ...

i Audiocodes Digital Trunk Secondary Discowery

|y Audiocodes Mediant 00 IF Digital Module Trunk Digital In..,

| Audiocodes Digital Trunks on BRI Module Inhitial Discovery

i Avdiocodes Mediant 800 IF BRI Module Trunk Digital Initia...

g Audiocodes Digital Trunk on acTrunkPackIPRA2000 Module .
4 Discovered Type: Audiocodes Ethernet Port Class (3)

i Audiocodes Ethernet Port Initial Dizcovery

i Audiocodes Ethernet Port Secondary Discovery
4

anumoroues {F Digital Ma..,
Audiocodes acTrunkPack-..,
Audiocodes Digital Trunk...
Audiocodes Mediant 800 ..
Audiocodes IF BRI Module
Audiocodes Mediant 500 ..,

Audiocodes acTrunkPack-..,

Audiocodes CPU Module
Audiocodes Ethernet Part..,

Audiocodes GW Mar
Audiocodes GV Mar
Audiocodes GW Mar
Auydiocodes W Mar
Audiocodes GW Mar
Audiocodes GV Mar
Audiocodes GW Mar

Audiocodes GV Mar

Audiocodes W Mar ,I
»

* Tasks
8 e

Object
Discovery

In the 'Discoveries' list, expand the tree and select the Discovery object whose value

* Tasks
o e

0Object
Discovery

Properties
|:pfy Disable
Overrides ¥

» Delete
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3. Right-click the monitor, choose Overrides > Override the Object Discovery, and
then in pop-up dialog, select the scope affected by the modification e.g. "For all
objects of another class".

The Override Properties window is displayed:
Figure 8-12: Override Properties-Object Discoveries

Override Properties [ %]

Object Discovery name: Audiocodes acTunkPack-MEDIANT 2000 Secondary Discovery
Category: Dizcovery
Overrides target: Clazs: Audiocodes acTunkPack:-MEDIANT 2000

Ovemide-controlled parameters: Show Object Discovery Properties...

Override | P. ter Mame ¢ | P ter Type Default Yalue | Overide Value | Effective Value | Change Status
1 Tr Tru Tr
B0 » B0
»
| I o
Details:
SyncTime Description Edit...

The parameter iz not zet by a custom override or by a
management pack. The effective value of thiz parameter
iz the default value of thiz parameter.

Management pack

Select destination management pack:

Audiocodes GW Management Pack j MNew.

Help | ak. | Apply | Cancel |
Y

4. Select the 'Override' check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

5. Inthe 'Override Value' field for 'SyncTime, type the appropriate value.
6. Click OK.
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8.1.4  Optimizing Rule's Load

This section describes how to configure when rules are launched.

There are two specific rules whose values are recommended to override. These rules
(counters) unlike the SIP PMs are not typical device counters; instead they calculate values
based upon monitored information about the Channels' state retrieved from the device (in-
service or out-of-service). These counters (‘Audiocodes Digital Trunk Available Channels
Counter Rule' and 'Audiocodes Digital Trunk Blocked Channels Counter Rule’) by default
collect information every minute and include a large number of monitored entities.
Consequently, this high polling frequency leads to high CPU utilization.

Therefore, you can improve performance by reducing the polling frequency of these
counters using the rule 'Audiocodes.GW.Management.Pack.Trunk.Digital. Channels.Probe'
(see Figure 8-14, Figure 8-15 and Figure 8-16). For this rule, it is recommended to modify
both the 'IntervalSeconds' parameter as well as the 'SyncTime parameter'.

Note: This rule queries the Channels state from the device, and then saves the
information in a file directory specified by System Environment variable
"AudiocodesTempFolder. This information is then aggregated by a script launched by the

SCOM.

It is also recommended to poll no more than one counter rule at any one point in time (for
details, see Appendix C on page 167).

» To optimize rules' loading:
1. Inthe Authoring pane, select Management Pack Objects > Rules.

Figure 8-13: Rules Option

4 | 7 Authoring
» (sl Management Pack Templates
%% Distributed Applicatiors
&= Groups
4 ‘&g Management Pack Objects
=] Attributes
) Manitars
|7y Object Discoveries
B Cverrides
|Z] Rules (uu—
|z Service Level Tracking
_h Tasks

& Views
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The Rules window is displayed:
Figure 8-14: Object Rules

PR Rules - Audiocodes - Operations Manager
Fle Edit View Go Tasks Tools Help

I Search »

Authoring

4 __5‘ Authoring
“~ Management Pack Templates
¥ Distributed Applications
3 Groups
4 iy Management Pack Objeds
i=| Attributes
Monitors
| ObjectDiscoveries
B Querrides
|:=| Rules
| Service Lewel Tracking
O Tasks
& Wiews

Add Monitoring Wizard...
Meww Distributed Application. . .

MNew Group,..
. Monitoring
# Authoring
Administration

_[?:\ My Workspace

Ready

Create a Rule

i Overrides v

Scope|| () Find || [7] Tasks|| @ _

< Rules (282)

Management pack objects are now scopedto: Audiocodes Analog Trunk Class, Audiocodes...

Marme
4 Type: Audiocodes Digital Trunk Class (3)
Audiocodes Digital Trunk Available Channels Counter Rule
Audiocodes Digital Trunk Blocked Channels Counter Rule
=) Audiocodes Digital Trunk Channels Probe Rule
4 Type: Audiocodes G'W Mediant4000 (31)
Audiocodes Attempted Calls Tel2IP Counter Rule
Audiocodes &vailable Channels Counter Rule
Audiocodes IPGroupDialogs Counter Rule
Audiocodes Established Calls Tel2IP Counter Rule
Audiocodes Busy Calls [P2Tel Counter Rule
Audiocodes Failed Calls Tel2IP Counter Rule
Audiocodes SROSubscribeDialogs Counter Rule
Audiocodes Attempted Calls IP2Tel Counter Rule
Audiocodes SROInwiteDialogs Counter Rule
Audiocodes MoResources Calls IP2Tel Counter Rule
Audiocodes Forwarded Calls Tel2IP Caunter Rule
Audiocodes SRDOtherDialogs Counter Rule
Audiocodes MoRoute Calls IP2Tel Counter Rule

Audiocodes IPGrouplnviteDialogs Counter Rule

|

> Tasks

Change Scope.. - 7]

X
Management Pack =
& j Rule -

|i=| Createa Rule

Irherited from

Audiocodes Digital Trunk., Audiocodes GW Mar
Audiocodes Digital Trunk., Audiocodes GW Mar
Audiocodes Digital Trunk...  Audiocodes GW Mar 3
Audiocodes SNMP Device  Audiocodes W Mar
Audiocodes SNMP Device  Sudiocodes G¥W Mar
Audiocodes SNMP Device  Audiocodes G¥W Mar
Audiocodes SNMP Device  Audiocodes G4 Mar
Audiocodes SNMP Device  Audiocodes W Mar
Audiocades G Mar
Audiocades GWW Mar
Audiocodes G Mar
Audiocades G Mar
Audiocades G Mar
Audiocades GWW Mar
Audiocodes G Mar
Audiocades G Mar

Audiocodes SNMP Device Audiocodes GW Mar o
| 3|

Audiocodes SNMP Device
Audiocodes SNMP Device
Audiocodes SMMP Device
Audiocodes SNMP Device
Audiocodes SNMP Device
Audiocodes SNMP Device
Audiocodes SMMP Device
Audiocodes SNMP Device

Rule detail

O Select a rule above to view details

v

Y

2. In the 'Rules' list,

expand the tree and select the rule whose values you wish to

override. For example, the 'Digital Trunk Channels Probe Rule'.
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Figure 8-15: Overriding Object Rules-AudioCodes Digital Trunk Channels Probe Rule

Rules {282)

Management pack abjects are now scopedto Audiocodes Analog Trunk Class, Audiocodes..,

Marme

4 Type: Audiocodes Digital Trunk Class (3)

Audiocades Digital Trunk &vailable Channels Counter Rule

Audiocodes Digital Trunk Blocked Channels Counter Rule

|i=] Audiocodes Digital Trunk Channels Probe Rule

4 Type: Audiocodes GW Mediant4000 (31)

Inherited From

Audiocades Digital Trunk...
Audiocodes Digital Trunk...
Audiocodes Digital Trunk...
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— For all objects of class: Audiocodes Digital Trunk Class
=] Audiocode
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=] Audiocode -
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Audiocades Failed Calls Tel2IP Counter Rule
Aydiocodes SRDSubscribeDialogs Counter Rule
Audiocades Attempted Calls IP2Tel Caunter Rule
Audiocodes SRDInviteDialags Counter Rule
Audiocodes MoResources Calls IP2Tel Caunter Rule
Audiocodes Forwarded Calls Tel2IP Counter Rule
Audiocades SRDOtherDialogs Counter Rule
Audiocodes MaRaute Calls IP2Tel Counter Rule

Aydiocodes IPGrouplnviteDialogs Counter Rule

e
Audiocodes SMMP Dewice
Audiocodes SMMP Device
Audiocodes SMMP Device
Audiocodes SMMP Device
Audiocodes SMMP Device
Audiocodes SMMP Device
Audiocodes SMMP Device
Audiocodes SMMP Dewice
Audiocodes SMMP Device

* Tasks
Change scope... » E )
Management Pack =
A Rule ~
tudiocodes W Mar L Create 2 Rule
Audiocodes GW Mar = Properties
Audiocodes G Mar |i=| Disable
Disable the Rule , [Overrides b
Override the Rule  |Delete
Summary b

Audiocodes Gl Mar
Audiocodes Gy Mar
Audiocodes GW Mar
Audiocodes Gl Mar
Audiocodes G Mar
Audiocodes GV Mar
Audiocodes Gl Mar
Audiocodes Gl Mar
Audiocodes @ Mar

Audiocodes GWM_aiLI
3

3. Right-click the monitor, choose Overrides > Override the Rule, and then in pop-up
dialog, select the scope affected by the modification e.g. "For a group".
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The Override Properties window is displayed:

Figure 8-16: Override Properties-Audiocodes Digital Trunk Channels Probe Rule

Override Properties E
Rule nane: Audiocodes Digital Trunk Channels Probe Rule
Categony: Cugtom
Overrides target; Clazz: Audiocodes Digital Trunk, Clazs
Overide-controlled parameters: Show Rule Properties. .
Override | Parameter Mame  # | Parameter Type Default Yalue | Oweride Yalue | Effective Walue | Change Status
- Enabled Boolean True True True [Ma change]
» n Interval Seconds Inteqer B0 B0 B0 [Ma change]
- Sync Time String [Ma change]
- Timeout Seconds Inteqer B0 B0 B0 [Ma change]
l | i
Details:
Interval Seconds Description Edit...
The parameter iz not zet by a custom overide or by a
management pack. The effective value of this parameter
iz the default valug of this parameter.

Management pack

Select destination management pack:

Audincodes G Management Pack. j e

Help | (] | Apply Cancel |

4. Select the 'Override' check box for the 'SyncTime' parameter.

Note: The message in Details pane is context-sensitive. Once you select a check box,
the message text changes accordingly.

In the 'Override Value' field for 'SyncTime', type the appropriate value.
Select the Override check box for the 'IntervalSeconds' parameter.

In the 'Override Value' field for 'IntervalSeconds', type the appropriate value.
Click OK.

In the 'Rules’ list, select other rules whose values you wish to override. For example,
the 'Audiocodes Failed Calls Tel2IP Counter Rule'.

© © N o u»
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Figure 8-17: Overriding Object Rules-AudioCodes Failed Calls Tel2IP Counter Rule

Rules (282) * Tasks
Mahagement pack objects are now scopedto Audiocodes Analog Trunk Class, Audiocodes.,..  Change Scope... » E] 71
Marne Inherited From Management Pack 2
Rule ~

4 Type: Audiocodes Digital Trunk Class (3)

Create a Rul
Auydiocodes Digital Trunk Awailable Channels Counter Rule  Audiocodes Digital Trunk,.. Audiocodes GW Mar ief treate a Rule
Audiocodes Digital Trunk Blocked Channels Counter Rule Audiocodes Digital Trunk,, Audiocodes Gy Mar =] Properties
|i=| Audiocodes Digital Trunk Channels Probe Rule Audiocodes Digital Trunk...  Audiocodes GW Mar |£| Disable
4 Type: Audiocodes GW Mediant4000 (31) . lowerrides b
Disable the Rule
=| Audiocodes Delet
— For all objects of class: Audiocodes GW Mediant3000 Override the Rule M|
Audiocodes

. For a group...
Audiocodes Summany »

For a specific object of class: Audiocodes GW Mediant$000

|i=| Audiocodes I e E————
= Audiocodes For all objects of another class... & Audiocodes GW Mar
|i=| Audiocodes Failed Calls Tel2IP Counter Rule Audiocodes SMMP Device  Audiocodes GW Mar
=] Audiocodes SRDSubscribeDialogs Counter Rule Audiocades SMMMP Device Audiocodes GW har
=] Audiocodes Atternpted Calls IP2Tel Counter Rule Audiocodes SMMP Device Audiocodes G Mar
|i=| Audiocodes 3RDInviteDialogs Counter Rule Andiocodes SMMP Device Aydiocodes GW Mar
=] Audiocodes MoResources Calls IP2Tel Counter Rule Audiocodes SMMP Device Audiocodes G Mar
|i=| Audiocodes Forwarded Calls Tel2IP Counter Rule Audiocodes SMMP Device  Audiocodes GW Mar
=] Audiocodes SRDOtherDialogs Counter Rule Audiocades SMMMP Device Audiocodes GW har
=] Audiocodes MoRoute Calls IP2Tel Counter Rule Audiocodes SPMP Device  Audiocodes W Mar
=] Audiocodes IPGrouplnviteDialogs Counter Rule Audiocades SMMMP Device Audiocodes GW Mar o
l | _*I_I

10. Right-click the monitor, choose Overrides > Override the Rule, and then in pop-up
dialog, select the scope affected by the modification e.g. "For a group".

The Override Properties window is displayed:
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Figure 8-18: Override Properties-AudioCodes Failed Calls Tel2IP Counter Rule

Ovetrride Properties

Fule name: Audiocodes Faled Calls Tel2IP Counter Rule
Category: Custarn
Overrides target: Class: Audiocodes GW Mediant4000
DOveride-controlled parameters: Show Fule Properties. . |
Owenide | Parameter Mame © | Parameter Type Default Value | Ovemide Value | Effective Value | Change Status
- Enabled Boolean True True True [Mo change]
[l IntervalSeconds Integer 300 00 900 [Mo change]
»4“ SyncTime Sting 1200 1200 1200 [Ma change]
1| | i
Details:
SyncTime Description Edit...
The parameter is not set by a custom overide or by a
management pack. The effective value of thiz parameter
iz the default value of this parameter,
Management pack
Select destination management pack:
IAud\ocodas G Management Pack j MHew...
Help ok | apy | caneel |
4

11. Select the 'Override’ check box for the 'SyncTime' parameter.

12. In the 'Override Value' field for 'SyncTime', type the appropriate value.
13. Click OK.
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A SNMP Traps

The tables in the following subsections provide information on SNMP traps that are sent
from the device to the SCOM. The component name (described in each of the following
headings) refers to the string provided in the acBoardTrapGlobalsSource trap varbind.

Notes:

e  Traps are not sent automatically to the SCOM. You must first configure the SCOM
server as a Trap Manager on your managed device (see Section 5.2 on page 46).

CE e Alltraps are sent from the SNMP port (default 161).

e To clear a generated alarm, the same notification type is sent; however with the
severity set to ‘Cleared’.

All trap-based monitors captured are cleared when a new trap arrives with
the same OID and source varbinds.

For detailed information on SNMP, refer to the SNMP Reference Guide for SIP Enterprise
Devices.

A.1 Chassis Alarms

A.1.1 Fan Tray Alarm

A Note: Applicable only to Mediant 3000 and Mediant 1000.

Table A-1: acFanTrayAlarm

Alarm acFanTrayAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.29

Description Sent when a fault occurs in the fan tray or a fan tray is missing.
Source Varbind Text Chassis#0/FanTray#0

Alarm Text Fan-Tray Alarm <text>

Event Type equipmentAlarm

Probable Cause = One or more fans on the Fan Tray module stopped working.

=  One or more fans on the Fan Tray module works slower than expected
(heatingVentCoolingSystemProblem)
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Alarm Severity

Critical

Major

Cleared

Condition <text>

Corrective Action

Fan-Tray is missing. | Fan-Trayis missing 1. Check if the Fan Tray module is inserted

When one or more Fan-Tray is faulty
fans in the Fan Tray
are faulty.

Fan Tray module is in | -
place and fans are
working.

in the chassis.

2. Ifthe Fan Tray module was removed
from the chassis, re-insert it.

3. If the Fan Tray module has already been
inserted in the chassis and the alarm is
active, send a Return Merchandise
Authorization (RMA) request to
AudioCodes.

Warning: When removing the Fan Tray
module while the power is on (or after it has
recently been switched off), the blades may
still be rotating at high speeds. Therefore, to
avoid bodily harm, make sure that you don't
touch the fan blades.

Fan Tray module is faulty. Send a Return
Merchandise Authorization (RMA) request to
AudioCodes.
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A.1.2 Power Supply Alarm

Note: Applicable only to Mediant 3000 devices and Mediant 1000 Series.

Table A-2: acPowerSupplyAlarm

Alarm acPowerSupplyAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.30

Description Sent when a fault occurs in one of the power supply (PS) modules or a PS module is

missing.

Default Severity Critical

Source Varbind Text Chassis#0/PowerSupply#<m>, where m is the power supply’s slot number

Event Type equipmentAlarm

Probable Cause powerProblem

Alarm Severity Condition <text> Corrective Action

Major The HA (High Availability) Power-Supply Alarm. Power- | 1.  Check if the unit is
feature is active (applicable Supply is missing. inserted in the chassis.
only to Mediant 3000) and 2 Ifit was removed from

one of the power supply units

h e the chassis, re-insert it.
is faulty or missing.

3. Ifit'sinserted in the
chassis and the alarm is
active, send a Return
Merchandise
Authorization (RMA)
request to AudioCodes.

Cleared PS unit is placed and - -
working.
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A.1.3 User Input Alarm

Note: Applicable to Mediant 3000 and Mediant 1000.

Alarm

OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-3: acUserlnputAlarm

acUserlnputAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.36

Sent when the input dry contact is short circuited; cleared when the circuit is reopened.

Critical
Chassis#0
equipmentAlarm
inputDeviceError

Condition

Input dry contact is short circuited.

Input dry contact circuit is
reopened.

A.1.4 PEM Alarm

<text>

Corrective Action

User input Alarm. User's | Reopen the input dry contact.

Input-Alarm turn on.

Note: Applicable only to Mediant 3000.

Alarm

OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-4: acPEMAlarm

acPEMAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.31

Sent when a fault occurs in one of the PEM modules or a PEM module is missing.

Critical

hassis#0/PemCard#<m>, where m is the power entry module’s (PEM) slot number

equipmentAlarm
underlyingResourceUnavailable
Condition

The HA (High Availability)
feature is active and one of the
PEMs (Power Entry Modules) is
missing.

PEM card is placed and both
DC wires are in.

<text>

PEM Module Alarm. | 1.
PEM card is
missing.

Corrective Action

Make sure the PEMs are
present and that they're
inserted correctly.

If it's present and inserted
correctly yet the alarm remains
active, send a Return
Merchandise Authorization
(RMA) request to AudioCodes.
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A.1.5 Hardware Failure Alarm

Note: Applicable only to Mediant 1000.

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Major

Table A-5: acHwFailureAlarm

acHwFailureAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.43

Critical

Chassis#0/module#<m>, where m is the module’s number

equipmentAlarm
equipmentMalfunction
Condition

The module is faulty or has been
removed incorrectly.

Module mismatch - module and
CPU board mismatch.

A.1.6 Timing Module Alarms

<text>

Module Alarm:
Faulty IF-Module

IF-Module
Mismatch

Corrective Action

Restart the device to clear this
alarm. The alarm is not cleared.

Restart the device to clear this
alarm. The alarm is not cleared.

Note: These alarms are applicable only to Mediant 3000.

A.1.7 TM Inconsistent Remote and Local PLL Status Alarm

Table A-6: acTMInconsistentRemoteAndLocalPLLStatus Alarm

Alarm

OID

Description

Default Severity
Source Varbind Text
Event Type

Probable Cause

Alarm Severity

Major

Status remains 'Major' until a
reboot. A 'Clear' trap is not
sent.

acTMInconsistentRemoteAndLocalPLLStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.56

Inconsistent Remote and Local PLL status.

Major
Chassis#0/TimingManager#0
equipmentAlarm

underlyingResourceUnavailable

Condition

The alarm is triggered when the
system is in 1+1 status and
redundant board PLL status is
different to the active board PLL
status

<text>

Timing Manager
Alarm. Local and
Remote PLLs

status is different.

Corrective Action

1.  Synchronize the timing module.
2. Reboot the system.

SCOM

107

AudioCodes Management Pack



/S )
(™ AudIOCOdES AudioCodes SCOM Management Pack

A.1.8 TM Reference Status Alarm

Table A-7: acTMReferenceStatus Alarm

Alarm acTMReferenceStatus

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.57

Description Timing manager reference status.

Default Severity Major

Source Varbind Text Chassis#0/TimingManager#0

Event Type equipmentAlarm

Probable Cause underlyingResourceUnavailable

Status Changes When primary and secondary clock references are down for more than 24 hours, the alarm

will be escalated to ‘Critical'.

Alarm Severity Condition <text> Corrective Action

Major The alarm is triggered when the | Timing Manager Alarm. 1.  Synchronize the timing
primary reference or secondary | PRIMARY REFERENCE module.
reference or both are down. DOWN/SECONDARY

Reboot the system.
REFERENCE DOWN/ALL

REFERENCES ARE DOWN

Status remains 'Major' until | - - -
areboot. A clear trap is not
sent.
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A.1.9 TM Reference Change Alarm

Alarm
OID
Description

Default Severity

Source Varbind Text

Event Type

Probable Cause

Alarm Severity

Table A-8: acTMReferenceChange Alarm

acTMReferenceChange
1.3.6.1.4.1.5003.9.10.1.21.2.0.58
Timing manager reference change.
Indeterminate

Chassis#0/TimingManager#0

Condition <text>

Log is sent on PLL status Timing Manager
change.

A.1.10 Trunk Alarms

Corrective Action

Corrective action is not necessary.

Note: Applicable only to Digital Series.

A.1.10.1 Trunk Near-End LOS Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

Table A-9: acTrunksAlarmNearEndLOS

acTrunksAlarmNearEndLOS
1.3.6.1.4.1.5003.9.10.1.21.2.0.49

Critical

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm
lossOfSignal

Condition <text>

Corrective Action

Critical Near-end LOS | Trunk LOS Alarm Los of Signal (LOS) indicates a physical problem.
1. Check that the cable is connected on the board.
2. Check that the correct cable type is being used
(crossed/straight).
3. Contact AudioCodes' Support Center at
support@audiocodes.com.
Cleared End of LOS - -
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A.1.10.2 Trunk Near-End LOF Alarm
Table A-10: acTrunksAlarmNearEndLOF

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

acTrunksAlarmNearEndLOF

1.3.6.1.4.1.5003.9.10.1.21.2.0.50

Critical

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

lossOfFrame

Condition

Near end LOF | Trunk LOF Alarm

End of LOF -

A.1.10.3 Trunk AIS Alarm

Alarm

OID

Source Varbind Text
Alarm Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

<text>

Corrective Action
Make sure that the trunk is connected to a proper
follow-up device.

Make sure that both sides are configured with the
same (E1/T1) link type.

Make sure that both sides are configured with the
same framing method.

Make sure that both sides are configured with the
same line code.

Make sure that the clocking setup is correct.

Contact AudioCodes' Support Center at
support@audiocodes.com.

Table A-11: acTrunksAlarmRcvAIS

acTrunksAlarmRcVvAIS

1.3.6.1.4.1.5003.9.10.1.21.2.0.51

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

PSTN provider has stopped the trunk (receiveFailure)

communicationsAlarm
Condition

Receive AIS

End of AIS

<text> Corrective Action

Trunk AIS Alarm e Contact your PSTN provider to

activate the trunk.

e |f the alarm persists, contact the
AudioCodes Support Center at
support@audiocodes.com
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A.1.10.4 Trunk Far-End LOF Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-12: acTrunksAlarmFarEndLOF

acTrunksAlarmFarEndLOF

1.3.6.1.4.1.5003.9.10.1.21.2.0.52

Critical

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

transmitFailure

Condition

RAI

End of RAI

A.1.10.5 DS1 Line Status Alarm
Table A-13: dsx1LineStatusChange

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

<text>

Trunk RAI Alarm

dsxlLineStatusChange

1.3.6.1.2.1.10.18.15.0.1

Major on raise; Clear on clear

Corrective Action

Make sure that transmission is
correct.

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm

<text>

Additional Info1,2,3

DS1 Updated DS1 Line Status.

Line
Status

This variable indicates the Line Status of the interface. It contains loopback,
failure, received 'alarm' and transmitted 'alarms' information.

dsxlLineStatus is a bitmap represented as a sum, so it can represent multiple
failures (alarms) and a LoopbackState simultaneously.

dsx1NoAlarm must be set if and only if no other flag is set.

If the dsx1loopbackState bit is set, the loopback in effect can be determined from
the dsxlloopbackConfig object. The various bit positions are:

1 dsx1NoAlarm No alarm present

2 dsx1RcvFarEndLOF Far end LOF (a.k.a., Yellow Alarm)

4 dsx1XmtFarEndLOF Near end sending LOF Indication

8 dsx1RcVvAIS Far end sending AIS

16 dsx1IXmtAIS Near end sending AIS

32 dsx1LossOfFrame Near end LOF (a.k.a., Red Alarm)

64 dsx1LossOfSignal Near end Loss Of Signal

128 dsx1lLoopbackState Near end is looped

256 dsx1T16AIS E1TS16 AIS

512 dsx1RcvFarEndLOMF Far End Sending TS16 LOMF

1024 dsx1XmtFarEndLOMF Near End Sending TS16 LOMF

2048 dsx1RcvTestCode Near End detects a test code

4096 dsx1OtherFailure Any line status not defined here

8192 dsx1lUnavailSigState Near End in Unavailable Signal State

16384 dsx1NetEquipOOS Carrier Equipment Out of Service

32768 dsx1RcvPayloadAlS DS2 Payload AIS

65536 dsx1Ds2PerfThreshold DS2 Performance Threshold Exceeded
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A.1.10.6 B-Channel Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Major

Clear

Table A-14: acBChannelAlarm

acBChannelAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.85

Minor

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm
degradedSignal
Condition

Raised when B-channel
service state changes to 'Out
of Service' or 'Maintenance'

B-channel status changes to
'In Service'

A.1.10.7 NFAS Group Alarm
Table A-15: acNFASGroupAlarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Major

Clear

acNFASGroupAlarm

<text>

B-Channel Alarm. %s

%s — additional
information

1.3.6.1.4.1.5003.9.10.1.21.2.0.84

Major

Corrective Action

Corrective action is not necessary

Interfaces#0/Trunk#<m>, where m is the trunk interface number, 1 being the first trunk

communicationsAlarm
degradedSignal
Condition

Raised when an NFAS
group goes out-of-service

NFAS group state goes to
in- service

<text>

NFAS Group Alarm.
%s

%s— Additional
information

Corrective Action

The alarm is sent only when
the backup Non-Facility
Associated Signaling (NFAS)
D-channel also falls, i.e.,
when both D-channels are
down.

When at least one of the
D-channels (primary or
backup) returns to service,
the alarm is cleared.

Corrective action is not
necessary.
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A.1.11 SONET Alarms

Note: These alarms are applicable only to Mediant 3000 with TP-6310 blade.

The source varbind text for the alarms under this component is Interfaces#0/Sonet#<m>,
where m is the SONET interface number.

A.1.11.1 SONET Section LOF Alarm
Table A-16: AcSonetSectionLOFAlarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

acSonetSectionLOFAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.38

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm
lossOfFrame
Condition

LOF condition is present
on SONET no.n

LOF condition is not
present

A.1.11.2 SONET Section LOS Alarm
Table A-17: AcSonetSectionLOSAlarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Severity

acSonetSectionLOSAlarm

Critical

<text>

SONET-Section LOF

LOF

1.3.6.1.4.1.5003.9.10.1.21.2.0.39

Corrective Action
Make sure the framing format on the port
matches the format configured on the line.

Note that the 'sonetSectionCurrentStatus'
field in the sonetSectionCurrentTable will
have a value sonetSectionLOF(4)

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm

lossOfSignal

Condition

<text>

Corrective Action

Critical LOS condition is present | SONET-Section LOS ' 1. Make sure the fiber optic cable is
on SONET no #n plugged in correctly.

2. Make sure it's not damaged.
Make sure its remote end is correctly
connected and undamaged.

4.  Make sure that configuration of the
remote port is correct.

Note that the 'sonetSectionCurrentStatus'

field in the sonetSectionCurrentTable will

have a value sonetSectionLOS (2)
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Cleared

LOS condition is not - -
present

A.1.11.3 SONET Section AIS Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-18: AcSonetLineAlSAlarm

acSonetLineAlSAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.40

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm

receiveFailure
Condition

<text> Corrective Action

AIS condition is present on SONET-  SONET-Line AIS
Line #n

If an Alarm Indication Signal (AIS)

condition is present on a SONET

line:

1. Make sure the remote
configuration is correct.

2. Check the line status at the
remote end of the link.

Note that the 'sonetLineCurrentStatus'
field in the sonetLineCurrentTable
will have a value sonetLineAlS

@

AIS condition is not present. - -

A.1.11.4 SONET Line RDI Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-19: AcSonetLineRDIAlarm

acSonetLineRDIAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.41

Critical

Interfaces#0/Sonet#<m>, where m is the SONET interface number

communicationsAlarm

transmitFailure
Condition

<text> Corrective Action

SONET-Line RDI 1. Check the remote site for

alarm conditions.

2. Correct a line problem that
has arisen from the remote
interface.

RDI condition is present on
SONET-Line #n

Note that the 'sonetLineCurrentStatus'
field in the sonetLineCurrentTable
will have a value sonetLineRDI

()

RDI condition is not present. - -
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A.1.11.5 SONET Path STS LOP Alarm
Table A-20: acSonetPathSTSLOPAlarm

Alarm

OID

Default Severity

Source Varbind
Text

Event Type

Probable Cause

Alarm Severity

Critical

Cleared

acSonetPathSTSLOPAIarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.61

Critical

Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
receiveFailure
Condition

LOP condition is present
on Path #m

LOP condition is not
present

<text>

SONET Path STS Loss of

Pointer alarm: LOP

A.1.11.6 SONET Path STS AIS Alarm
Table A-21: acSonetPathSTSAISAlarm

Alarm

OID

Default Severity

Source Varbind
Text

Event Type

Probable Cause

Alarm Severity

acSonetPathSTSAISAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.62

Critical

Corrective Action

1. Verify that the Path configuration is
identical on both ends. For example, if the
far-end is configured as STS3c instead of
STS3, this is causing the alarm.

2. If the alarm doesn't clear, contact
AudioCodes Support Center at:

support@audiocodes.com

Note that the 'sonetPathCurrentStatus' field in
sonetPathCurrentTable has a value of
sonetPathSTSLOP(2)

STS = Synchronous Transport Signal

Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
receiveFailure

Condition

<text>

Corrective Action

Critical AIS condition is present on | SONET Path STS AIS 1. Check the configuration of the SONET
Path #n alarm: AIS path.

2. You may need to check more than just
the next hop. You may need to check the
far end of the path.

Note that the 'sonetPathCurrentStatus' field in

sonetPathCurrentTable has a value of

sonetPathSTSAIS(4)
Cleared AIS condition is not - -
present
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A.1.11.6.1 SONET Path STS RDI Alarm
Table A-22: acSonetPathSTSRDIAlarm
Alarm acSonetPathSTSRDIAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.63

Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
transmitFailure

Condition <text> Corrective Action

SONET Path STS RDI alarm:
RDI (Remote Defect
Indicator)

RDI condition is present on
Path #n

Check the stations along the SONET
path for alarm statuses, beginning with
the nearest hop.

The Remote Defect Indicator (RDI) is
sent upstream from the path endpoint to
inform the provider of a problem with its
circuit downstream.

Note that 'sonetPathCurrentStatus' in the
sonetPathCurrentTable has a value of
sonetPathSTSRDI(8)

RDI condition is not present - -

A.1.11.7 SONET Path Unequipped Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-23: acSonetPathUnequippedAlarm

acSonetPathUnequippedAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.64

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
receiveFailure
Condition

<text> Corrective Action

Unequipped condition is
present on Path #n

SONET Path Unequipped 1.
alarm: Unequipped

Make sure the SONET path has a
valid sender. The problem
originates with the hub transmitting
the signal to the hub reporting the
alarm.

2. Make sure the other side is set up
correctly. Make sure the carrier's
SONET network is set up correctly.
If you're set up correctly on both
sides, it's probably the carrier's
SONET network that is the
problem.

See also RFC 1595.
Note that 'sonetPathCurrentStatus' in

the sonetPathCurrentTable has a value
of sonetPathUnequipped(16)

Unequipped condition is not
present
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A.1.11.8 SONET Path Signal Label Mismatch Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type
Probable Cause

Alarm Severity

Table A-24: acSonetPathSignalLabelMismatchAlarm

acSonetPathSignalLabelMismatchAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.65

Critical
Interfaces#0/Path#<m>, where m is the SONET interface number

communicationsAlarm
receiveFailure

Condition <text> Corrective Action

Critical Signal Label Mismatch condition is | SONET Path Signal Label ' 1. Make sure the SONET Path is
present on Path #n Mismatch alarm: correctly provisioned.
SignalLabelMismatch 2. Make sure the received

Cleared S

Synchronous Transport Signal
(STS) or VT signal label (the C2
byte or V5 bits 5 through 7
respectively) is equal to either a
label value corresponding to the
locally provisioned Path-
Terminating Equipment (PTE)
functionality or the label value
corresponding to the equipped,
non-specific code.

See RFC 1595.

Note that 'sonetPathCurrentStatus' in
sonetPathCurrentTable has a value
of sonetPathSignalLabelMismatch(32)

ignal Label Mismatch condition is | - -

not present

A.1.11.9 SONET Hardware Failure Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type
Probable Cause

Alarm Text

Table A-25: acSonetlfHwFailureAlarm

acSonetlfHwFailureAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.42

Critical on raise; Clear on clear

Interfaces#0/Path#<m>, where m is the SONET interface number
communicationsAlarm

Transmit failure

SONET/SDH interface Failure Alarm
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A.1.12 DS3 Alarms

Note: These alarms are applicable only to Mediant 3000 with TP-6310 blade.

A.1.12.1 DS3 RAI Alarm
Table A-26: acDS3RAIAlarm

Alarm acDS3RAIAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.66
Default Severity Critical
Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.
Text
Event Type communicationsAlarm
Probable Cause transmitFailure
Alarm Severity Condition <text> Corrective Action
Critical RAI condition is present on DS3- | DS3 RAI alarm: RAI To clear the Remote Alarm Indication
Line #n (RAI) failure, remove the presence of
any of the following:
= Far-end Severely Errored Frame
(SEF) / Alarm Indication Signal
(AIS) defect (aka 'yellow'). To
correct it, set the two X-bits in the
M-frame that are set to zero, to
one (RFC 1407).
=  One or two alarm signals on the
far-end alarm channel.
Note that the 'dsx3LineStatus' field in
dsx3ConfigTable will have a value of
dsx3RcvRAlFailure(2)
Cleared RIA condition is not present - -
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A.1.12.2 DS3 AIS Alarm
Table A-27: acDS3AISAlarm

Alarm acDS3AISAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.67
Default Severity Critical
Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.
Text
Event Type communicationsAlarm
Probable Cause receiveFailure
Alarm Severity Condition <text> Corrective Action
Critical AIS condition is present on DS3- | DS3 AIS alarm: AIS = Remove the presence of Alarm
Line #n Indication Signal (AIS) in
contiguous M-frames for a time
equal to or greater than T, where
0.2ms <=T <= 100 ms.
= See RFC 3896 for information on
DS3 AIS framed with "stuck
stuffing".
Note that the 'dsx3LineStatus' field in
dsx3ConfigTable will have a value of
dsx3RcvAIS(8)
Cleared AIS condition is not present - -

A.1.12.3 DS3 LOF Alarm
Table A-28: acDS3LOFAlarm

Alarm acDS3LOFAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.68

Default Severity Critical

Source Varbind Interfaces#0/DS3#<m>, where m is the DS3 interface number.

Text

Event Type communicationsAlarm

Probable Cause lossOfFrame

Alarm Severity Condition <text> Corrective Action
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Alarm

Critical

Cleared

acDS3LOFAlarm

LOF condition is present on DS3-
Line #n

LOF condition is not present

DS3 LOF alarm: LOF

Correct the configuration
settings on the line. They're
correct for the the port but not
correct for the line.

Make sure the framing format
configured on the port matches

the framing format on the line.

Try see if the other framing

format clears the alarm.

Configure a remote loopback on

the affected interface. Do this
with your provider. Run an

unframed Bit Error Rate Tester
(BERT) to see if there're
problems on the line.

Isolate the problem using hard
or soft loopbacks (if you find
evidence of a bad line).

Note that the 'dsx3LineStatus’ field in
dsx3ConfigTable will have a value
dsx3LOF (32)
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A.1.12.4 DS3 LOS Alarm

Alarm
OID
Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

Table A-29: acDS3LOSAlarm

acDS3LOSAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.69

Critical

Interfaces#0/DS3#<m>, where m is the DS3 interface number.

communicationsAlarm

lossOfSignal
Condition <text> Corrective Action
LOS condition is present on DS3- | DS3 LOS alarm: LOS = Achieve an average pulse density

Line #n

of at least 33% over a period of
175 +/- 75 contiguous pulse
positions starting with the receipt
of a pulse.

= The alarm occurs if there are 175
+/- 75 contiguous pulse positions
with no pulses of either positive
or negative polarity. See the IETF
DS3/E3 MIB.

Note that the 'dsx3LineStatus' field in
dsx3ConfigTable will have a value of
dsx3LOS (64)

LOS condition is not present - -

A.1.12.5 DS3 Line Status Change Alarm

Alarm

OID

Default Severity
Source Varbind Text
Event Type

Probable Cause

Alarm Text

Additional Info1,2,3

Table A-30: dsx3LineStatusChangeTrap

dsx3LineStatusChange

1.3.6.1.2.1.10.30.15.0.1

Major on raise; Clear on clear

Interfaces#0/DS3#<m>, where m is the DS3 interface number.
communicationsAlarm

A dsx3LineStatusChange trap is sent when the value of an instance of dsx3LineStatus
changes. It can be utilized by an NMS to trigger polls. When the line status change results
in a lower level line status change (i.e., ds1), then no traps for the lower level are sent.

DS3 Line Status

Updated DS3 Line Status.

This variable indicates the Line Status of the interface. It contains loopback state
information and failure state information. The dsx3LineStatus is a bit map represented as a
sum, therefore it can represent multiple failures and a loopback (see dsx3LoopbackConfig
object for the type of loopback) simultaneously. The dsx3NoAlarm must be set if and only
if no other flag is set. If the dsx3loopbackState bit is set, the loopback in effect can be
determined from the dsx3loopbackConfig object.

The various bit positions are:

1 dsx3NoAlarm No alarm present

2 dsx3RcvRAlIFailure Receiving Yellow/Remote Alarm Indication

4 dsx3XmitRAIAlarm Transmitting Yellow/Remote Alarm Indication
8 dsx3RcVAIS Receiving AlS failure state

16 dsx3XmitAlS Transmitting AIS

32 dsx3LOF Receiving LOF failure state
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64 dsx3LOS

128 dsx3LoopbackState
256 dsx3RcvTestCode
512 dsx30therFailure
1024 dsx3UnavailSigState
2048 dsx3NetEquipOOS

Receiving LOS failure state
Looping the received signal
Receiving a Test Pattern

Any line status not defined here
Near End in Unavailable Signal State
Carrier Equipment Out of Service

A.1.13 SS7 Alarms

A.1.13.1 SS7 Link State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol
varbind

2. Condition

Alarm status

Corrective Action

Table A-31: acSS7 Link State Change Alarm Trap

acSS7LinkStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.19
Major

communicationsAlarm

other

** SST7 *** Link %i is %s $s

Operational state of the SS7 link becomes ‘BUSY’.
Major

%i - <Link number>

%s - <state name>: { "OFFLINE", "BUSY", "INSERVICE"}
%s — IF link has MTP3 layer, then this string equals:
(SP %i linkset %i slc %i)

Where:

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

Otherwise there is NO additional text.

BUSY

Operational state of the link becomes ‘IN-SERVICE’ or ‘OFFLINE’.
cleared

For full details see the SS7 section and SS7 MTP2 and MTP3 relevant standards.

A.1.13.2 SS7 Link Congestion State Change Alarm Trap

Alarm

OID

Default Severity
Alarm Type
Probable Cause

Alarm Text

Table A-32: acSS7 Link CongestionState Change Alarm Trap

acSS7LinkCongestionStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.22

Major

communicationsAlarm

other

*% SS7 *** Link %i is %s %s
%i - <Link number>
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Alarm

Status Changes
1. Condition
Alarm status

Additional Infol
varbind

2. Condition
Alarm status
Corrective Action

Note :

Table A-32: acSS7 Link CongestionState Change Alarm Trap

acSS7LinkCongestionStateChangeAlarm

%s — IF link has MTP3 layer, then this string equals:
(SP %i linkset %i slc %i)

Where:

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

Otherwise there is NO additional text.

%s - <congestion state>: { "UNCONGESTED", "CONGESTED" }

SS7 link becomes congested (local or remote).
Major

CONGESTED

Link becomes un-congested - local AND remote.
Cleared

Reduce SS7 traffic on that link.

This alarm is raised for any change in the remote or local congestion status.

A.1.13.3 SS7 Link Inhibit State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol varbind

2. Condition
Alarm status
Corrective Action

Note

Table A-33: SS7 Link Inhibit State Change Alarm Trap

acSS7LinkinhibitStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.20
Major

communicationsAlarm

other

*rk SS7 *** Link %i (SP %i linkset %i slc %i) is %s

SS7 link becomes inhibited (local or remote).
Major

%i - <Link number>

%i - <SP number>

%i - <Link-Set number>

%i - <SLC number>

%s - <congestion state>: { "UNINHIBITED", "INHIBITED" }

INHIBITED

Link becomes uninhibited - local AND remote

cleared

Make sure the link is uninhibited — on both local and remote sides

This alarm is raised for any change in the remote or local inhibition status.
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A.1.13.4 SS7 Link Set State Change Alarm

Alarm

OID

Default Severity
Alarm Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol varbind

2. Condition
Alarm status

Corrective Action

Table A-34: SS7 Link Set State Change Alarm
acSS7LinkSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.23
Major
communicationsAlarm
other

*xx SS7 *** Linkset %i on SP %i is %s

Operational state of the SS7 link-set becomes BUSY.
Major

%i - <Link-Set number>
%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY
Operational state of the link-set becomes IN-SERVICE or OFFLINE
cleared

For full details see the SS7 section and SS7 MTP3 relevant standards

A.1.13.,5 SS7 Route Set State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Info
2. Condition
Alarm status

Corrective Action

Table A-35: SS7 Route Set State Change Alarm Trap
acSS7RouteSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.24
Major
communicationsAlarm
Other

**x SS7 *** Routeset %i on SP %i is %s

Operational state of the SS7 route-set becomes BUSY
Major

%i - <Route-Set number>
%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY
Operational state of the route-set becomes IN-SERVICE or OFFLINE.
Cleared

For full details see the SS7 section and SS7 MTP3 relevant standards.

The source varbind text for all the alarms under the component above is System#0/SS7#0/
SS7RouteSet#<m> where m is the route set number. (Applicable to Mediant 3000

devices.)
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A.1.13.6 SS7 SN Set State Change Alarm Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm status

<text>value

Additional Infol
varbind

2. Condition
Alarm status

Corrective Action

Table A-36: SS7 SN Set State Change Alarm Trap

acSS7SNSetStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.25
Major

communicationsAlarm

Other

¥k SS7 *** SP %i is %s

Operational state of the SS7 node becomes BUSY
Major

%i - <SP number>
%s - <state name: { "OFFLINE", "BUSY", "INSERVICE"}

BUSY

Cleared when the operational state of the node becomes IN-SERVICE or OFFLINE
Cleared

Signaling Node must complete its MTP3 restart procedure and become un-isolated
For full details see the SS7 section and SS7 MTP3 relevant standards.

The source varbind text for all the alarms under the component above is
System#0/SS7#0/SS7SN#<m> where m is the SN (signaling node) number. (Applicable
to Mediant 3000 devices.)

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text
Status Changes
Condition
Alarm status

<text>value

Additional Infol varbind

Condition
Alarm status

Corrective Action

Table A-37: SS7 Ual Group State Change Alarm Trap

acSS7UalGroupStateChangeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.74
Major

communicationsAlarm

other

*** SS7 *** Group Id %j Asp status is %s

Group ASP status changes.
Major

%i - Group number

%s - New state ("NO_SCTP", "SCTP_ASSOCIATE", SCTP_FAILURE", "ASP_DOWN",
"ASP_INACTIVE", "ASP_ACTIVE")

When group ASP status changes to "ASP_ACTIVE"

cleared

The source varbind text for all the alarms under the component above is
System#0/SS7#0/ss7ualgroup#<m> where m is the ual group number. (Applicable to 3000

devices.)
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A.1.14 Hitless Software Upgrade Alarm

Note: These alarms apply to Mediant 800B GW & E-SBC HA, Mediant 3000 HA,
Mediant 2600 HA, Mediant 4000 HA, Mediant SE SBC HA, and Mediant VE SBC HA.

Alarm

OID

Default Severity
Event Type
Probable Cause

Alarm Severity

Indeterminate

Table A-38: acHitlessUpdateStatus

acHitlessUpdateStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.48

Other
Other

Condition

A notification trap sent at the beginning
and end of a hitless software update.
Failure during the software update also

activates the trap.

Hitless: Start software upgrade.

Hitless fail: Invalid cmp file file - missing

Version parameter.

Hitless fail: The software version stream

name is too long.

Hitless fail: Invalid cmp file - missing UPG

parameter.

Hitless fail: Hitless software upgrade is not

supported.

Hitless: Software upgrade ended
successfully.

<text>

Hitless
Update Event

Corrective Action

The corrective action for each condition is
described below.

Corrective action is not required.

Replace the cmp file with a valid one.

Replace the cmp file with a valid one.

Replace the cmp file with a valid one.

Replace the cmp file with a valid one that
supports hitless upgrade of the software
from the current version to the new one.

Corrective action is not required.
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A.1.15 High Availability Alarms

Note: These alarms apply to Mediant 800B GW & E-SBC HA, Mediant 3000 HA,
Mediant 4000 HA, Mediant SE SBC HA and Mediant VE SBC HA.

8.1.4.1.1 HA System Fault Alarm
Table A-39: acHASystemFaultAlarm

Trap
OID
Description

Default
Severity

Source
Varbind Text

acHASystemFaultAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.33

Sent when the High Availability (HA) system is faulty (i.e., no HA functionality).

Critical

System#0/Module#<m>, where m is the blade module’s slot number

Event Type qualityOfServiceAlarm
Probable outOfService
Cause
Alarm_ Condition <text> Corrective Action
Severity
Critical HA feature is Fatal exception error High Availability (HA) was lost due to
active but the switchover and should return automatically
system is not . . Lo
working in HA after a few minutes. Corrective action is not
mode required.
TCPIP exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
Network processor exception error HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
SW WD exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
HW WD exception error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
SAT device is missing HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
SAT device error HA was lost due to switchover and should
(applicable only to Mediant 3000) return automatically after a few minutes.
Corrective action is not required.
DSP error HA was lost due to switchover and should
(applicable only to Mediant 3000 and return automatically after a few minutes.
Mediant 4000) Corrective action is not required.
BIT tests error HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.
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PSTN stack error
(applicable only to Mediant 3000)

Keep Alive error

Software upgrade

Manual switch over

Manual reset

Board removal

(applicable only to Mediant 3000)

TER misplaced

(applicable only to Mediant 3000)

HW fault. TER in slot 2 or 3 is missing
(applicable only to Mediant 3000)

HW fault. TER has old version or is not
functional

(applicable only to Mediant 3000)

HW fault. invalid TER Type

(applicable only to Mediant 3000)

HW fault. invalid TER active/redundant
state

(applicable only to Mediant 3000)

HW fault. Error reading GbE state
(applicable only to Mediant 3000)
Redundant module is missing
(applicable only to Mediant 3000)

Redundant is not connecting
(applicable only to Mediant 3000)
Redundant is not reconnecting after
deliberate restart

No Ethernet Link in redundant module

SA module faulty or missing
(applicable only to Mediant 3000)
Eth link error

Higher HA priority

(Not applicable to Mediant 3000)

Network watchdog error

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover and should
return automatically after a few minutes.
Corrective action is not required.

HA was lost due to a system reset and
should return automatically after few
minutes. Corrective action is not required.
Return the removed board to the system.

Place the TER card according to the User's
Manual

Place the TER card according to the User's
Manual

Replace the TER card.

Replace the TER card.

Replace the TER card.

Replace the TER card.

1. Insert the redundant module into the
system.

2. Ifthe error continues, reset / replace the
module.

Reset / replace the redundant module.

Reset / replace the redundant module.

Connect Ethernet links to the redundant
module

Make sure the Shelf Alarm module is
inserted correctly.

HA was lost due to switchover,

Connect the Eth link back.

HA was lost due to switchover to unit with
higher HA priority and should return
automatically after a few minutes.
Corrective action is not required.

HA was lost due to switchover ,

Fix the network connectivity from failed unit
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Minor

Cleared

8.1.4.2

Trap
OID
Description

Default
Severity

Source
Varbind Text

HA feature is
active and the
redundant
module is in
startup mode
and hasn’t
connected yet

HA system is -
active

Waiting for redundant to connect
(applicable only to Mediant 3000)

HA System Configuration Mismatch Alarm

Corrective action is not required.

Table A-40: acHASystemConfigMismatchAlarm

acHASystemConfigMismatchAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.34

Sent when the configuration of the modules in the HA system is not identical, causing instability.

Major

System#0/Module#<m>, where m is the blade module’s slot number

Event Type processingErrorAlarm

Probable configurationOrCustomizationError

Cause

Alarm_ Condition <text> Corrective Action

Severity

Major HA feature is active: Configuration mismatch in the system: | The actions for the conditions are

described below.

License Keys of Active Active and Redundant modules have Update the Feature Keys of the Active
and Redundant modules | different feature keys. and Redundant modules.
are different.
The Active module was Fail to update the redundant with Replace the Feature Key of the
unable to pass on to the | feature key. Redundant module — it may be
Redundant module the invalid.
License Key.
License key of the Feature key did not update in redundant A Replace the Feature Key of the
Redundant module is module. Redundant module — it may be
invalid. invalid.

Cleared Successful License Key The feature key was successfully -
update updated in the redundant module
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8.1.4.3 HA System Switch Over Alarm
Table A-41: acHASystemSwitchOverAlarm

Trap

OID

Description
Default Severity

Source Varbind
Text

Event Type
Probable Cause
Alarm Severity

Critical

Cleared

acHASystemSwitchOverAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.35

Sent when a switchover from the active to the redundant module has occurred.

Critical

System#0/Module#<m>, where m is the blade module’s slot number

qualityOfServiceAlarm

outOfService

Condition

<text> Corrective Action

A switchover from the active | Switch-over: See the

to the redundant unit has

occurred

acHASystemFaultAlarm
table above

10 seconds have passed - -
since the switchover

A.1.16 Device (Board) Alarms

The source varbind text for all the alarms under this component depends on the device:
B 3000 Series: Board#0<n>
B All other devices: System#0<n>

Where n is the slot number in which the blade resides in the chassis. For Mediant 1000
and MediaPack, n always equals to 1.

A.1.16.1

Alarm

OID

Description
Default Severity
Event Type
Probable Cause
Alarm Severity

Critical

Fatal Error Alarm

Table A-42: acBoardFatalError

acBoardFatalError

1.3.6.1.4.1.5003.9.10.1.21.2.0.1

Sent whenever a fatal device error occurs.

Critical

equipmentAlarm

underlyingResourceUnavailable (56)

Condition

Any fatal error

<text> Corrective Action

Board Fatal Error: A run-time | 1.
specific string describing the

Capture the alarm information and the
Syslog clause, if active.

fatal error 2. Contact AudioCodes' Support Center at
Stays 'Critical' until | After fatal error - support@ audiocodes.com which will want
reboot. A 'Clear' to collect additional data from the device
trap is not sent. and perform areset.
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A.1.16.2 Configuration Error Alarm

Table A-43: acBoardConfigurationError

Alarm acBoardConfigurationError
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.2
Description
the invalid setting.
Default Severity Critical
Event Type equipmentAlarm

Probable Cause
Alarm Severity Condition

Critical A configuration

Stays 'Critical' until | After configuration | -
reboot. A 'Clear’ error
trap is not sent.

A.1.16.3 Temperature Alarm

underlyingResourceUnavailable (56)
<text>

Board Config Error: A run-
error was detected | time specific string describing
the configuration error

Sent when the device's settings are invalid. The trap contains a message stating/detailing/explaining

Corrective Action

1. Check the run-time specific string to
determine the nature of the configuration
error.

2. Fix the configuration error using the
appropriate tool: Web interface, EMS, or ini
file.

3. Save the configuration and if necessary
reset the device.

Table A-44: acBoardTemperatureAlarm

Alarm acBoardTemperatureAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.3
Description

Source System#0
Varbind Text

Sent when the device exceeds its temperature limits. Applies only to 2000 and 3000 Series devices.

Event Type equipmentAlarm
Probable ® The air filter is saturated.
Cause = One of the fans work slower than expected.
temperatureUnacceptable (50)
Alarm_ Condition <text> Corrective Action
Severity
Critical Temperature is above 60°C | Board temperature 1. Check that the ambient environment around the
(140°F) too high chassis was not changed (room temperature, air-
For Mediant 3000: conditioner, and location of the chassis on the
Fans at High speed - site). If the ambient environment is the same,
check your ventilation make sure that all unoccupied module slots are
outlet and covered with blank panels.
environment 2. Clean the air filter — refer to the Hardware
temperature. Installation Manual on how to clean/replace the
air filter.
3. If after cleaning the air filter the alarm still exists:
Check if all fans in the system are properly
operating.
For Mediant 3000: Check if you also received a Fan
Tray alarm, which indicates that one or more fans in
the Fan Tray are faulty (major). If this is the case,
send the faulty Fan Tray to AudioCodes as RMA.
For Mediant 1000: Send an RMA request to
AudioCodes for the Fan Tray.
Cleared Temperature falls below 55°C| - -
(131°F)
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A.1.16.4 Software Reset Alarm

Table A-45: acBoardEvResettingBoard

Alarm acBoardEvResettingBoard

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.5

Description Sent after the device resets.

Default Critical

Severity

Event Type equipmentAlarm

Probable outOfService (71)

Cause
Alarm Severity Condition <text> Corrective Action
Critical When a soft reset is triggered User resetting

via the Web interface or SNMP | board

Stays ‘Critical’ After raise A n_etwork admi_nistrat_or h_as taken a_ction toreset the
until reboot. A device. Corrective action is not required.
'Clear' trap is

not sent.

8.1.4.3.1 Software Upgrade Alarm
Table A-46: acSWUpgradeAlarm

Alarm acSWUpgradeAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.70

Description Sent for software upgrade process errors.

Default Major

Severity

Alarms System#0

Source

Event Type processingErrorAlarm

Probable softwareProgramError

Cause
Alarm Severity Condition <text> Corrective Action
Major Raised upon software SW upgrade error: Start up the system from BootP/TFTP.

upgrade errors Firmware burning

failed. Startup system
from Bootp/tftp.
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A.1.16.5 Call Resources Alarm

Table A-47: acBoardCallResourcesAlarm

Alarm acBoardCallResourcesAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.8
Description Sent when no free channels are available.
Default Major
Severity
Event Type processingErrorAlarm
Probable softwareError (46)
Cause
Alarm Severity Condition <text> Corrective Action
Major Percentage of busy Call resources alarm | ® Expand system capacity by adding more channels
channels exceeds the (trunks)
predefined RAI high -OR-
threshold = Reduce traffic
Cleared Percentage of busy - Note that to enable this alarm, the Remote Alarm
channels falls below the Indication (RAI) mechanism must be activated
predefined RAI low (EnableRAI = 1).
threshold

A.1.16.6 Controller Failure Alarm

Table A-48: acBoardControllerFailureAlarm

Alarm acBoardControllerFailureAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.9
Description = Sent when the Proxy is not found or registration fails. Internal routing table may be used for routing.

= Sent when the physical network link is up or down ("BusyOut Trunk/Line n Link failure").

" GWAPP_TRAP_BUSYOUT_CONNECTIVITY: Sent when the connection to the Proxy is up or down
("BusyOut Trunk/Line n Connectivity Proxy failure").

"= GWAPP_TRAP_BUSYOUT_TDM_OVER_IP: Sent when a failure occurs in TDM over IP
(transparent T1/E1 without signaling) - "BusyOut Trunk n TDM over IP failure (Active calls x Min y)".
(Note: Applicable only to Digital Series.)

= GWAPP_TRAP_BUSYOUT_PROXY_SET: Sent when the connection to the Proxy Set associated
with this trunk/line is up/down ("BusyOut Trunk/Line n Proxy Set Failure").

= GWAPP_TRAP_BUSYOUT_REGISTRATION: Sent when a failure occurs in server registration for
this trunk/line ("BusyOut Trunk/Line n Registration Failure").

= GWAPP_TRAP_BUSYOUT_SERVING_IPGROUP: Sent when a failure occurs in a Serving IP
Group for this trunk ("BusyOut Trunk n Serving IP Group Failure").

(Note: Applicable only to Digital Series.)

" GWAPP_TRAP_PROXY_SET: Sent when a failure occurs in a Proxy Set (not per trunk/line, but per

Proxy Set) - "Proxy Set ID n".

Default Major

Severity

Event Type processingErrorAlarm
Probable softwareError (46)
Cause
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Alarm acBoardControllerFailureAlarm
Alarm Severity Condition <text> Additional Information
Major Proxy has not been found or | Controller failure alarm: = Check the network layer
the physical network linkis ' proyy not found. Use internal | ®  Make sure that the proxy IP and port are
up or down ("BusyOut routing. configured correctly.
Trunk/Line n Link failure"). _OR-

Proxy lost. Looking for
another Proxy.

Cleared Proxy is found. The 'Cleared’ | - -
message includes the IP
address of this Proxy.

A.1.16.7 Board Overload Alarm
Table A-49: acBoardOverloadAlarm

Alarm acBoardOverloadAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.11
Description Sent when there is an overload in one or some of the system's components.
Default Major
Severity
Event Type processingErrorAlarm
Probable softwareError (46)
Cause
Alarm Severity Condition <text> Corrective Action
Major An overload condition exists | "System CPU overload 1. Make sure that the syslog level is 0 (or
in one or more of the system | condition - IdleUtilization not high).
—ond”
components percentage. %od 2. Make sure that DebugRecording is not
Where %d is the percentage running.
of available CPU resources . )
remaining 3. Ifthe system is configured correctly,
reduce traffic.
Cleared The overload condition “System CPU overload -
passed condition - IdleUtilization

percentage=%"

A.1.16.8 Feature Key Error Alarm
Table A-50: acFeatureKeyError

Alarm acFeatureKeyError

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.6
Description Sent to relay Feature Key errors etc.
Default Severity Critical

Event Type processingErrorAlarm

Probable Cause configurationOrCustomizationError (7)
Alarm Text Feature key error

Status Changes

Note Support for this alarm is pending.
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A.1.16.9 Missing SA/M3K Blade (Alarm, Status and Synchronization) Alarm

Note: Applicable only to Mediant 3000.

Table A-51: acSAMissingAlarm

Alarm acSAMissingAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.32

Description Sent when the Shelf Alarm (SA) module is missing or non operational.
Default Critical

Severity

Source Chassis#0/SA#<m>, where m is the shelf Alarm module’s slot number

Varbind Text

Event Type equipmentAlarm

Probable underlyingResourceUnavailable

Cause
Alarm Severity Condition <text> Corrective Action
Critical SA module removed or missing SA Module Alarm. SA-Module | ®= Reinsert the Shelf Alarm

from slot #n is missing. (SA) module into slot #n
= Make sure it's correctly
inserted in the slot.

Cleared SA module is in slot 2 or 4 and working. | - -

A.1.16.10 Administration Status Change Alarm
Table A-52: acgwAdminStateChange

Alarm acgwAdminStateChange
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.7
Description Sent when Graceful Shutdown commences and ends.
Default Major
Severity
Event Type processingErrorAlarm
Probable outOfService (71)
Cause
Alarm Severity Condition <text> Corrective Action
Major Admin state changed to shutting down | Network element = No corrective action is required.
admin state change | = A network administrator took an
alarm: Gateway is action to gracefully lock the device.
shutting down. No
time limit.
Major Admin state changed to locked Locked = No corrective action is required.
= A network administrator took an
action to lock the device, or a
graceful lock timeout occured.
Cleared Admin state changed to unlocked - = No corrective action is required.

= A network administrator has taken
an action to unlock the device.
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A.1.16.11 Operational Status Change Alarm

Alarm
QOID

Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Major

Cleared

Table A-53: acOperationalStateChange

acOperationalStateChange
1.3.6.1.4.1.5003.9.10.1.21.2.0.15

Sent if the operational state of the node goes to disabled; cleared when the operational state of the node
goes to enabled.

Major

processingErrorAlarm

outOfService (71)

Condition <text> Corrective Action

The alarm is cleared when the
operational state of the node goes to
enabled.

= InIP systems, check for initialization
errors - in IP systems the operational
state of the node is disabled if the
device fails to properly initialize.

= Look for other alarms and Syslogs
that might provide additional
information about the error.

Operational state changed to
disabled

Network element operational -
state change alarm. Operational
state is disabled.

Operational state changedto | - -
enabled

A.1.17 Network Alarms

A.1.17.1 Ethernet Link Alarm

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Major

Critical

Table A-54: acBoardEthernetLinkAlarm

acBoardEthernetLinkAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.10
Sent when the Ethernet link(s) is down.

Critical

All except 3000 Series: Board#<n>/EthernetLink#0 (where n is the slot number)

3000 Series: Chassis#0/Module#<n>/EthernetLink#0 (where n is the blade's slot number)

This trap relates to the Ethernet Link Module (the #0 numbering doesn't apply to the physical Ethernet
link).

equipmentAlarm

underlyingResourceUnavailable (56)

Condition <text> Corrective Action

Ethernet link alarm: 1.
Redundant link is down

Ensure that both Ethernet cables
are plugged into the back of the
system.

2. Observe the system’s Ethernet link
lights to determine which interface
is failing.

3. Reconnect the cable or fix the
network problem

Fault on single interface

Fault on both interfaces No Ethernet link
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Cleared Both interfaces are - Note that the alarm behaves differently
operational when coming from the redundant or the

active modules of a High Availability
(HA) system. The alarm from the
redundant is raised when there is an
operational HA configuration in the
system. There is no critical severity for
the redundant module losing both its
Ethernet links as that is conveyed in the
no HA alarm that follows such a case.

A.1.17.2 Ethernet Group Alarm

Note: Applicable only to Mediant 500 GW & E-SBC, Mediant 800B GW & E-SBC, and
Mediant 1000B GW & E-SBC.

Table A-55: acEthernetGroupAlarm

Alarm acEthernetGroupAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.86

Description This alarm is raised when both ports in an Ethernet port-pair group (1+1) are down, and
cleared when at least one port is up.

Default Severity Major

Event Type equipmentAlarm

Probable Cause underlyingResourceUnavailable

Alarm Text Ethernet Group alarm. %s

Status Changes
1. Condition Raised when both ports in a group are down

2. Condition Cleared when at least one port is up

A.1.17.3 WAN Link Alarm
Table A-56: acBoardWanLinkAlarm (only for MSBR Series)

Alarm acBoardWanLinkAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.79

Description This alarm is raised when the WAN Link is down (and cleared when link is up again).
Default Major / Clear

Severity

Event Type equipmentAlarm

Source Board#x/WanLink#y

Varbind Text

Probable underlyingResourceUnavailable

Cause
Alarm Severity Condition <text> Corrective Action
Major WAN link down - Connect the WAN port
Clear WAN link up - -
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A.1.17.4 Data Interface Status Alarm

Note: Applicable only to MSBR series.

Table A-57: acDatalnterfaceStatus

Alarm
QOID

Default Severity

Event Type
Probable Cause
Alarm Text
Status Changes
1. Condition
Alarm Status

<text> Value

Corrective Action

acDatalnterfaceStatus
1.3.6.1.4.1.5003.9.10.1.21.2.0.83

Indeterminate

communicationsAlarm

A.1.17.5 Wireless Cellular Modem Alarm

No corrective action is required as this is an event, not an alarm.

Note: Applicable only to Mediant 500 MSBR and Mediant 800B MSBR.

Alarm
QOID

Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Major

Clear

Table A-58: acWirelessCellularModemAlarm

acWirelessCellularModemAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.82

This alarm is raised when either the wireless modem is down or in backup mode, and cleared when

modem is up.

Major / Clear

Board#x/WanLink#y

equipmentAlarm

underlyingResourceUnavailable

Condition <text>

Raised when either the WAN wireless cellular modem
wireless modem is down or in | alarm

backup mode, and cleared

when modem is up.

WAN link up -

Corrective Action

Get the link up. Investigate the possibility
of an electronics failure or a problem
with the radio frequency (RF) path.
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A.1.17.6 NTP Server Status Alarm

Alarm
QOID

Description

Default
Severity

Event Type

Probable
Cause

Alarm Severity

Major

Minor

Table A-59: acNTPServerStatusAlarm

acNTPServerStatusAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.71

NTP server status alarm. Raised when the connection to the NTP server is lost. Cleared when the
connection is reestablished. Unset time (as a result of no connection to NTP server) may result with

functionality degradation and failure in device.

Major

communicationsAlarm

communicationsSubsystemFailure

Condition <text>

No initial communication to Network | NTP server alarm. No

Time Protocol (NTP) server. connection to NTP server.

No communication to NTP server -
after the time was already set once.

A.1.17.7 NAT Traversal Alarm

Alarm
QOID

Description

Default Severity
Event Type
Probable Cause
Alarm Text

Status Changes

Table A-60: acNATTraversalAlarm

acNATTraversalAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.17

Corrective Action

Repair NTP communication (the NTP
server is down or its IP address is
configured incorrectly in the device).

Sent when the NAT is placed in front of a device and is identified as a symmetric NAT. It is
cleared when a non-symmetric NAT or no NAT replace the symmetric one.

Indeterminate

other (0)

NAT Traversal Alarm

The STUN client in the device is enabled and has either identified a NAT or is not finding

the STUN server.

Keep-alive is sent out every 9/10 of the time defined in the 'NatBindingDefaultTimeout'

parameter.

Corrective Action See http://tools.ietf.org/html/rfc5389
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A.1.17.8 LDAP Lost Connection Alarm

Alarm

OID

Default Severity
Event Type

Probable Cause

Alarm Text
Status Changes
1. Condition

Alarm Status

Table A-61: acLDAPLostConnection

acLDAPLostConnection
1.3.6.1.4.1.5003.9.10.1.21.2.0.75
Minor

communicationsAlarm

communicationsSubsystemFailure

If a connection is idle for more than the maximum configured time in seconds that the
client can be idle before the LDAP server closes the connection, the LDAP server returns
an LDAP disconnect notification and this alarm is raised.

LDAP Lost Connection

This alarm is raised when there is no connection to the LDAP server

A.1.17.9 OCSP Server Status Alarm

Alarm

OID

Default Severity
Event Type
Probable Cause

Alarm Text

Corrective Action

Table A-62: acOCSPServerStatusAlarm

acOCSPServerStatusAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.78
Major / Clear
communicationsAlarm
communicationsSubsystemFailure
OCSP server alarm

=  Repalir the Online Certificate Status Protocol (OCSP) server
-OR-
=  Correct the network configuration
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A.1.17.10IPv6 Error Alarm

Alarm
QOID

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Critical

Stays 'Critical'
until reboot.

A 'Clear' trap is
not sent.

Table A-63: aclPv6ErrorAlarm (Applicable only to E-SBC Series)

aclPv6ErrorAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.53

Critical

System#0/Interfaces#<n>.

operationalViolation

communicationsProtocolError

Condition

Bad IPv6 address (already
exists)
disabled.

After the alarm is raised. -

A.1.17.11 Active Alarm Table Alarm

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

<text>

IP interface alarm: IPv6 .
configuration failed, IPv6 willbe '«

Corrective Action

Find a new IPV6 address.
Reboot the device.

Table A-64: acActiveAlarmTableOverflow

acActiveAlarmTableOverflow

1.3.6.1.4.15003.9.10.1.21.2.0.12

Sent when an active alarm cannot be entered into the Active Alarm table because the table is full.

Major

System#0<n>/AlarmManager#0

processingErrorAlarm

resourceAtOrNearingCapacity (43)

Condition <text>

Corrective Action

Major Too many alarms to fit | Active alarm table = Some alarm information may be lost but the ability of
in the active alarm overflow the device to perform its basic operations is not
table impacted.

= Avreboot is the only way to completely clear a
problem with the active alarm table.

=  Contact AudioCodes' Support Center at
support@audiocodes.com

Remains After the alarm is - Note that the status remains 'Major' until reboot as it

'Major" until raised denotes a possible loss of information until the next

reboot. A reboot. If an alarm is raised when the table is full, it is

'Clear' trap is possible that the alarm is active, but does not appear in

not sent. the active alarm table.
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A.1.17.12 Audio Staging from APS Server Alarm

A\

Note: Applicable only to Mediant 1000B series.

Alarm
OID
Description

Default
Severity

Source
Varbind Text

Event Type

Probable
Cause

Alarm Severity

Critical

Cleared

Table A-65: acAudioProvisioningAlarm

acAudioProvisioningAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.14

Sent if the device is unable to provision its audio.

Critical

System#0/AudioStaging#0

processingErrorAlarm

configurationOrCustomizationError (7)

Condition <text>

Media server times out | Unable to provision
waiting for a audio

successful audio

distribution from the

APS (Audio

Provisioning Server)

After the alarm is -
raised, the media

server is successfully
provisioned with audio
from the APS

Corrective Action

From the Audio Provisioning Server (APS)
GUI, ensure that the device is properly
configured with audio and that the device
has been enabled.

Ensure that the IP address for the APS
has been properly specified on the device.
Ensure that both the APS server and
application are in-service.

For more information regarding the
problem, view the Syslogs from the device
as well as the APS manager logs.
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A.1.18 Analog Port Alarms

Note: These alarms are applicable only to Analog Series.

A.1.18.1 Analog Port SPI Out-of-Service Alarm
Table A-66: acAnalogPortSPIOutOfService

Alarm acAnalogPortSPIOutOfService
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.46
Default Severity Major
Source Varbind Text System#0/analogports#<n>, where n is the port number
Event Type physicalViolation
Probable Cause equipmentMalfunction
Alarm Severity Condition <text> Corrective Action
Major Analog port has gone out of Analog Port SPI out of service | ® No corrective action is
service required.
= The device shuts down the
port and activates it again
when the Serial Peripheral
Interface (SPI) connection
returns.
Cleared Analog port is back in service - -
A.1.18.2 Analog Port High Temperature Alarm
Table A-67: acAnalogPortHighTemperature
Alarm acAnalogPortHighTemperature
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.47
Default Severity Major
Source Varbind Text System#0/analogports#<n>, where n is the port number
Event Type physicalViolation
Probable Cause equipmentMalfunction
Alarm Severity Condition <text> Corrective Action
Major Analog device has reached Analog Port High Temperature | ® No corrective action is
critical temperature. Device is required.
automatically disconnected. = The device shuts down the
analog port and tries to
activate it again later when
the device's temperature
drops.
Cleared Temperature is back to normal | - -

- analog port is back in service.
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A.1.18.3 Analog Port Ground Fault Out-of-Service Alarm

Table A-68: acAnalogPortGroundFaultOutOfService

Alarm acAnalogPortGroundFaultOutOfService

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.76

Default Severity Major / Clear

Source Varbind Text System#0/analogports#<n>, where n is the port number

Event Type physicalViolation

Probable Cause equipmentMalfunction (this alarm is raised when the FXS port is inactive due to a ground fault)
Alarm Text Analog Port Ground Fault Out Of Service

Corrective Action = No corrective action is required.

=  The device shuts down the port and tries to activate it again when the relevant alarm is over.

Note Relevant to FXS only.

A.1.19 Media Alarms

A.1.19.1 Media Process Overload Alarm

Note: This alarm is applicable only to the MSBR series, Mediant 1000B GW & SBC,
Mediant 2000, and Mediant 3000.

Table A-69: acMediaProcessOverloadAlarm

Alarm acMediaProcessOverloadAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.81
Description Sent when there is overload of the device’s media processing and interfaces.
Default Severity Major
Event Type environmentalAlarm
Probable Cause underlyingResourceUnavailable
Alarm Severity Condition <text> Corrective Action
Major - Media Process Overload Alarm. %s = Avoid making new calls.
Although not corrective, this action
eventually causes the alarm to
drop.
Cleared - - None
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A.1.19.2 Media Realm Bandwidth Threshold Alarm

A Note: This alarm is applicable only to Digital Series and E-SBC Series.

Alarm

OID

Default Severity

Event Type

Probable Cause
Alarm Severity

Major

Table A-70: acMediaRealmBWThresholdAlarm

acMediaRealmBWThresholdAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.87

ProcessingErrorAlarm

Raised when a bandwidth threshold is crossed

Condition <text> Corrective Action

- Media Realm BW Threshold Alarm Cleared when bandwidth threshold

returns to normal range

A.1.20 Network Monitoring (Probe) between Devices

A Note: This alarm is applicable only to Mediant 800B MSBR.

A.1.20.1 NQM Connectivity Alarm

Alarm

OID

Default Severity
Alarm Source
Event Type

Probable Cause

Table A-71: acNgmConnectivityAlarm

acNgmConnectivityAlarm

1.3.6.1.4.1.5003.9.10.1.21.2.0.88

Board#%d/NgmSender#%d
communicationsSubsystemFailure

Raised when Connectivity with NQM probe destination is lost

Alarm Severity Condition <text> Corrective Action
Minor Connectivity with NQM probe Cleared when connectivity with the
destination is lost Noise Quality Measure (NQM) probe
destination is re-established
SCOM
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A.1.20.2 NQM High RTT Alarm

Table A-72: acNgmRttAlarm

Alarm acNgmRttAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.89

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type communicationsSubsystemFailure

Probable Cause Raised when Detected high RTT towards NQM probe destination
Alarm Severity Condition <text> Corrective Action

Minor - Detected high RTT towards NQM To correct long RTT (Round Trip Time):

probe destination = Test with traceroute.

= Contact your ISP with the
traceroute results.

= Use Wireshark or any other
diagnostic tool to perform a traffic
capture and determine who is
contaminating the network.

A.1.20.3 NQM High Jitter Alarm

Table A-73: acNgmJitterAlarm

Alarm acNgmJitterAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.90

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type CommunicationsAlarm

Probable Cause Raised when Detected high Jitter towards NQM probe destination - thresholdCrossed
Alarm Severity Condition <text> Corrective Action
Minor - Detected high Jitter towards NQM To correct high jitter:

probe destination = Test with traceroute.

=  Contact your Internet Service
Provider (ISP) with traceroute
results.

= |mplement Quality of Service
(Qos).
= Note that there's no simple solution

for high jitter. A systemic level
solution may be required.
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A.1.20.4 NQM High Packet Loss Alarm
Table A-74: acNgmPacketLossAlarm

Alarm acNgmPacketLossAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.91

Default Severity

Alarm Source Board#%d/NgmSender#%d
Event Type CommunicationsAlarm
Probable Cause Raised when Detected high Packet Loss towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected high PL towards NQM probe | To correct high packet loss (PL):
destination

= Eliminate interference problems:
Distance your modem from
electrical devices

= Do not coil up any excess signal or
power cables.

= Check the statistics counters of
network nodes to determine where
loss is occurring. Typically, each
node in the network has a packet
loss counter. Isolate the network
segment where loss has been

occurring.
A.1.20.5 NQM Low Conversational MOS Alarm
Table A-75: acNgmCqgMosAlarm

Alarm acNgmCgMosAlarm

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.95

Default Severity

Alarm Source Board#%d/NgmSender#%d

Event Type communicationsAlarm

Probable Cause Raised when Detected low conversational voice quality towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected low conversational voice To fix the Noise Quality Measure

quality towards NQM probe destination | (NQM) result:

= Perform corrective action for jitter.
See Section A.1.20.3.

= Perform corrective action for Real
Time Protocol (RTP) packet loss.
See Section A.1.20.4.

=  Perform corrective action for long
Round-Trip Time (RTT) - the time it
takes for packets to travel from
source to destination.
See Section A.1.20.2.

To fix the poor Conversational Quality
(CQ) that the test indicates:

=  Try changing the coder
=  Try using RTP-Redundancy

= Perform corrective action for RTP
packet loss.
See Section A.1.20.4.
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A.1.20.6 NQM Low Listening MOS Alarm
Table A-76: acNgmLgMosAlarm

Alarm acNgmLgMosAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.96

Default Severity

Alarm Source Board#%d/NgmSender#%.d
Event Type communicationsAlarm
Probable Cause Raised when detected low listening voice quality towards NQM probe destination
Alarm Severity Condition <text> Corrective Action
Minor - Detected low listening voice quality To fix the Noise Quality Measure
towards NQM probe destination (NQM) result:

= Perform corrective action for Real
Time Protocol (RTP) packet loss.

See Section A.1.20.4.

To fix the poor listening quality that the
test indicates:

=  Try changing the coder
=  Try using RTP-Redundancy

= Perform corrective action for RTP
packet loss.

See Section A.1.20.4.

A.1.21 Intrusion Detection Alarms

A.1.21.1 IDS Policy Alarm
Table A-77: acIDSPolicyAlarm

Alarm aclDSPolicyAlarm
OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.99

e The alarm is raised whenever a threshold is crossed in the IDS system.
Description

The alarm is associated with the MO pair IDSMatch & IDSRule.

Default Severity
Event Type Other
Probable Cause

Policy NUM (NAME) minor/major/critical threshold (NUM) of REASON cross in

AT T global/ip/ip+port scope (triggered by IP)

Status Changes

1. Identify additional traps (acIDSThresholdCrossNotification) that were sent
alongside this Intrusion Detection System (IDS) alarm.

2. Locate the remote hosts (IP addresses) that are specified in the traps.

Corrective Action 3. Examine the behavior of those hosts (with regard to the reason specified in the
alarm), and attempt to fix incorrect operation.

4. If necessary, change the configured thresholds in the IDS Rule table under the
IDS Policy table.
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A.1.22 SAS Alarms

A.1.22.1 Emergency Mode Alarm
Table A-78: acGWSASEmergencyModeAlarm

Alarm

OID

Description

Default Severity
Event Type
Probable Cause

Alarm Text

Status Changes

Corrective Action

acGW SASEmergencyModeAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.59

Sent by the Stand-Alone Survivability (SAS) application when switching from “Normal”
mode to “Emergency" mode. This alarm is cleared once the SAS returns to “Normal"
mode.

Note: Applicable only to Analog and Digital Series.

Other

Other

Sent by the Stand-Alone Survivability (SAS) application when switching from 'Normal'
mode to 'Emergency' mode. The alarm is cleared once the SAS returns to 'Normal'
mode.

= This alarm is only for informative purposes.
= No corrective action is required.

A.1.23 High-Availability (HA)

Note: These SNMP events are applicable only to devices that support the High-
Availability (HA) feature.

A.1.23.1 Redundant Board Trap

Trap
OID

Description

Default Severity

Table A-79: acRedundantBoardAlarm

acRedundantBoardAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.97

Active board sends notification when an alarm or notification is raised in the redundant
board.

Indeterminate

Event Type Other (0)
Probable Cause Other (0)
Condition Alarm or notification is raised in the redundant board
Trap Text
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A.1.23.2 HA Network Watchdog Status Alarm

3000.

Note: This SNMP event is applicable to all HA-supporting devices except Mediant

Table A-80: acHANetworkWatchdogStatusAlarm

Trap
OID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Trap Text

Failed sending ping

Network watchdog is disabled
while HA priority is in use

Network watchdog is disabled
while Redundant units has
less Eth groups available

Disabling network watchdog
due to network interface error
in Redundant unit

acHANetworkW atchdogStatusAlarm
1.3.6.1.4.1.5003.9.10.1.21.2.0.98

This alarm indicates that the device's HA Network Reachability (network watchdog)
feature is configured, but is not functioning correctly due to, for example, the Ethernet
Group being down from where the ping is sent to the network entity.

The device's HA Network Reachability feature is used to configure a network IP address
to test reachability using pings. When the tested peer stops replying to the Active unit, a
switchover is made to the Redundant unit. For configuring the HA Network Reachability
feature, refer to the User's Manual.

Major
System#0/Module#<m>, where m is the blade module’s slot number
alarmTrap
outOfService
Condition Corrective Action

Some network configuration error -

When HA Priority is in use, the network -
watchdog module is disabled

One or more of the Redundant unit's Ethernet | -
Groups are down

One or more of the Redundant unit's Ethernet | -
Groups are down
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A.1.23.3 Hitless Software Upgrade Status Trap

Note: Applicable only to Mediant 500 E-SBC, Mediant 800B Gateway & E-SBC,
Mediant 3000, Mediant 2600 E-SBC, Mediant 4000 SBC, Mediant 9000 SBC, and
Mediant Software SBC.

Alarm

OID
Description

Default Severity
Event Type
Probable Cause
Source

Trap Text

"Hitless: Start software
upgrade.”

"Hitless: SW upgrade
ended successfully."

"Hitless: Invalid cmp file -
missing Ver parameter."

"Hitless fail: SW ver
stream name too long."

Note: Applicable only to
Mediant 3000.

"Hitless fail: Invalid cmp
file - missing UPG
parameter.”

"Hitless fail: Hitless SW
upgrade not supported."

Table A-81: acHitlessUpdateStatus

acHitlessUpdateStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.48

A notification trap sent at the beginning and end of a Hitless Software Upgrade. Failure during
the software upgrade also activates the trap.

Indeterminate

Other (0)

Other (0)

Automatic Update
Condition

Hitless Upgrade has begun.

Successful Hitless Upgrade.

Hitless Upgrade failed because the
cmp file is invalid. The cmp file’s
version parameter is incorrect.

Hitless Upgrade failed because the
cmp file is invalid. The number of
characters defining the software
version stream name in the cmp file
has been exceeded.

Hitless Upgrade failed because the
cmp file is invalid. An upgrade
parameter is missing from the file.

Hitless Upgrade failed because the
cmp file is invalid. The cmp file does
not support Hitless Upgrade of the
current software version to the new
software version.

Corrective Action

Corrective action is not required

Corrective action is not required

Replace the cmp file with a valid one.

Replace the cmp file with a valid one

Replace the cmp file with a valid one.

Replace the cmp file with a valid one that supports hitless
upgrade of the software from the current version to the

new one.
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A.2  Event Traps (Notifications)

This subsection details traps that are not alarms. These traps are sent with the severity
varbind value of ‘Indeterminate’. These traps don’t ‘Clear’ and they don’t appear in the
alarm history or active tables. (The only log trap that does send 'Clear is
acPerformanceMonitoringThresholdCrossing).

A.2.1 IDS Threshold Cross Notification
Table A-82: acIDSThresholdCrossNotification

Alarm

OID

Description
Description
Default Severity
Event Type
Probable Cause
Alarm Text

Status Changes

Corrective Action

A.2.2

Alarm

OID

Description
Default Severity
Event Type

Probable Cause
Alarm Text

Status Changes

Corrective Action

acIDSThresholdCrossNotification
1.3.6.1.4.1.5003.9.10.1.21.2.0.100
Sent for each scope (IP or IP+Port) crossing a threshold of an active alarm.

The trap is sent for each scope (IP or IPport) crossing a threshold of an active alarm.

Other

Threshold cross for scope value IP. Severity=minor/major/critical. Current value=NUM

1. Identify the remote host (IP address / port) on the network which the Intrusion
Detection System (IDS) has indicated is malicious.

Note that the IDS determines a host to be malicious if it has reached or exceeded
a user-defined threshold of malicious attacks (counter).

2. Block the malicious activity.

IDS Blacklist Notification

Table A-83: acIDSBlacklistNotification

aclDSBIlacklistNotification

1.3.6.1.4.1.5003.9.10.1.21.2.0.101

securityServiceOrMechanismViolation
thresholdCrossed

Added IP * to blacklist
Removed IP * from blacklist

Identify the malicious remote host (IP address / port) that the Intrusion Detection
System (IDS) has automatically blacklisted or removed from the blacklist.

Note that a host is determined to be malicious if it has reached or exceeded a user-
defined threshold of malicious attacks (counter). The malicious source is automatically
blacklisted for a user-defined period, after which it is removed from the blacklist.
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A.2.3 Web User Access Denied due to Inactivity Trap

Alarm

OID

Default Severity
Event Type
Probable Cause
Alarm Text

Status Changes

Corrective Action

A.2.4

Table A-84: acWebUserAccessDisabled

acWebUserAccessDisabled
1.3.6.1.4.1.5003.9.10.1.21.2.0.93

Indeterminate

Sent when Web user was disabled due to inactivity

Contact your Web security administrator. Only the Web security administrator can
unblock a user whose access to the Web interface was denied (for example, because
the user made 3 unsuccessful attempts at access).

The Web security administrator must:

1. Inthe Web interface, access the Accounts page (Configuration > System >
Management > Web User Accounts).

2. Identify in the list of users table that user whose access has been denied.
3. Change the status of that user from Blocked to Valid or New.

Power-Over-Ethernet Status Trap

Note: This alarm is applicable only to Mediant 800B MSBR.

Trap

OID

Description
Default Severity
Event Type
Probable Cause

Trap Text

Condition

Trap Status

Table A-85: acPowerOverEthernetStatus

acPowerOverEthernetStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.80

Sent when Power over Ethernet (PoE) for a specific port is disabled.
Indeterminate

environmentalAlarm

underlyingResourceUnavailable

“POE Port %d Was Not Powered Due To Power Management”
where %d is the Ethernet port number

This trap is sent when insufficient power is available for a plugged-in PoE client in a PoE-
enabled LAN port.

Trap is sent
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A.2.5 Keep-Alive Trap

Trap
OID

Description

Default Severity
Event Type
Probable Cause
Trap Text
Status Changes

Condition

Trap Status

Note

Table A-86: acKeepAlive

acKeepAlive
1.3.6.1.4.1.5003.9.10.1.21.2.0.16

Part of the NAT traversal mechanism. If the STUN application in the device detects a
NAT, this trap is sent on a regular time laps - 9/10 of the acSysSTUNBIndingLifeTime
object. The Additionallnfol varbind has the MAC address of the device.

Indeterminate
other (0)
other (0)

Keep alive trap

The STUN client is enabled and identified as a NAT device or doesn’t locate the STUN
server. The ini file contains the following line ‘SendKeepAliveTrap=1’

Trap is sent

Keep-alive is sent every 9/10 of the time defined in the parameter
NatBindingDefaultTimeout.

A.2.6 Performance Monitoring Threshold-Crossing Trap

Trap
OID

Description

Default Severity
Event Type
Probable Cause

Trap Text

Status Changes

Condition

Trap Status
Condition

Trap Status

Table A-87: acPerformanceMonitoringThresholdCrossing

acPerformanceMonitoringThresholdCrossing
1.3.6.1.4.1.5003.9.10.1.21.2.0.27

Sent every time the threshold of a Performance Monitored object (‘Minimum', '‘Average',
'Maximum', 'Distribution below/above/between thresholds', and 'Low and high thresholds')
is crossed. The severity field is 'Indeterminate’ when the crossing is above the threshold
and 'Cleared’ when it goes back under the threshold. The 'Source' varbind in the trap
indicates the object for which the threshold is being crossed.

Indeterminate
other (0)
other (0)

"Performance: Threshold trap was set”, with source = name of performance counter
which caused the trap

A performance counter (for the attributes 'Minimum’, 'Average’, 'Maximum', ‘Distribution
below/above/between thresholds', and 'Low and high thresholds') has crossed the high
threshold.

Indeterminate
A performance counter has returned to under the threshold

Cleared
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A.2.7 HTTP Download Result Trap

Table A-88: acHTTPDownloadResult

Trap acHTTPDownloadResult

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.28

Description Sent upon success or failure of the HTTP Download action.
Default Severity Indeterminate

Event Type processingErrorAlarm (3) for failures and other (0) for success.
Probable Cause other (0)

Status Changes

Condition Successful HTTP download.

Trap Text HTTP Download successful

Condition Failed download.

Trap Text HTTP download failed, a network error occurred.

Note There are other possible textual messages describing NFS failures or success, FTP

failure or success.

A.2.8 Dial Plan File Replaced Trap

Note: This alarm is applicable only to Digital Series.

Table A-89: acDialPlanFileReplaced

Alarm acDialPlanFileReplaced

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.45
Default Severity Indeterminate

Event Type Other (0)

Probable Cause Other (0)

Status Change
Condition Successful dial plan file replacement

Trap Text Dial plan file replacement complete.
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A.2.9 Hitless Software Upgrade Status Trap

Note: This alarm is applicable only to Mediant 3000.

Alarm

OID

Default Severity
Event Type
Probable Cause
Source

Status Changes
Condition

Trap Text

Condition

Trap Text

A.2.10 Secure Shell

Alarm

OID

Default Severity
Event Type

Probable Cause

Alarm Text

Status Changes

Condition
<text> Value

Condition

Table A-90 acHitlessUpdateStatus
acHitlessUpdateStatus

1.3.6.1.4.1.5003.9.10.1.21.2.0.48
Indeterminate

Other (0)

Other (0)

Automatic Update

Successful SW upgrade
Hitless: SW upgrade ended successfully
Failed SW upgrade

Hitless fail: Waiting for module in slot <n> to burn new SW and reboot Timed out. (n —
slot number).

(SSH) Connection Status Trap
Table A-91: acSSHConnectionStatus

acSSHConnectionStatus
1.3.6.1.4.1.5003.9.10.1.21.2.0.77
indeterminate
environmentalAlarm

other

"SSH logout from IP address <IP>, user <user>"
"SSH successful login from IP address <IP>, user <user> at: <IP>:<port>"

"SSH unsuccessful login attempt from IP address <IP>, user <user> at: <IP>:<port>.
<reason>"

"WEB: Unsuccessful login attempt from <IP> at <IP>:<port>. <reason>"

SSH connection attempt

%s — remote IP
%s — user name

SSH connection attempt — success of failure
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A.2.11 SIP Proxy Connection Lost Trap

Table A-92: acProxyConnectionLost

Alarm acProxyConnectionLost

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.94

Description Sent when all connections in a specific Proxy Set are down. The trap is cleared when one
of the Proxy Set connections is up.

Source Varbind Text System#0

Alarm Text Proxy Set Alarm <text>

Event Type communicationsAlarm

Probable Cause = Network issue (connection fail due to network/routing failure).

= Proxy issue (proxy is down).
= AudioCodes device issue.

Alarm Severity

Severity Condition <text>

Major When connection to the Proxy Proxy Set %d: Proxy
Set is lost and this Proxy Setis | not found. Use
configured with fallback to internal routing

routing table.

Major When Proxy Set includes more | Proxy Set %d: Proxy
than one proxy IP with lost. looking for
redundancy and connection to another proxy
one of them is lost.

Cleared When connection to proxy is Proxy found. ip:<IP
available again address>:<port #>
Proxy Set ID %d

Corrective Action

Ping the proxy server. If there is no ping, contact
your proxy provider. The probable reason is the
proxy is down.

Ping between the proxy and AudioCodes device.
If there is no ping, the problem could be a
network/router issue.

If you have more than one device connected to
this same proxy, check if there are more
AudioCodes devices with the same Alarm. If this
is the case, this could confirm that this is not
AudioCodes device issue.

Check that routing using the device's (internal)
routing table is functioning correctly.

Contact AudioCodes support center
(support@audiocodes.com) and send a syslog
and network capture for this issue.

Ping the proxy server. If there is no ping, contact
your proxy provider. The probable reason is the
proxy is down.

Ping between the proxy and AudioCodes device.
If there is no ping, the problem could be a
network/router issue.

If you have more than one device connected to
this same proxy, check if there are more
AudioCodes devices with the same Alarm. If this
is the case, this could confirm that this is not
AudioCodes device issue.

Check if routing via the redundant proxy is
operating correctly. If it is, then this could mean
that it's not a network issue.

Contact AudioCodes support center
(support@audiocodes.com) and send a syslog
and network capture for this issue.
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A.2.12 TLS Certificate Expiry Trap

Table A-93: acCertificateExpiryNotifiaction Trap

Alarm acCertificateExpiryNotifiaction

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.92

Description Sent before (in days) the expiration of the installed certificate credentials, which cannot
be renewed automatically.

Source Varbind Text System#0

Alarm Text environmentalAlarm

Event Type The certificate key expired (keyExpired)

Probable Cause acCertificateExpiryNotifiaction

Alarm Severity
Severity Condition <text> Corrective Action

Intermediate | The certificate | Either: Load a new certificate to the device before the
key_ls aboutto . The device certificate has expired explratlgn of the mstﬁlled certificate (which cannot be
expire. %d days ago -OR- renewed automatically).

" The device certificate will expire | 14 repjace certificates, refer to the section 'Replacing
in %d days -OR- the Device's Certificate’ in the User's Manual.

= The device certificate will expire
in less than 1 day

%d — number of days

A.2.13 Cold Start Trap
Table A-94: coldStart

Trap Name ColdStart

OID 1.3.6.1.6.3.1.1.5.1

MIB SNMPv2-MIB

Note This is a trap from the standard SNMP MIB.

A.2.14 Authentication Failure Trap

Table A-95: authenticationFailure

Trap Name authenticationFailure
OID 1.3.6.1.6.3.1.1.5.5
MIB SNMPv2-MIB
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A.2.15 Board Initialization Completed Trap

Table A-96: acBoardEvBoardStarted

Trap Name acBoardEvBoardStarted

OID 1.3.6.1.4.1.5003.9.10.1.21.2.0.4

Description Sent after the device is successfully restored and initialized following reset.
MIB AcBoard

Severity cleared

Event Type equipmentAlarm

Probable Cause Other(0)

Alarm Text Initialization Ended

Note This is the AudioCodes Enterprise application cold start trap.

A.2.16 Configuration Change Trap

Table A-97: entConfigChange

Trap Name entConfigChange
OID 1.3.6.1.2.1.4.7.2
MIB ENTITY-MIB

A.2.17 Link Up Trap

Table A-98: linkUp

Trap Name linkUp
OID 1.3.6.1.6.3.1.1.5.4
MIB IF-MIB

A.2.18 Link Down Trap

Table A-99: linkDown

Trap Name linkDown
OID 1.3.6.1.6.3.1.1.5.3
MIB IF-MIB
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A.2.19 D-Channel Status Trap

Note: This alarm is applicable only to Digital Series.

Trap Name
OID

Description

MIB

Severity

Event Type
Probable Cause
Alarm Text
Source

Status Changes
Condition

Trap Status
Condition

Trap Status

Table A-100: AcDChannelStatus

acDChannelStatus
1.3.6.1.4.1.5003.9.10.1.21.2.0.37

Non-alarm trap sent at the establishment, re-establishment or release of LAPD link with
its peer connection occurs. The trap is sent with one of the following textual descriptions:

= D-channel synchronized
= D-channel not-synchronized

AcBoard

Minor

communicationsAlarm
communicationsProtocolError
D-Channel Trap.

Trunk <m> where m is the trunk number (starts from 0).

D-Channel un-established.
Trap is sent with the severity of 'Minor'.
D-Channel established.

Trap is sent with the severity of 'Cleared'.
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A.2.20 Enhanced BIT Status

Note: This alarm is not applicable to MSBR.

Alarm
QOID

Description

Default Severity
Source Varbind Text
Event Type
Probable Cause
Alarm Text

Status Changes
Additional Info-1

Additional Info-2

Additional Info-3

Corrective Action

Table A-101: AcDChannelStatus

acEnhancedBIT Status
1.3.6.1.4.1.5003.9.10.1.21.2.0.18

Sent for the status of the BIT (Built In Test). The information in the trap contains blade
hardware elements being tested and their status. The information is presented in the
Additional Info fields.

Indeterminate
BIT

Other

other (0)

Notification on the board hardware elements being tested and their status.

BIT Type: Offline, startup, perodic

BIT Results:

BIT_RESULT_PASSED
BIT_RESULT_FAILED

Buffer: Number of bit elements reports

Not relevant
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B Performance Monitoring Counters

This section lists the supported SNMP PM counters. These counters are polled by the
SCOM at default interval of 15 minutes. In the SCOM, the PM data that is polled from the
AudioCodes devices is represented in the SCOM by the following entities:

B Rules: Each counter is represented by a separate rule. For example, "Attempted Calls
IP2Tel Counter Rule".

B Threshold Monitors: Each counter includes a corresponding pair of threshold
monitors (High Threshold Monitor and a Low Threshold Monitor). For example,
"Attempted Calls IP2Tel High Threshold Monitor" and "Attempted Calls IP2Tel Low
Threshold Monitor"

The SCOM supports the following PM counter groups:
B |P-to-Tel Performance Monitors. See below.

B Tel-to-IP Performance Monitors. See Section B.2 on page 164.
B SBC Performance Monitors. See Section B.3 on page 165.

For more information, see Section 7.5 on page 76.

B.1 IP-to-Tel Performance Monitoring

The table below describes the SIP IP-to-Tel Performance Monitoring counters.

A\

Note: These PM counters are not applicable to Mediant 4000.

Table B-1: SIP IP-to-Tel Performance Monitoring

SCOM Name

Attempted Calls IP2Tel High
Threshold Monitor

Attempted Calls IP2Tel Low
Threshold Monitor

Established Calls IP2Tel High
Threshold Monitor

Established Calls IP2Tel Low
Threshold Monitor

Busy Calls IP2Tel High Threshold
Monitor

Busy Calls IP2Tel Low Threshold
Monitor

No Answer Calls IP2Tel High
Threshold Monitor

No Answer Calls IP2Tel Low
Threshold Monitor

Forwarded Calls IP2Tel High
Threshold Monitor

Forwarded Calls IP2Tel Low
Threshold Monitor

No Route Calls IP2Tel High
Threshold Monitor

Counter (MIB Name)

acPMSIPAttemptedCallsVal

acPMSIPEstablishedCallsVal

acPMSIPBusyCallsVal

acPMSIPNoAnswerCallsVal

acPMSIPForwardedCallsVal

acPMSIPNoRouteCallsVal

Description

Indicates the number of attempted calls for
IP to Tel direction, during last interval.

Indicates the number of established calls for
IP to Tel direction, during last interval.

Indicates the number of calls that failed as a
result of a busy line for IP to Tel direction,
during last interval.

Indicates the number of calls that weren't
answered for IP to Tel direction, during last
interval.

Indicates the number of calls that were
terminated due to a call forward for IP to Tel
direction, during last interval.

Indicates the number of calls whose
destinations weren't found for IP to Tel
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SCOM Name

No Route Calls IP2Tel Low
Threshold Monitor

No Match Calls IP2Tel High
Threshold Monitor

No Match Calls IP2Tel High
Threshold Monitor

No Resources Calls IP2Tel High
Threshold Monitor

No Resources Calls IP2Tel Low
Threshold Monitor

SIPFailCalls IP2Tel High Threshold

Monitor

SIPFailCalls IP2Tel Low Threshold

Monitor

Counter (MIB Name)

acPMSIPNoMatchCallsVal

acPMSIPNoResourcesCallsVal

acPMSIPFailCallsVal

Description

direction, during last interval.

Indicates the number of calls that failed due
to mismatched media server capabilities for
IP to Tel direction, during last interval.

Indicates the number of calls that failed due
to unavailable resources or a media server
lock for IP to Tel direction, during last
interval.

This counter is incremented as a result of
calls that fail due to reasons not covered by
the other counters for IP to Tel direction,
during last interval.

B.2 SIP Tel-to-IP Performance Monitoring

This table below describes the SIP Tel-to-IP PM counters supported by the SCOM.

Note: These PM counters are not applicable to Mediant 4000.

Table B-2: SIP Tel-to-IP Performance Monitoring

SCOM Name

Attempted Calls Tel2IP High
Threshold Monitor

Attempted Calls Tel2IP Low
Threshold Monitor

Established Calls Tel2IP High
Threshold Monitor

Established Calls Tel2IP Low
Threshold Monitor

Busy Calls Tel2IP High Threshold
Monitor

Busy Calls Tel2IP Low Threshold
Monitor

No Answer Calls Tel2IP High
Threshold Monitor

No Answer Calls Tel2IP Low
Threshold Monitor

Forwarded Calls Tel2IP High
Threshold Monitor

Forwarded Calls Tel2IP Low
Threshold Monitor

No Route Calls Tel2IP High
Threshold Monitor

Counter (MIB Name)

acPMSIPAttemptedCallsVal

acPMSIPEstablishedCallsVal

acPMSIPBusyCallsVal

acPMSIPNoAnswerCallsVal

acPMSIPForwardedCallsVal

acPMSIPNoRouteCallsVal

Description

Indicates the number of attempted calls for
Tel to IP direction, during last interval.

Indicates the number of established calls for
Tel to IP direction, during last interval.

Indicates the number of calls that failed as a
result of a busy line for Tel to IP direction,
during last interval.

Indicates the number of calls that weren't
answered for Tel to IP direction, during last
interval.

Indicates the number of calls that were
terminated due to a call forward for Tel to IP
direction, during last interval.

Indicates the number of calls whose
destinations weren't found for Tel to IP
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SCOM Name

No Route Calls Tel2IP Low
Threshold Monitor

No Match Calls High Threshold
Monitor

No Match Calls Low Threshold
Monitor

No ResourcesCalls Tel2IP High
Threshold Monitor

No ResourcesCalls Tel2IP Low
Threshold Monitor

FailCalls Tel2IP High Threshold
Monitor

FailCalls Tel2IP Low Threshold
Monitor

B.3

Counter (MIB Name)

acPMSIPNoMatchCallsVal

acPMSIPNoResourcesCallsVal

acPMSIPFailCallsVal

SBC Performance Monitoring

Description

direction, during last interval.

Indicates the number of calls that failed due
to mismatched media server capabilities for
Tel to IP direction, during last interval.

Indicates the number of calls that failed due
to unavailable resources or a media server
lock for Tel to IP direction, during last
interval.

This counter is incremented as a result of
calls that fail due to reasons not covered by
the other counters for Tel to IP direction,
during last interval.

This table below describes the SBC PM counters supported by the SCOM.

Note: This section is only applicable to the E-SBC Series.

Table B-3: SBC Call Admission Control Performance Monitoring

SCOM Name

SRD Dialogs High Threshold Monitor
SRD Dialogs Low Threshold Monitor

SRD Invite Dialogs High Threshold
Monitor

SRD Invite Dialogs Low Threshold
Monitor

SRD Subscribe Dialogs High
Threshold Monitor

SRD Subscribe Dialogs Low
Threshold Monitor

SRD Other Dialogs High Threshold
Monitor

SRD Other Dialogs Low Threshold
Monitor

Group Dialogs High Threshold
Monitor

Group Dialogs Low Threshold
Monitor

Group Invite Dialogs High Threshold
Monitor

Group Invite Dialogs Low Threshold
Monitor

Counter (MIB Name)

acPMSIPSRDDialogsTable

acPMSIPSRDInviteDialogsTable

acPMSIPSRDSubscribeDialogsTable

acPMSIPSRDOtherDialogsTable

acPMSIPIPGroupDialogsTable

acPMSIPIPGrouplnviteDialogsTable

Description

Indicates all dialogs currently being
handled by the SBC per SRD.

Indicates all calls (initiated by
SIP:INVITE) currently being handled
by the SBC per SRD.

Indicates all SUBSCRIBE dialogs
(initiated by SIP:SUBSCRIBE)
currently being handled by the SBC
per SRD.

Indicates dialogs other than INVITE
and SUBSCRIBE (initiated by
SIP:REGISTER) currently being
handled by the SBC per SRD.

Indicates all dialogs currently being
handled by the SBC per IP Group

Indicates all calls (initiated by
SIP:INVITE) currently being handled
by the SBC per IP Group
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SCOM Name Counter (MIB Name) Description

Group Subscribe Dialogs High acPMSIPIPGroupSubscribeDialogsTable Indicates all SUBSCRIBE dialogs
Threshold Monitor (initiated by SIP:SUBSCRIBE)

. . currently being handled by the SBC
Group Subscribe Dialogs Low per IP Group
Threshold Monitor
Group Other Dialogs High Threshold acPMSIPIPGroupOtherDialogsTable Indicates all other dialogs other than
Monitor INVITE and SUBSCRIBE (initiated by

SIP:REGISTER) currently being

Group Other Dialogs Low Threshold handled by the SBC per IP Group
Monitor
Group In Invite Dialogs High acPMSIPIPGrouplninviteDialogsTable Indicates the number of incoming
Threshold Monitor calls (SIP INVITE) per IP Group

Group In Invite Dialogs Low
Threshold Monitor

Group Subscribe Dialogs High acPMSIPIPGrouplnSubscribeDialogsTable Indicates the number of incoming
Threshold Monitor SUBSCRIBE dialogs per IP Group

Group Subscribe Dialogs Low
Threshold Monitor

Group Out Invite Dialogs High acPMSIPIPGroupOutinviteDialogsTable Indicates the number of outgoing
Threshold Monitor calls (SIP INVITE) per IP Group.

Group Out Invite Dialogs Low
Threshold Monitor

Group Out Subscribe Dialogs High acPMSIPIPGroupOutSubscribeDialogsTabl Indicates the number of outgoing
Threshold Monitor e SUBSCRIBE dialogs per IP Group.

Group Out Subscribe Dialogs Low
Threshold Monitor

Invited Dialogs High Threshold acPMSIPInvitedDialogsTable Indicates the number of calls (SIP
Monitor INVITE).

Invited Dialogs Low Threshold

Monitor

Subscribe Dialog High Threshold acPMSIPSubscribeDialogTable Indicates the number of SUBSCRIBE
Monitor dialogs.

Subscribe Dialog Low Threshold

Monitor

SBC Registered Users High acPMSBCRegisteredUsersTable Indicates the number of registered
Threshold Monitor users.

SBC Registered Users Low
Threshold Monitor
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C

Optimizing SCOM Server Load-Example
Scenario

This appendix describes how to balance the loading of the AudioCodes MP-related
functional items (Discoveries, Monitors and Rules) running on the SCOM server. For each
functional item launched, a script is run. Each script represents an equivalent CPU
utilization percentage. This appendix presents a scenario with models of gateways with
different numbers of trunks. The scenario shows the affect on the CPU utilization both
before and after load balancing is performed. Load balancing is achieved by overriding the
polling frequency and Sync time for each functional item (see Chapter 8 on page 85).

C.1 Default Loading
The following describes the default loading for the different monitored AudioCodes gateway
models:
B Six gateways with six modules where each module includes one trunk, one Fan Tray
module and one power supply module— type A.
B Six gateways with six modules where each module includes four trunks, one Fan Tray
module and one power supply module — type B.
B Six gateways with six modules where each module includes 16 trunks, one Fan Tray
module and one power supply module — type C.
The table below shows the maximum number of scripts that are run for each of the SCOM
elements for the different AudioCodes MP-related objects.
Table C-1: Management Pack Objects and Number of Scripts Run
Management Pack Discoveries Monitors Performance
Object
Gateway One discovery with 1 80 monitors with | 26 performance counters with 26
script. 52 scripts. scripts.
Module three discoveries with two monitors with | -
two scripts. no scripts (Fan
Tray has one
monitor with no
scripts).
Trunk two discoveries with two  eight monitors Three rules with three scripts.
scripts. with no scripts.
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C.2  Script Load Estimation
The tables below describe the different script load estimations for the different models that

are described in Section C.1 on page 167.

C.2.1 Type A Gateways

The following table describes the script load estimations for Type A Gateway models.

Table C-2: Type A Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 12 29
Monitors 52 0 0 52
Performance 26 0 18 54
Counters
Total 143

C.2.2 Type B Gateways

The following table describes the script load estimations for Type B Gateway models.

Table C-3: Type B Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 48 65
Monitors 52 0 0 52
Performance 26 0 72 98
Counters
Total 215
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C.2.3 Type C Gateways

The following table describes the script load estimations for Type C Gateway models.

Table C-4: Type C Gateways

Management Gateway Scripts Module Trunk Scripts Total
Pack Object Scripts
Discovery 1 16 192 209
Monitors 52 0 0 52
Performance 26 0 288 316
Counters
Total 577
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C.3 Load Analysis

The figure below shows a comparison of the number of scripts that are run (Y-axis) for the
different model types (described in Section C.1 on page 167).

The key observation from the graph is that an increasing number of trunks significantly
affects the number of loaded scripts.

Figure C-1: Load Analysis
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The following summarizes the specific limitations and restrictions on possible frequencies
for different kinds of processes:

Performance counters rules (see Section 7.6 on page 77) have to be launched
precisely every 15 minutes due to their dependency on SNMP counters on devices.
For example, Tel2IP Calls.

High and Low Threshold Monitors must also be launched precisely every 15 minutes
due to their dependency on SNMP counters on devices. For example, Tel2IP Calls
High Threshold Monitor and Tel2IP Calls Low Threshold Monitor.

Trunk monitor rules 'Audiocodes Digital Trunk Available Channels Counter Rule' and
'‘Audiocodes Digital Trunk Blocked Channels' Counter Rule and the corresponding
threshold monitors 'Audiocodes Blocked Channels High Threshold Monitor' and
'‘Audiocodes Free Channels Low Threshold Monitor' by default are launched once per
minute. This is due to the relatively large number of trunk objects and their dynamic
states. For more information, see Section 8.1.4 on page 96.

Discoveries for Gateways and Modules can be launched at very low polling
frequencies because the probability of any parameter changing is low to impossible.
At the same time, the trunks discoveries should be launched much more frequently
since the probability of any parameter modification is relatively higher.
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C.3.1 Script Execution Without Load Balancing

The figure below shows the number of scripts executed (Y-axis) over a 60 second time
period (X-axis) without load balancing.

The key observation from the figure is that aproximately once every 15 minutes, there is a
peak in the script execution due to the running of the counter rules and threshold monitor

scripts.
Figure C-2: Non-Balanced Script Execution
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C.3.2 Script Execution with Load Balancing

For the implementation of load balancing, it is recommended to make the following
overrides:

Since gateways and modules do not need to be frequently discovered, it is
recommended to set the launching of these processes to once per 60 minutes.

For the discoveries of trunks, it is recommended to set their launching to once every
three minutes (instead of the one minute default).

All performance measurements (counter rules) and gateway threshold monitors
should still be launched once per 15 minutes.

Performance measurements of trunks (see Section 8.1.4 on page 96) are not
dependent on PM counters of devices; and in the SCOM indicate which trunk
channels are in-service and which trunk channels are out-of-service. Therefore, we
recommend to reduce the polling frequency for running these scripts from the default
one minute to once every three minutes.

The overidding of Discoveries, Monitors and Rules are described in Section 8 on page 85.

C.3.2.1 Script Execution Without Overriding Sync Time

The figure below shows the number of scripts executed (Y-axis) run over a one minute time
axis (X-axis) following the modifications described above (without overidding the Sync time
values).

The key observation of the figure shows an improvement; however, there are still a lot of
loading peaks.

Figure C-3: Frequency Without Syncronization
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C.3.2.2 Script Execution when Overriding Sync Time

This section describes how to modify the Synchronization time. Highest peaks are defined
as peaks when gateway counters and monitors are executed. It is possible to modify them
so every counter and monitor will have its own designated minute of synchronization where
the starting minute will be the second minute because discoveries of gateways and
modules will be executed at the first minute of an hour.

The table below shows an example of setting a sequence of different Sync times for the
different counters.

Table C-5: Sync Time Sequence

Counter Sync Time
AttemptedCalls 00:01
BusyCalls 00:02
EstablishedCalls 00:03
FailCalls 00:04
ForwardedCalls 00:05
IPGroupDialogs 00:06
IPGrouplnviteDialogs 00:07
NoAnswerCalls 00:08
NoMatchCalls 00:09
NoResourcesCalls 00:10
NoRouteCalls 00:11
SRDDialogs 00:12
SRDOtherDialogs 00:13
SRDSubscribeDialogs 00:14

In addition, note the following:

B The corresponding threshold monitors of the above-mentioned counters will have the
same minute of synchronization.

B There are 252 discoveries of trunks with scripts that represent 35% of all remaining
scripts. Let’s set their synchronization minute to 00:01.

B At the same time, there are 288 performance measuring rules of gateways of type C
that represent 40% of all remaining counters. Let’s set their synchronization time to
00:02.
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The figure below shows the results following the above modifications.

The key observation of the figure is that peaks are much lower and smoother over the time
axis, which consequently implies lower CPU utilization.

Figure C-4: Frequency and Sync
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C.3.3

Resource Monitor

You can monitor the running SCOM processes in the SCOM Server Resource Monitor as
shown in the figure below.

You can change the service name of the SCOM ?

» To open the Resource Monitor on the Windows Server:

B Press Cntrl+ Shift + Esc.

Figure C-5: SCOM Server Resource Monitor
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